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Preface

This publication compiles training material prepared in the framework of the project ‘Learning
tools for advanced three-dimensional surveying in risk awareness project (3DRiskMapping)’,
from October 2006 to September 2008, which has been co-financed by the Flemish Agency of
the European Leonardo Da Vinci programme.

This tutorial is the result of an international cooperation of a multidisciplinary group of experts
from universities and industries in Europe, including:

e Mario Santana Quintero and Bjorn Van Genechten, University of Applied Sciences St.
Lieven (Belgium)

Marc De Bruyne, BnS (Belgium)

Ronald Poelman, Delfttech (The Netherlands).

Martin Hankar, GlobeZenit (Belgium).

Simon Barnes and Huseyin Caner, Plowman Craven (United Kingdom)

Luminita Budei, Technical University of lasi (Romania).

Erwin Heine and Hansjorg Reiner: University of Natural Resources and Applied Life
Sciences (Austria).

e José Luis Lerma Garcia and Josep Miquel Biosca Taronger, Polytechnic University of
Valencia (Spain).

The content is based on substantial scientific research and hands-on experience in the
application of terrestrial laser scanning for capturing our built environment.

The theoretical part of the tutorial has been compiled by Bjorn Van Genechten with contributions
from Huseyin Caner, Erwin Heine, José Luis Lerma Garcia, Ronald Poelman, and Mario
Santana Quintero; as well as support from all participants.

The Heritage case study on recording the St. James church for the purpose of disaster recovery
was compiled by Bjorn Van Genechten with contributions from Huseyin Caner, Erwin Heine,
José Luis Lerma Garcia, Ronald Poelman, and Mario Santana Quintero as well as with support
from all participants. The scanning of the church was possible with the permission of the City of
Leuven, University of Leuven, and the support of Plowman Craven. The scanning project was
carried out by Huseyin Caner, Tomasz Skiba, Tim MacDonald, Leive Spincemaille, Stuart
McLeod, Bjorn Van Genechten, and Mario Santana.

The Civil Infrastructure case study on monitoring the deformation of a hydroelectric dam was
prepared by Hansjérg Reiner, Josep Miquel Biosca Taronger, Erwin Heine, José Luis Lerma
Garcia and support from all participants. The data acquisition in the field has been made
possible by the lllwerke AG, Vorarlberg (Austria) and by Thomas Weinold from the University of
Innsbruck (Austria).

The Industrial case study on scanning hazardous environments (petrochemical platform) was
prepared by Marc De Bruyne and Martin Hankar with contributions from Ronald Poelman and
Bjorn Van Genechten; as well as support from all participants.
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Glossary

3D: Having three-dimensions, characterized by Cartesian (x, y, z) co-ordinates.

Airborne laser scanning: The use of a laser scanning device from an airborne platform to
record the topography of the surface of the earth.

As-built: Describes how a structure was built based on its design.

As-is: Describes the current status of the structure at present.

CAD (Computer Aided Design): Use of computer technology to aid in the design of a product.
Clash detection: Detecting possible collision between as-is and proposed design.

Data voids: Sections within the point cloud which contain no data.

Deformation Monitoring: The systematic measurement and tracking of the alteration in shape
or dimension of an object as a result of the application of stress to it.

DEM (Digital Elevation Model): Digital stored xyz-triples of a surface. It is necessary to
mention always which surface is meant by using the DEM (for example DEM of the ground
water surface, DEM of the Earth’s surface).

DSM (Digital Surface Model): Digital stored- xyz-triples that fully envelopes whatever object in
space. If the object is the Earth’s surface, then it should include natural (mainly vegetation) and
man-made objects such as buildings and bridges.

DTM (Digital Terrain Model): Digital stored xyz-triples of the Earth’s surface. Therefore, the
DTM is one special case of the DEM (DTM = DEM of the Earth’s surface).

Geometric accuracy: The closeness of a measurement to its true value. It is commonly
described by the Root Mean Squared Error (RMS). Where ¢ is the error (the difference between
the measurement and the true value) and n is the number of measurements the RMS error can
be defined as:



Geometric precision: The distribution of a set of measurements about the average value,
which is commonly described by the standard deviation. If n is the number of measurements and
v is the residual (i.e. the difference between a measured quantity and the most probable value
for that quantity) the precision of a sample set of data can be presented by the standard
deviation:

All reference to the standard deviation of a quantity should be accompanied by the probable
error value e.g. £3 mm (67% probable error) — sometimes referred to as repeatability;

GIS (Geographical Information System): In the strictest sense, it is an information system
capable of managing, integrating, storing, editing, analyzing, sharing, and displaying
geographically-referenced information.

GPS (Global Positioning System): The global positioning system — a US satellite positioning
system used to position an aircraft during an airborne survey, or used as a ground based survey
technique. The Russians and the Europeans are working on similar systems respectively called
GLONASS and GALILEO.

INS (Inertial Navigation System): A navigation aid that uses a computer and motion sensors
(accelerometers and gyroscopes) to continuously track the position, orientation, and velocity of
an object without the need for external references.

Laser (Light Amplification by Simulated Emission of Radiation): An intense light beam that
produces images with electronic impulses.

Laser scanning: From a user’s point of view, a 3D scanner is any device that collects 3D co-
ordinates of a given region of an object surface automatically and in a systematic pattern at a
high rate (hundreds or thousands of points per second) achieving the results (i.e. 3D
coordinates) in (near) real time.

LiDAR (Light Detecting and Ranging): Often used to refer to airborne laser scanning but can
also apply to some ground based systems.

Mesh: A polygonal subdivision of the surface of a geometric model, also referred to as polygon
model or triangulated model.

Metadata: Data that is used to describe other data. It is a vital component of the data
management process.

Model: An expression that should be qualified by the type of model, e.g. geometric model. A
geometric model is, typically, a representation of a three-dimensional shape.

Modelling: The process of creating a model or three-dimensional shape, for instance meshes,
nurbs or solids.

Oversampling: Setting the grid density (resolution) higher than the per-point accuracy of the
laser scanner. Oversampling generates less precision and more noise in the dataset.



Peripheral data: Additional scan data collected during the scanning process, but not explicitly
defined in the project brief.

Point cloud: A collection of XYZ co-ordinates in a three-dimensional co-ordinate system. It may
also include additional information, such as colour and reflectivity values. It is also referred to as
COP (Cloud of Points).

Point density: Number of points per unit. Usually the higher the point density is, the better
representation of features.

Point-of-interest: Is a geometrical point on the scanned object that is highly distinguishable and
can be accurately located due to its shape. Also referred to as point-of-detail or natural target.

Raw scan data: Any unprocessed data collected by a laser scanner. This might include different
sources of error and peripheral data captured during the scanning survey.

Registration: The process of transforming point clouds onto a common coordinate system. Also
referred to as alignment or consolidation.

Rendering: Is the process of generating images from a 3D computer model, without the ‘limited’
capabilities of graphic hardware. The model is a description of three dimensional objects in a
strictly defined language or data structure. It would contain geometry, viewpoint, texture, lighting
and shading information.

Resolution: The average distance between XYZ co-ordinates in a point cloud. This is
commonly represented in two forms, spatial and angular.

The average 3-D distance between points at a specified distance (assumed to be taken from/to
the centre of the footprint): 30 mm x 30 mm (at 50 m)

The angular step of the two axes: 0.25°x0.25°

The average 3-D distance between points on the subject is likely to be clearer to a non-technical
user. The quoted point density for array scan should always be seen as the minimum density of
the points for data on the subject, not the peripheral data.

Revamp: Is the term for modernization and optimization that are the prerequisites for long-term
plant operation.

Scan (n): Refers to a single session of data collection at a single scan origin and scan
orientation.

Scan noise: The level of deviation of the point cloud to the actual surface, caused by inclination
angle, footprint size, reflectivity, atmospheric conditions, etc.

Scan orientation: Placement of the scanner in a rotational coordinate system in three-
dimensional Euclidian space.

Scan origin: The origin of the arbitrary co-ordinate system in which static scans are performed.
When the scan origin is transformed into the site co-ordinate system it becomes the scan
position.

Scan position: The location, in a known co-ordinate system, from which a single scan is
performed. If the system does not perform a full 360-degree scan, several scans may be taken
from the same scan position, but with different scan orientations.

Scanning artefacts: Irregularities within a scan scene that are a result of the scanning process
rather than features on the subject itself.
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Spot Size: Diameter of the laser beam emitted by the laser scanner, also referred to as the
footprint.

Survey control: Points of known location that define a local reference frame in which all other
measurements can be referenced.

TIN (Triangulated Irregular Network): Representation of a surface that is arranged in a
network of non-overlapping triangles.
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1. Chapter |: 3D spatial information in making informed
decisions

1.1. What is risk assessment?

Risk assessment is the process where hazards are identified, analyzed or evaluated for the risk
associated with those hazards, so as to determine appropriate ways to eliminate or control the
hazard. In practical terms, a risk assessment is a thorough look at a workplace, building or
environment to identify those elements, situations, processes, etc that may cause harm,
particularly to people. After identification, an evaluation is made of how likely and severe the risk
is, which helps in deciding what measures should be in place to effectively prevent or control the
harm from happening.

The Risk Assessment process can be summarized as follows (Fig. 1):

» Risk identification and assessment: determining and analyzing the potential, origin,
characteristics and behaviour of the hazard — e.g. frequency of occurrence/magnitude of
consequences

= Potential Risk Treatments :

0 Reduction: planning and implementation of structural interventions (e.g. dams, dikes) or
non-structural measures like disaster legislation

o Early warning: provision of timely and effective information, through identified institutions,
that allow individuals exposed to a hazard, to take action to avoid or reduce their risk and
prepare for effective response

o0 Disaster preparedness and emergency management: activities and measures taken in
advance to ensure effective response to the impact of a hazard, including measures
related to timely and effective warnings as well as to evacuation and emergency planning

= Recovery/Reconstruction: decisions and actions taken in the post-disaster phase with a view
to restoring the living conditions of the affected population

Restoration of
Infrastructure

Figure 1: Risk Management Cycle (from [1])
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Proper risk assessment or risk management requires up to date information, a possible rapid
response, accurate data and a possibility to check data for change in a certain time-span. This is
exactly what laser scanners do best.

Laser scanners are used for risk assessment in a wide variety of applications:

» Analyzing the structural state of a building in danger of collapse

» Assessing possible deformations of structures over time due to external or internal forces

» Detecting possible flooding zones by analyzing the topographical terrain

= Simulation of land slides or earthquakes

= Condition assessment and safety analysis of roads and bridges

= Documenting disaster areas when disaster has already occurred, this includes building
collapses, roadway defects and structural failures, damaged vehicles; collision areas,
including roadways, shipping docks, parking lots and stairways; the remnants of building

fires; interference checks with new designs and as-built scan databases

» Recording crime scenes (comparison of damage profiles, no disturbance of the evidence,
incorporates the environment, quick clearance of the scene)

= Surveying high-traffic areas without shutdowns or risk to a survey crew
» Conducting remote and accurate measurements of rock faces (danger of rock falling)
= Tsunami simulation

= GIS mapping: location of people affected and critical infrastructures such as hospitals or fire
departments

1.2. What is Laser Scanning?

Laser Scanning describes a method where a surface is sampled or scanned using laser
technology. It analyzes a real-world or object environment to collect data on its shape and
possibly its appearance (e.g. colour). The collected data can then be used to construct digital,
two-dimensional drawings or three-dimensional models useful for a wide variety of applications.

The advantage of laser scanning is the fact that it can record huge numbers of points with high
accuracy in a relatively short period of time. It is like taking a photograph with depth information.
Laser scanners are line-of-sight instruments, so to ensure complete coverage of a structure
multiple scan positions are required.

1.3. Static and dynamic laser scanning
Current laser scanner technology can be divided into 2 categories: static and dynamic.

When the scanner is kept in a fixed position during the data acquisition, it is called static laser
scanning. The advantages of using this method are the high precision and its relatively high
point density. All static laser scanning can be seen as terrestrial laser scanning, however not all
terrestrial laser scanning can be categorized as being static laser scanning.

In cases of dynamic laser scanning, the scanner is mounted on a mobile platform. These
systems require additional positioning systems such as INS and GPS which makes the system
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more complex and expensive. Examples of dynamic laser scanning are scanning from an
airplane (airborne laser scanning), scanning from a moving car or from an unmanned aerial
vehicle (UAV).

This tutorial focuses on static laser scanning.

1.4. Applications of laser scanning

In the early stages, laser scanning was short range and mainly used in the automotive and
industrial design process to facilitate the Computer Aided Design (CAD) process. This helped in
the mass production of consumer products.

However, since technology keeps evolving, other potential fields are exploited. Mid range
scanners were developed for the petrochemical industry. Due to the complexity of plants, which
were only documented as 2D drawings, laser scanning led to the full 3D management of sites.

Because the obvious advantages of laser scanning like: non contact measurement, high
accuracy, long range, fast data acquisition, etc., other disciplines like cultural heritage,
architecture, urban development, forensics, and the entertainment industry are starting to
steadily adopt this technology (see Figure 2)

[
( Dynamic Laser Scanning ] [ Static Laser Scanning j

[ ]
Long Range Medium Range Close Range
150-1000m 1-150m 0,5-2m

Figure 2: Laser Scanner applications
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2. Chapter II: Principles of Laser scanning

2.1. The electromagnetic spectrum and light

The electromagnetic spectrum is more familiar to you than might be thought. The microwave you
use to heat your food and the cell phones you use, use parts of the electromagnetic spectrum.
The reason we see objects, is because they emit, reflect or transmit a part of the visible part of
the spectrum that we call light. This visible part of the electromagnetic spectrum consists of the
colours that we see in a rainbow - from reds and oranges, through blues and purples.

Figure 3: Prism converting white light into its different colours

Each of these colours actually corresponds to a different wavelength of light. We can see this if
we pass white light through a glass prism - the violet light is bent ("refracted") more than the red,
because it has a shorter wavelength - and we see a rainbow of colours.

Waves in the electromagnetic spectrum vary in size from very long radio waves (the size of
buildings), to very short gamma-rays smaller than the size of the nucleus of an atom.

Wisibse: Light
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Figure 4: The electromagnetic spectrum

The electromagnetic spectrum can be expressed in terms of its energy, its wavelength or its
frequency. These quantities are related according to the following equations:
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wavespeed (c) = frequency( f).wavelength(A)
and

h.wavespeed (c)
wavelength(2)

Energy(E) = h. frequency(f) =

where:
= Cis the speed of light, 299,792,458 m/s

= his Planck's constant, 6.626069.10-34 J.s

So, high-frequency electromagnetic waves have short wavelengths and high energy; and vice-
versa, low-frequency waves have long wavelengths and low energy.

2.2. Lasers

A device that is able to generate a wave of light using only a very narrow band of the spectrum
is called a laser. A typical laser emits light in a narrow, low-divergence beam with a well-defined
wavelength (corresponding to a particular colour if the laser is operating in the visible spectrum).
This is in contrast to a light source such as the incandescent light bulb, which emits into a large
solid angle and over a wide spectrum of wavelengths. These properties can be summarized in
the term coherence.

Lasers are actually similar to transistors, they generate or amplify light, just as transistors
generate and amplify electronic signals at audio, radio or microwave frequencies. The word
laser is an acronym for Light Amplification by Stimulated Emission of Radiation. The first working
laser was demonstrated in May 1960 by Theodore Maiman at Hughes Research Laboratories.

Lasers are used in everyday life, especially in optical storage devices such as compact disc and
DVD players, in which the laser scans the surface of the disc for data retrieval. Other common
applications of lasers are bar code readers and laser pointers. In industry, lasers are used for
cutting steel and other metals and for inscribing patterns such as the letters on computer
keyboards. Lasers are also used for military and medical applications.

2.3. Important properties of laser light

Laser light is simply light generated with a laser device. Such light has some very special
properties, which distinguishes it from light from other origins [2]:

= Laser light is generated in the form of a laser beam. Such a laser beam has a high
(sometimes extremely high) degree of spatial coherence, therefore it propagates dominantly
in a well defined direction with moderate beam divergence. The term coherence means that
the electric signal at different locations across the beam profile oscillates with a rigid phase
relationship. This coherence is the reason why a laser beam can propagate over long
distances and can be focused to very small spots.

= Laser light also has a high degree of temporal coherence (in most cases), which is
equivalent to a long coherence length. Long coherence lengths imply a rigid phase
relationship over relatively long time intervals, which correspond to large propagation
distances (often many kilometres).
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= Combining a large temporal coherence with a large coherence time or coherence length
results in a narrow spectral bandwidth (or line width). This means that visible laser beams
have a certain pure colour, e.g. red, green or blue, but not white or magenta For instance,
most lasers used in close range and mid range measuring devices have a wavelength of
1064 nm (near infrared) or 532 nm (green laser). It should be noted that a large coherence
length introduces a tendency for the phenomenon of laser speckle, i.e., a characteristic
granular pattern which can be observed. This effect can be noticed for instance when a laser
beam hits a metallic surface.

* In most cases, laser light is linearly polarized. This means that the electric field oscillates in a
particular spatial direction.

Depending on the application, laser light can have other remarkable properties:

= Laser light may be visible, but most lasers actually emit in other spectral regions, in particular
the near infrared region, which human eyes cannot perceive.

= Laser light is not always continuous, but may be delivered in the form of short or ultra short
pulses. As a consequence, the peak power can be extremely high.

Because of its coherence properties, laser beams stay in focus when projected on a distant
scene. Another fundamental property of (laser) light waves is their velocity of propagation. Light
waves travel with a finite and constant velocity in a certain medium. Because of these
properties, laser light is highly suited to the measurement of objects. How this is done will be
explained in the following paragraphs.

2.4. Laser Safety

Lasers are used in a wide variety of applications including, scientific, military, medical, and
commercial fields; all developed since the invention of the laser in 1958. The coherency, high
monochromaticy, and ability to reach extreme powers are all properties which allow for these
specialized applications. Therefore, laser light should be handled with extreme caution and
understanding of laser types becomes necessary.

To enable users to determine the potential risk, all lasers and devices that use lasers are
labelled with a classification, depending on the wavelength and power of the energy the laser
produces. The European Standard [3] provides information on laser classes and precautions. It
outlines seven classes of lasers:

= Class 1 lasers are safe under reasonably foreseeable conditions of operation, including the
use of optical instruments for intra-beam viewing.

= Class 1M lasers are safe under reasonably foreseeable conditions of operation, but may be
hazardous if optics are employed within the beam.

= Class 2 lasers normally evoke a blink reflex that protects the eye; this reaction is expected to
provide adequate protection under reasonably foreseeable conditions, including the use of
optical instruments for intra-beam viewing.

= Class 2M lasers normally evoke a blink reflex that protects the eye, this reaction is expected
to provide adequate protection under reasonably foreseeable conditions. However, viewing
of the output may be more hazardous if the user employs optics within the beam.

= Class 3R lasers are potentially hazardous where direct intra-beam viewing is involved,
although the risk is lower than that for Class 3B lasers.
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» Class 3B lasers are normally hazardous when direct intra-beam exposure occurs, although
viewing diffuse reflections is normally safe. This class of laser is generally not suited for
survey applications.

= Class 4 lasers will cause eye or skin damage if viewed directly. Lasers of this class are also
capable of producing hazardous reflections. This class of laser is not suited for survey
applications.

Users of laser scanning systems should always be aware of the class of their instrument. In
particular, the user should ensure that the correct classification system is being used. (Refer to
the IEC standard for more information on laser safety [3]).

Particular precautions and procedures are outlined in the IEC standard for Class 1M, Class 2M
and Class 3R laser products used in surveying, alignment and levelling. Those precautions, with
relevance to laser scanning are:

= Only qualified and trained persons should be assigned to install, adjust and operate the laser
equipment.

= Areas where these lasers are used should be posted with an appropriate laser warning sign.

* Precautions should be taken to ensure that persons do not look into the beam (prolonged
intra-beam viewing can be hazardous). Direct viewing of the beam through optical
instruments (theodolites, etc) may also be hazardous.

» Precautions should be taken to ensure that the laser beam is not unintentionally directed at
mirror-like (specular) surfaces.

= When not in use the laser should be stored in a location where unauthorized personnel
cannot gain access.

= |n potentially explosive environments (e.g. petrochemical plants, mining), special ‘explosion
proof laser equipment should be used. Important properties of explosion proof equipment
are: peak power of the laser should be limited, no spark generation, and the maximum
temperature of the equipment should be limited.

2.5. Measuring using light

Because of recent developments in computer vision and sensor technology, light has been used
in @ number of ways to measure objects. These measuring techniques can be divided into two
categories: active and passive techniques.

Passive scanners do not emit any kind of radiation themselves, but instead rely on detecting
reflected ambient radiation. Most scanners of this type detect visible light because it is a readily
available ambient radiation. Other types of radiation, such as infrared could also be used.
Passive methods can be very cheap because in most cases they do not need particular
hardware other than a digital camera. The problem with these techniques is that they rely on
finding correspondences between 2D images, which do not always have unique solutions. For
example, repetitive patterns tend to ‘fool’ the measurement method. The accuracy of these
methods depends mostly on the resolution of the imaging system and the density of identifiable
features in the image.
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Figure 5: Categorization of measuring methods using light [adopted from [4]]

In this manual we will concentrate on active measurement techniques. Active scanners emit
some kind of controlled radiation and detect its reflection in order to probe an object or
environment. Possible types of radiation used include light, ultrasound or x-ray. Since these
active measurement techniques require a laser transmitter and a receiver, they are mechanically
more complex then passive techniques. The main benefits of these systems are:

» They do not require ambient lighting, because they generate their own radiation;
» They provide high density measurements in a very automated way;

» They are useable on featureless surfaces;

» They have a relatively fast acquisition time (1000 — 500.000 pts/sec);

However, some active systems are affected by external light sources, reflectivity, colour and
roughness. These drawbacks will be discussed at a later point.

A number of active scanners exist, all differing in the way the scanner receives and/or analyses
the reflected radiation signal. In the next chapters these different types of active scanners are
described in more detail.

2.5.1. Triangulation based measurement

Triangles are the basis of many measurement techniques. They were already used for basic
geodesic measurements in Ancient Greece and can still be found in the modern laser-based 3D
cameras. The mathematical basis of the triangle (trigonometry), which is at the basis of these
triangulation based measurement techniques, has to be credited to the Greek philosopher
Thales (6th century BC).
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Figure 6: Triangulation principle

A triangulation laser scanner uses the same principle to probe the environment. It shines a laser
pattern onto the subject and exploits a camera to look for the location of the laser’s projection on
the object. The laser emitter and the camera are setup under a constant angle, creating a
triangle between them and the laser projection on the object, hence the name triangulation.
Because of this configuration, the laser projection changes in the camera’s field of view
depending on the distance to the camera.

Camera

Laser emitter

Figure 7: Triangulation Laser Scanning Principle

Analyzing Figure 7 shows that at triangle side (D), the distance between the camera and the
laser emitter, is known. The angle of the laser emitter (a) is also known. The angle of the camera
(B) can be determined by looking at the location of the laser beam in the camera’s field of view.
These three pieces of information fully determine the shape and size of the triangle and provide
the exact depth location of the object being measured.

It can be shown that, the wider the baseline (D), the less effect errors in pixel coordinates have
on the estimate of the depth location. However, the baseline cannot be made very large
because then the laser projector and the camera would have a reduced overlapping field of view
(FOV) and the laser spot may not be captured in the camera image at all.
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As a summary, possible ways to decrease the uncertainty in the depth direction are:

= Decreasing the distance of the object to the scanner - increases shadow effects
» Increasing the triangulation base (D) = also increases shadow effects

» |ncreasing the lens focal length = reduces the field of view

= Decreasing the measurement uncertainty - more pixels in the camera

In most cases a laser line, instead of a single laser dot, is used and swept across the object to
acquire the whole object in 3D. This means that the angle of the laser emitter also changes
while sweeping the laser across the object.

Because of the physical limitations of using a wider baseline and the limited field of view of the
camera, triangulation scanners are used in applications generally requiring an operating range
that is less than 10 meters. Compared to the mid- and long range scanners based on time delay
principles (see chapter 2.5.2), triangulation scanners have very high accuracies in the order of
microns.

In practice, the active triangulation method was invented to solve the notorious correspondence
problem found in passive measuring techniques. The correspondence problem can be stated as
follows: given two images 11 and 12 of a scene captured from two different viewpoints, the
relative orientation of the cameras and a matching point pair between these images; we can
then compute the corresponding 3D point by using the triangulation principle. Thus the
correspondence problem consists of finding matching points between different images. The
active triangulation method uses laser light to solve this problem by marking the 3D point on the
object with the colour of the laser light, so that it can be easily detected in the image.

point line pattern

Figure 8: Different projection techniques used in triangulation scanners

In order to avoid the use of mechanical fixtures, some innovative modifications have been
imposed. Instead of moving/rotating the laser emitter to cover the whole object, patterns of
points or lines can be projected, which cover the whole object at once. Different patterns are
used ranging from regular line patterns to spatially encoded patterns that modulate their
frequency or phase in time to provide better accuracy. Note that these spatially encoded
patterns require the scan to be to a static object.
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Figure 10: Binary coded pattern that is phase modulated in time, also called fringe projection

Even more complex patterns based on the Moiré effect are used nowadays to increase the
accuracy and robustness of these systems. The Moiré effect is simply the result of two
amplitude modulated spatial signals interacting together. This phenomenon can be observed on
television when people being interviewed wear striped clothing. A Moiré scanner projects a
regular pattern on the object to be scanned while the camera capturing the scene also has an
integrated regular pattern. The interference of these two patterns superimposed to each other
generates a moiré pattern from which we can determine accurate changes of depth.

p ok

Figure 11: Moiré pattern formed by two sets of parallel lines, one set inclined at an angle of 5° to the other (adopted
from [6])

As a closing remark on triangulation based scanners, the main challenge in using coded line

projection systems is the unique separation of the different directions of projection on objects
that have sudden jumps in depth and wide texture differences across their surface.

2.5.2. Time-based measurement

Time-based scanners are active scanners that measure a time frame between two events. In

general we have two time-based scanning principles: Pulse based (Time-of-Flight) and Phase
based scanners.
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2.5.2.1. Pulse Based (Time-of-flight) scanners (incoherent detection)

As already mentioned in paragraph 2.3, light waves travel with a finite and constant velocity in a
certain medium. Therefore, when the time delay created by light travelling from a source to a
reflective target surface and back to the source (round trip) can be measured, the distance to
that surface can be evaluated using the following formula:

5. (€

With ¢ = speed of light in air
f = time between sending and receiving the signal

. D =‘
Transrnitter
Transtmitted hearn
Clocking
electronics L—
Target swface
Feflected bearn
Feceiver

Figure 12: Time-of-flight laser scanner principle

The current accepted value for the speed of light in a vacuum is exactly ¢ = 299,792,458 m/s. If
the light waves travel in air then a correction factor equal to the refraction index (depending on
the air density) must be applied to c. Taking into account this speed of light, one can calculate it
takes 3.33 nanoseconds to travel 1 meter. Therefore, to reach a point accuracy of 1 mm, we
need to be able to measure a time delay of about 3.33 picoseconds.

Pulsed time-of-flight scanners do not use continuous laser beams, but make use of laser pulses.
They scan their entire field of view one point at a time by changing the range finder’s direction.
The view direction of the laser range finder is changed by a deflection unit (see paragraph
2.5.3). Typical pulsed time-of-flight 3D laser scanners can measure up to 2,000~50,000 points
every second.

Transtitter Receiver
pulse pulse

Titme

Figure 13: Laser pulse measurement
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Note that for a non-ambiguous measurement, the time measured (t) should be greater than the
pulse width, Tpulse. Thus

t > Tpulse

or

d> %C.Tpulse

To gain a better understanding of these equations, numbers can be used. Setting Tpulse to be
10ps, implies that the maximum accuracy that can be achieved will be d = 1.5mm. Most
commercial mid- and long-range systems provide an accuracy of about 6 to 10 mm. Because
the accuracy depends on the clocking mechanism, the error of a time-of-flight scanner is almost
independent of the distance itself (except for the laser footprint, see chapter 2.6.1).

It is important to notice that the time derivation method for measuring the return pulse depends
on the desired time resolution, the counting rate and the required dynamic range of the pulse.
Commonly used principles in discriminator design include leading edge timing (constant
amplitude), zero crossing timing (derivation), first moment timing (integration) and constant
fraction timing (search for an instant in the pulse when its height bears a constant ratio to pulse
amplitude).

In a pulsed time-of-flight system, the maximum pulse repetition frequency is dictated by the fact
that the transmitter cannot send another pulse until the echo from the previous one has been
received [7]. The purpose of this restriction is to avoid confusion in the pulses arriving at the time
interval counter and is called the maximum unambiguous range. The maximum unambiguous
range depends on the pulse duration and its frequency.
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Figure 14: Maximum Unambiguous Range versus pulse repetition frequency (adopted from [7])

Three maijor factors govern the accuracy of a pulsed ranging system [7]:

= Ability to select the same relative position on the transmitted and received pulse to measure
the time interval. This is limited by noise, time jitter, signal strength and sensitivity of the
threshold detector, and shortness and reproducibility of the transmitter pulse.

» The accuracy with which fixed time delays in the system are known.

= The accuracy of the time interval measurement instrumentation.
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The advantage of using pulses for laser ranging is the high concentration of transmitted laser
power. This power makes it possible to achieve the required SNR (signal to noise ratio) needed
for high accuracy measurements at long ranges (up to several hundred meters). The
disadvantage is the problem of detecting the exact arrival time of the backscattered laser pulse
due to the changeable nature of the optical threshold and atmospheric attenuation.

In Figure 15 some commercially available time-of-flight scanners are shown. Today (year 2008),
the most widely known companies are: Optech, Leica, Riegl, Trimble, Callidus.

Figure 15: Commercially available Time-Of-Flight Laser Scanners

25.2.2. Phase based

Another time-based measuring principle avoids using high precision clocks by modulating the
power of the laser beam. The emitted (incoherent) light is modulated in amplitude and fired onto
a surface. The scattered reflection is collected and a circuit measures the phase difference
between the sent and received waveforms, hence a time delay.

Distance
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reference signal
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Figure 16: Phase based measurement principle

Typical phase-based scanners modulate their signal using sinusoidal modulation, amplitude
based (AM) or frequency based (FM) modulation, pseudo-noise or polarization modulation. In
case of a sinusoidal modulated signal, the reflected light is demodulated by means of four
sampling points that are triggered to the emitted wave. Out of the four measurements c(70),
c(tl1), c(12) and c(13) the phase shift A®, the offset B and the amplitude A can be calculated:

_ c(z0) + c(71) + c(7r2) + c(73)
4

B
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A= \/(C(TO) - C(T2))2 + (C(Tl) _ C(Z’3))2
2

Ag = arctan(—c(ro) — C(Tz)j
c(71) —c(z3)

This phase difference can be related to a time delay similar to that measured in the pulse-based
scanners. The relationship between phase difference (A®), modulation frequency (fmodulatea),
and time delay (1), is:

t——A¢
2. f

* " mod ulated

Then, according to the distance measuring equation of the time-of-flight scanner, the distance to
the target is given by

D:(c.t): c A
2 4'72. fmodulated

Again numbers may be inserted to get a better feel for these entities. With a frequency of 10MHz

and a phase resolution of 0.01 degree (not too difficult with standard electronics), we get a

resolution in z of about 0.5 mm.

Continuous beam-modulation scanners also have a maximum unambiguous range, similar to
pulsed time-of-flight systems. For these systems the range is limited to that which causes a
phase delay in the sine wave of one complete cycle. The equation for maximum unambiguous
range in a continuous wave system is given by:

_ C
amb 2 f

* " mod ulated

In the example above, the interval is about 15 m (frequency 10MHz). The range measurement
uncertainty is proportional to zams and inversely proportional to the Signal-to-Noise Ratio (SNR).
To get around the inconvenience of a range ambiguity interval, one can use multiple frequency
waveforms in which the target is localized at low frequency (long wavelength) and then accurate
measurement is performed at high frequency. In the latest generation of phase based scanners,
2 or even 3 waves with different wavelengths are superimposed. The longest wavelength
defines the uniqueness range and the shortest wavelength defines the precision that can be
obtained. Generally, phase based scanners have higher speeds and better resolution but less
precision than time-of-flight scanners.

Generally the accuracy of a phase based scanner is limited by:

» Frequency of the signal or modulation.

» Accuracy of the phase-measurement loop - Depends on signal strength, noise, ...
= Stability of the modulation oscillator.

= Turbulence in the air through which the measurement is made.

= Variations in the index of refraction of the air.
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Figure 17: Schematic drawing of two modulation wavelengths and a carrier wave for phase-based laser ranging.
(from [8])

In Figure 18 some commercially available phase based scanners are shown. Today (year 2008),
the most widely known companies are: IQSun, Leica, Z+F and Faro.
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Figure 18: Commercially available Phase based Laser Scanners

2.5.2.3. Interferometry (coherent)

Interferometry means using the interference of different light waves to record three dimensional
positions in space. Optical interferometry has been used since the 19th century [7]. Due to the
limited intensity and coherence of conventional light sources, the measurements were restricted
to distances of only a few centimetres. It was only when lasers were invented that these
restrictions could be overcome. Lasers have allowed interferometry to develop into a fast, highly
accurate and versatile technique for measuring longer distance.

Interferometric measurement of distance can be highly accurate. It offers a higher degree of
precision than the pulsed time-of-flight or beam-modulation telemetry methods. However, it is
best suited to measurements made in a controlled atmosphere (for example, indoors) over
distances no greater than a few tens of meters.
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Figure 19: A Michelson Interferometer [9]

In an interferometric laser scanner the laser beam is split using a beam splitter that reflects half
the beam in one direction (the reference arm) and transmits the other half (the measurement
arm). Both parts of the beam travel along different paths and when the beams are combined
together interference fringes are produced. Very small displacements (in the order of a fraction
of wavelengths) can be detected (using coherence detection), and longer distances can also be
measured with low measurement uncertainty (by counting wavelengths). Many systems have
been built on this principle, for example multi-wavelength, holography and speckle
interferometry. These systems have very high accuracy, but are also very expensive.

2.5.3. Beam deflection methods for time-based measurement systems

To be able to measure multiple points from the same scanner point of view, the laser beam
needs to be deflected. Instead of moving the laser itself, a deflection unit is used. Most
deflection units make use of a mirror because they are much lighter and can thus be rotated
much faster and with greater accuracy. A number of methods exist to deflect the laser beam
towards a specific direction without having to move the scanner itself. In general, three methods
are employed for this purpose.

One option is to use an oscillating mirror which allows movement of the laser along a line. A
combination of two mirrors allows for the deflection of the beam in two directions (see Figure
20a). To increase the speed of the deflection unit and reduce the complexity of turning a mirror
and then having to turn it back, researchers have come up with a rotating optical reflective prism
(see Figure 20b). This principle needs only one direction of rotation and is therefore faster.
Recently the use of fibre switches was introduced to make systems more flexible. These
systems deflect the laser beam into a circle of optical fibres by means of a rotating mirror (see
Figure 20c). The optical fibres then transport the beam into any direction that is required. The
advantages of this system are:

= Laser pulse rate is not linked to the viewing angle
= Possible to have a very dense and regular scan pattern
= No calibration required after factory setting

» Forward and side looking mounting of the laser possible

27



Fiber

switch
Oscillating Rotating .
mirror polygon u”&

Laser .- o "f :___

\ @ (same for

eon 9 =
receiving
optics)

q b C

Figure 20: Beam deflection methods (adopted from [10])

2.6. Metrological aspects: error analysis

Laser scanner companies publish the accuracies of their laser scanners to illustrate the
advantages of their particular product. However, experience shows that sometimes these should
not be taken at face value and that the accuracy of the instruments, which are built in limited
series, varies from instrument to instrument and depends on the individual calibration and the
care that has been taken in the use of the instrument.

Every point cloud produced by a laser scanner contains a considerable number of points that
show gross errors. If the delivered product is a point cloud the accuracy of the survey cannot be
guaranteed to the same extent as that of a survey by conventional instrumentation. Many
researchers have already published papers on accuracy tests with laser scanners (e.g. [11-15]).
i3mainz, part of the University of Applied Sciences in Mainz and the Institute of Geodesy and
Photogrammetry at the Swiss Federal Institute of Technology Zurich [16] have carried out some
exacting work in testing laser scanner accuracy. To be able to systematically describe error
sources for laser scanning they are divided into four categories: instrumental, object-related,
environmental and methodological errors.

2.6.1. Instrumental errors

Instrumental errors can be both systematic and random and are due to the scanner design.
Random errors mainly affect the range measurement precision and the angular location of
pulsed time-of-flight rangefinders. Systematic errors may be generated by the non-linearity of
the time measurement unit or by temperature drift in the time measurement electronics causing
range drift among other errors.

2.6.1.1. Laser beam propagation

Beam divergence is the laser beam widening with the distance travelled. Beam divergence has
a strong influence on the cloud resolution as well as the positional uncertainty of a measured
point. The beam divergence can be expressed by the following equation [17]:
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With

* pw = the range relative to the beam waist location
» w =radius of the beam
* wpo = the minimum beam radius (at the starting point) = beam waist

It is assumed that the laser reflection has a Gaussian shape. For large ranges, the divergence is
approximately linear and the beam diameter is expressed as the position that encapsulates 86%
of the total beam power within a Gaussian irradiance distribution [18].
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Figure 21: Ideal reflection, partial illumination, partial occlusion (from [18])

Practically, this beam divergence has an effect on the angular location of the point measured.
The apparent location of the observation is along the centreline of the emitted beam. However,
the actual point location lies somewhere in the projected footprint. According to Lichti and
Gordon [19], the beam uncertainty is approximately equal to one-quarter of the laser beam
diameter.

2.6.1.2. Mixed edge problem

One of the most important consequences of the beam divergence is the mixed edge problem.
When a laser beam hits an edge of an object, the beam is split in two. One part of the beam
reflects on the first part of the jump edge, while the other part travels further to hit another
surface. The result of this is that the information from one laser pulse that is sent back to the
receiver comes from two different locations in space. The coordinates for such a point, relative
to the scanner’s position, will be calculated based on an average of both returned signals, and
will therefore put the point in the wrong place.

Figure 22: Mixed edge effect
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When using a high resolution scan on an object, the chances of the beam hitting an edge are
increased and the resulting data will show noise just behind the edges of the object. Scanners
with a smaller beam width help to solve this problem but the range limit remains as the beam
width increases over distance.

2.6.1.3. Range-uncertainty

The range uncertainty can be expressed as a function of a number of parameters based on the
laser scanner type and its working principal. The following is a summary of range uncertainties
taken from Beraldin et al. [20].

For a triangulation scanner, the range uncertainty can be expressed by:

2
zzé‘

0.
* fD°P

Where:

» fis the effective position of the laser spot (effective focal length);
= D is the triangulation baseline,

» & is the uncertainty in laser position — depends on the type of laser spot sensor, peak
detector algorithm, signal-to-noise ratio and the image laser spot shape.

= 7/ is the distance to the surface

For a time-of-flight scanner, we already know that the range accuracy is dependent on the
clocking mechanism. This brings us to the following equation:

S ~ c.T,

* 24/SNR

Where

= Tis the pulse rise time.
= SNR is the signal to noise ratio.

Most mid- and long range terrestrial scanners provide a range uncertainty of about 5mm to
50mm within a range of 50m. In the modelling phase these errors are minimized by averaging or
by fitting of primitive shapes to the point cloud.

As already explained, continuous wave based scanners avoid the need for high speed clocking
mechanisms by modulating the laser signal. The range uncertainty in an amplitude modulated
laser scanner depends only on the modulated wavelength and the signal to noise ratio and can
be described by:

A
o, = L

* 474/SNR

Comparison of range uncertainty between different types of laser scanners can be illustrated in
a graph as shown in Figure 23.
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Figure 23: Range uncertainty for different laser scanner principles (adopted from [4])

2.6.1.4. Angular uncertainty

Most laser scanners make use of rotating mirrors to guide the laser signal in a certain direction.
A small angle difference can cause a considerable coordinate error when the distance from the
scanner increases. The angular accuracy depends on any error in the positioning of the mirrors
and the accuracy of the angular measurement device. Since the positions of single points are
hard to be verified, few investigations of this problem are known. As described by Boehler et al.
[21], errors can be detected by measuring short horizontal and vertical distances between
objects (e.g. spheres) which are located at the same distance from the scanner and comparing
those to measurements derived from more accurate surveying methods.

2.6.1.5. Axes errorsin a TLS

In the development of laser scanner calibration procedures, a geometrical model of the scanner
is needed. Therefore, we define the following axes:

= Vertical axis: This is the vertical axis that allows the rangefinder to move the laser beam
horizontally. Depending on the type of scanner, panoramic or camera-scanner, this is the
rotation axis of the scanning head or the axis orthogonal to the axes of the two mutually
orthogonal oscillating mirrors;

= Collimation axis: This is the axis that passes through the centre of the scanning mirror and
the centre of the laser spot on the object surface;

» Horizontal axis: This is the rotation axis of the scanning mirror;

Due to manufacturing tolerances, these axes are not perfectly aligned, leading to a collimation
error as well as a horizontal axis error.

2.6.2. Object-related errors

Since scanners measure the reflection of the laser beam from a surface, we have to cope with
the physical laws of reflection and the optical properties of materials. The surface reflection of
monochromatic light normally shows reflected rays in many directions. This type of isotropic
(diffuse) reflection (Figure 24) can be described in general by Lambert’s cosine law:
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I reflected (/1) = i (ﬂ)kd (ﬂ)COS(a)
With

= Ji (A\) the incident light intensity as a function of wavelength (colour), (is absorbed when
travelling through air)

= Kkqd(A) the diffuse reflection coefficient which is also a function of wavelength

» O the angle between the incident light and the normal vector to the surface.

Lambertian Surface

Figure 24: Lambertian surface reflection

This formula shows us that the laser beam is affected by the absorption of the signal travelling
through the air, the reflection of the material being measured and the angle of incidence
between the laser beam and the surface being measured. This means that for very dark (black)
surfaces that absorb most of the visible spectrum, the reflected signal will be very weak, hence
the point accuracy will be corrupted by noise. Surfaces with high reflectance (i.e. bright surfaces)
give more reliable and precise range measurements. However, if the object reflectivity is too
high (metal surface, retro reflective tape ...), the laser beam is fully deflected in the mirroring
direction and will hit another surface or spread into the open. This deflection results in the point
being measured not being the point that the laser is pointing at, but another point or no point at
all. This type of noise is called speckle noise.

Recording surfaces of different reflectivity also leads to systematic errors in range, sometimes
several times larger then the standard deviation of a single range measurement [21].
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Figure 25: Signal response when scanning surfaces of different reflectivity (adopted from [4])

As well as reflectance properties of the surface, colour properties affect the precision. Clark et
al. [22] have found that significant systematic range discrepancies exist which can be broadly
correlated against the colour of each surface with respect to the wavelength of the laser used.

Besides the reflectance effects, a number of materials have a semi-transparent coating that
allows the laser beam to refract and reflect in the material itself (i.e. wood, marble, styropor).
These effects lead to an addition constant to the distance measurements, which has to be
regarded in the computation [23].

Incident ray

refracted 2nd reflection

i.e. marble surface

Figure 26: Refraction effects in inhomogeneous semitransparent materials (Styropor, wood, marble).
2.6.3. Environmental conditions

2.6.3.1. Temperature

It should be noted that the temperature inside the scanner may be far above the temperature of
the surrounding atmosphere due to internal heating or heating resulting from external radiation
(i.e. the sun). This external radiation source might heat one side of the tripod or scanner,
causing that side to expand, slowly distorting the scanner data.

Not only the equipments temperature, but the temperature of the surface to be scanned is of
importance. When scanning a hot target, e.g. in an industrial environment, the background
radiation caused by the hot surface reduces the Signal-to-Noise ratio and thus the precision of
the range measurements.
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2.6.3.2. Atmosphere

Laser scanners will only function properly when used in a certain temperature range. Even
within this range deviations in measurements may be observed, especially in the distance
measurement.

As in all laser based distance measurement operations, natural errors stem primarily from
atmospheric variations in temperature, pressure and humidity which affect the index of
refraction, and modify the wavelength of electromagnetic energy. This means, that the laser light
velocity is strongly dependent on the air density.

Most laser scanning acquisition software provides for correcting this refraction by setting a
refraction parameter. In general the scanners are preset using the ISO standard atmosphere
parameter (15°C, 1013,25 hPa). When working under different atmospheric conditions than the
standard atmosphere, these parameters need to be adapted. A difference in temperature of
10°C or in air pressure of 35 hPa leads to a scan distance error of 1mm/100m.

In terrestrial cases, this effect may not seriously affect the results for short or medium range
scan distances. For long range measurements or high precision scans it is imperative to apply
the correct atmospheric parameters.

When working, for example, in a mountain region, the temperature decrease can be estimated
as 0.65°C/100m and the pressure decreases at 10hPa/100m. For a scan station positioned at
an altitude of 2000m the scan distance error would then be about 8mm/100m.

2.6.3.3. Interfering radiation

Since laser scanners operate in a very narrow frequency band, the precision of the range
measurement may be influenced by external radiation, for instance from strong external
illumination sources. Special optical interference filters can be applied in the receiving unit
allowing only the correct frequencies to reach the receiver.

2.6.3.4. Distortion from motion

Most laser scanners scan at a rate of 2000 to 500,000 samples per second. Although this is very
fast, scanning at high resolution can still take 20-30 minutes for some time-of-flight scanners and
about 10 minutes for phase scanners. During this time the scanner is susceptible to vibrations in
its surroundings causing displacements. We call this distortion from motion.

Since each point is sampled at a different time, any motion in the subject or the scanner will
distort the collected data. Therefore the scanner needs to be mounted on a stable platform to
minimize vibrations. The subject itself should also be motionless.

Notice that the scanner can also move due to changes in temperature. For example if the sun
shines on one side of the scanner, the legs of the tripod on that side may expand and slowly
distort the scan data (see paragraph 2.6.3.1). The latest scanners, also called scan-stations,
have a dual axis compensator integrated that compensates for any movement of the scanner
during the scan process.

2.6.4. Methodological errors

Methodological errors are errors due to the chosen survey method or the users experience with
this technology. For instance, if the user sets the grid density (resolution) higher than the per-
point accuracy of the laser scanner, the scan will be oversampled. By oversampling a scan,
extra noise is generated and the required processing time will increase dramatically. Another
possible source of error could be the wrong choice of scanner. By taking a scanner with a
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maximum range that is near the maximum range of the object to be scanned, these scans will
contain less precise measurements and possible noise.

Possible errors generated during the registration or consolidation phase are also categorized
under this topic. Depending on the technique used to register multiple point clouds, errors are
introduced. These errors occur in indirect registration/geo-referencing as well as in direct
registration/geo-referencing (see paragraph 3.5).

2.7. State of the art laser scanner equipment

The current state of the art laser scanners are fully integrated for faster set-ups. They combine
the scanner, a control panel, internal storage and battery in one piece of equipment. Special
dual axis compensators are also integrated to automatically level the scanner. Some scanners
have mounting devices to attach GPS receivers and/or INS compensators to directly position
and orient the scanner in space. To add high resolution colour information to the measured point
clouds, some scanners integrate high quality digital cameras or provide a mounting device.

Laser scanning technology is continuously developing:

= Special targets with integrated GPS receivers overcome the necessity of having to record
targets using total stations.

» Hardware based homogeneous point cloud filtering
= Combining the best of time-of-flight and phase based scanners into 1 scanner

Table 1 provides an overview of some commercially available laser scanner systems (year
2008).

Scanner/Criterion Trimble Leica Faro Z+F
GX Scanstation 2 LS 880 HE Images 5006
Scan Method Time-of-Flight Phase difference
Field of view [°] 360 x 60 360 x 270 360 x 320 360 x 310
Scan distance [m] 200 300 <76 <79
Scanning speed <5000 pts/s <50000 pts/s 120 kHz <500000 pts/s
Vertic. Ang. 0,0017 0,0034 0,009 0,018
Resolution [°]
Horizont. Ang. 0,0017 0,0034 0,00076 0,018
Resolution [°]
3D scan precision 12mm/100m 6mm/50m n.a. n.a.
Camera integrated integrated add-on option add-on option
Inclination sensor compensator compensator yes yes

Table 1: Summary of technical specifications of commercial available laser scanning systems (adopted from [24])
A recommended overview of different manufacturers of laser scanners and their laser scanner

specifications can be found through the ISPRS website:
http://www.cage.curtin.edu.au/~gordonsj/isprs_wgv3/survey.html
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3. Chapter lll: Laser scanning in practice

Using a laser scanner to record a building is not just pressing a button and waiting for the
deliverables to come out. It requires a profound knowledge of the equipment and the scanning
process. Some of the steps of the scanning process are quite automated while others are still
labour intensive. This chapter we will discuss the terrestrial laser scanning process.

Figure 27: The terrestrial laser scanner pipeline

3.1. Survey planning
At present there is no standard procedure for survey planning for terrestrial laser scanning.

However, according to the laser scanning users’ community, the survey planning should at least
contain the following topics (see Figure 28):

= Determining the goals and objectives
* Analyzing the area to be surveyed
= Determining the measuring techniques and equipment

= Data management
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Figure 28: Survey planning flowchart

3.1.1. Determine the goals and objectives

One of the key issues when recording an object, are the client’s goals and objectives. To fully
understand the client’s needs and requests, some questions have to be answered.

= Why does the client want this object to be recorded and what does he/she want to do with
the recorded data?

= The reason for recording an object or building can provide insight on the requirements
concerning the deliverables and their accuracy. Often the client might think laser scanning is
the ideal tool for their problem because they have heard that a competing firm has used a
laser scanner. Or, indeed, the other way around, the client might be afraid of using laser
scanning to record their building because they are sceptical and rely on using traditional
techniques. By listening to the clients requirements, guidance can be offered on the
appropriate measurement technique.

=  What deliverables are requested?
In close relation to the motivation for recording, we need to define the requested deliverables.

These deliverables can range from 2D plans and elevations to 3D models or even 3D
animations. In some cases the client may only want the raw point cloud for archiving. Particularly
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important is the level of detail (minimum feature size) of the deliverables because it helps in
determining the expected resolution (i.e. point density) [25].

3.1.2. Analyzing the areato be surveyed

Gathering as much information as possible on the object to be recorded provides insight into the
complexity and time required for a certain task. As already mentioned in the previous paragraph,
the required resolution and the accuracy of the recording are based on either the scale of the
survey area or the minimum feature size that should be recognizable in the final deliverables.
Field notes, reports, maps, photographs or video footage of the site can help in determining
possible hazards when recording the object, as can previous surveys which may have been
created by other means of recording (hand measured, GPS or total station data).

Not only the building itself can provide useful information, but also its surroundings. The site can
be scattered with obstructions, limiting the possible laser scanner setup positions, or there might
even be time restrictions on entering the site (i.e. recording metro tunnels). Indirectly the
possible laser scanner setup positions determine the minimum and maximum range which the
scanner should be able to record.

Using all this data, a decision can be made on the proper recording technique and if laser
scanning is chosen, the scanner type can be determined. Laser scanning is a highly developed
technique, but it is not always the most efficient solution for every problem. Sometimes it is
much easier and time-efficient to use another recording technique. Possible reasons to choose
for laser scanning are:

» Very complex surface structure (organic forms)

= 3D deliverables required

= Requirement for surface measurements instead of individual point measurements
» Data record that can be used by a multi-disciplinary team for different purposes

» Archiving without a priori knowledge of future use

» Access restrictions

= Etc.

3.1.3. Determine optimal scanning locations

Once the site documentation is gathered and laser scanning has been chosen to be the most
effective recording technique, the scan and target positions need to be planned.

The optimal locations for the scanning station should be chosen to guarantee a maximum
coverage and accuracy while minimizing the number of setups. As already mentioned in
paragraph 2.6, the accuracy of the measurement depends on footprint diameter from a given
scanner setup, indicating that the angle of incidence (see Figure 30) and the range to the object
are of great importance when determining the scanner’s position. A thorough analysis of
determining the optimal configuration of the scanner to achieve the required accuracy is
described in [26]. The following list gives a set of prioritized rules that should be kept in mind
while determining the optimal position of the scanner.
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Figure 29: (above) Bad scanner positioning, containing very inclined angles, (below) Good scanner positioning

» Check for positions that provide large area coverage without having obstructions in the line
of sight and that produce the least shadows.

= Check if the minimum/maximum range limits of the scanner are fulfilled to reach certain
accuracy, the larger the distance to the object, the lower the accuracy and resolution.

= Minimize the appearance of low intersection angles, under sharp angles the laser beam is
not so well reflected back to the scanner which results in less accuracy.
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Figure 30: Laser footprint when scanning under different angles dims too small
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» Try to decrease the number of scan positions.

= Other important facts that should be taken into account are:
= Health and Safety

= Environment (vibrations, wind...)

= Elevation of the scanner above the ground

= Visibility of artificial or natural targets

3.1.4. Determining the optimal target locations

Next to the optimal scanner locations, the target types and their positions and/or geometric
configuration are also important. Targets are mainly used to register scans taken from different
scan positions. Currently there is wide variety of target types available: retro-reflective targets,
spherical targets, paper targets, prism targets... In the near future, we will even have targets with
integrated GPS receivers.

One important remark when using targets is that they need to be widely spread, not only in x
and y direction but also in the z direction. This is often forgotten and sometimes all targets are
simply placed on the ground.

Figure 31: (above) Bad target configuration, (below) Good target configuration
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Some target configurations do not imply a unique solution to the registration process. For
instance if all the targets lie on a line, 1 degree of freedom remains, namely the rotation around
that line.

Special retro-reflective targets and spherical targets are often provided by the scanner developer
companies. These targets are designed to reflect most of the laser beam back to the scanner.
The scanner can therefore automatically detect these targets and after a fine scanning process,
determine the exact centre by fitting a primitive shape to the measured point cloud.

Sometimes paper targets are used because they are a lot cheaper than the retro-reflective or
spherical targets. On occasions a retro-reflective prism is fixed to the scanner head. Knowing
the offset between the deflecting mirror of the scanner and the prism, the scanner’s position can
be determined by measuring the prism with a total station.

Figure 32: Artificial target types

Mills and Barber [25] state that, depending on the registration technique used, there should be at
least 4 appropriately distributed XYZ control points/targets in each scan. A more detailed
explanation of the registration methods and their respective optimal target configurations is
described in paragraph 3.5.

3.1.5. Data management

It is important to think about the data storage before starting the scanning. For example, using a
Leica HDS4500, 1 scan is approximately 140 Mb. On an average scanning day 20-30 scans
can be made, generating a data set of approximately 7 GB. This requires careful planning.

3.2. Field operation

3.2.1. Survey preparation

The survey preparation phase includes the decision making on the registration technique to be
used. These techniques can be subdivided into three categories: registration using 3D re-
sectioning of scanned targets, registration by setting the laser scanner over known control
points, and registering using cloud to cloud constraints (see chapter 3.5 for more details).
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3.2.2. Setting up the scanner

Setting up a laser scanner generally follows a similar procedure to that of setting up a total
station. The following steps are performed (Figure 33):

= Set up tripod: Open the tripod and extend the legs. Make sure the tripod is on stable ground.
Usually the scanner will be placed at eye height. When the floor area needs to be scanned,
an even higher position is beneficial because it provides a better inclination angle.

= Attach the scanner by placing onto the tripod and locking into place.

= Depending on the registration technique, the scanner may be positioned above a known
control point.

= Level the scanner: By changing the length of two tripod legs used to position the tripod, level
the top surface of the tripod using the bulls-eye level. The bubble should be within the inner
circle. Be as precise as possible. When positioning the scanner above a control point, this
procedure should not alter the point you were over in step 3.

Figure 33: Setting up the laser scanner (from [27])

3.2.3. Connecting the scanner

Before starting the scanning, the scanning device itself must be connected to a laptop that can
receive and store all the points coming from the scanner and control the properties of the
scanner. Power can be supplied to the scanner using batteries, a generator or directly from the
main power.
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Figure 34: Fully integrated scan control on the scanner Leica HDS6000 scanner (from [27])

These are the steps to connect the scanner to a computer:

= Make the connection between the scanner and the laptop using the appropriate cable
(standard network cable for older scanners or a FireWire cable for use with newer scanners).

= Connect the battery to the scanner.

= Remove the lens cap from the scanner and unlock the scanner (most panoramic scanners
have a lock key to prevent them from turning whilst being transported).

» Turn on the scanner and wait for it to warm up.
= Start the scanner software on the laptop.

= Establish the connection between the computer and the scanner (using IP address, USB
cable, wireless connection ...).

= Open the scan controller software and initialize a connection.

The latest generations of scanners (i.e. Leica HDS6000) are fully integrated, which means they
combine a controller, data storage and battery in one piece.

3.2.4. Scanner settings

Once the scan controller software has established the connection to the scanner, the
parameters to use in the scan process need to be specified.

3.24.1. Targeting

Although most state-of-the-art scanners can scan a full 360° (Figure 35), this is not always
required. Therefore we need to define the area to be scanned. To do this, there are several
options.
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Figure 35: Example of the field of view of a Leica HDS6000 scanner (from [27])

Some scanners have a minimized control panel on the scanner itself which can define the target
area. This is a very rough way of defining the target area, but a very quick method.

Mostly, the targeting area is defined using the scanner control in the software. Using this type of
targeting, we first capture an image of the scene that allows the target area to be selected.
Scanners nowadays have integrated fixed cameras or even video cameras to show the user
what the scanner is seeing. Using the scan control software, the user can then select the target
area using a selection box similar to selecting a part of an image in image processing software
(Figure 36).
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Figure 36: Defining the target area
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Most phase-based scanners do not have a camera because of their technical design. However,
these scanners can record so many points per second that creating a low resolution scan only
takes as long as another scanner taking pictures. This low resolution scan can then be used to
select the target area.

3.2.4.2. Resolution

The key question when carrying out a laser scanning project is choosing the correct resolution.
The resolution is defined as the distance between two subsequent measured points, and thus
determines the density of points in the point cloud. Often people mistake accuracy with
resolution. Although there is a certain connection between both, they still define a different
aspect of the laser scanning process.

The resolution is mainly governed by the smallest detail of the surface structure that needs to be
recognizable in the final deliverable. Therefore it is also directly related to the scale of the
deliverable. In fact, laser scanners overcome the intelligent processing that humans do when
analyzing a building (i.e. splitting a building up into planes, lines and points) by recording a huge
set of points with redundant information. For instance, in smooth areas like planes, less points
are required to model the object, while in areas with high curvature, many more points are
required, sometimes even more then the laser scanner can provide.

It should be noted that the higher the chosen resolution, the more points need to be scanned
and thus the longer it will take. Besides the time frame, the dataset storage size increases. The
operator should bear in mind that scanning at a higher resolution than the scanner’s single point
accuracy in distance measurement can cause oversampling and thus result in more noise in the
final dataset.

Since most laser scanners work with constant angle change between two consecutive points
(based on polar coordinates), the scanner resolution is defined at a specified distance to the
scanner. This distance can be manually entered through the software, or a probe can capture a
point distance value and define the resolution at that distance from the scanner. Points scanned
further than this distance will have a lower resolution, while points scanned closer have a higher
resolution. In general, it is advised to take the probe point at the furthest point to be scanned.

Some scan control software provides quick settings for the resolution, i.e. low, medium or high
resolution. These quick settings set the resolution to a specific value for a certain distance. In
the manual of the scanner, tables are provided illustrating the effective resolution at several
distances for each setting.

English Heritage, a non-departmental public body of the United Kingdom with substantial
expertise in managing the historic environment, created a table which helps a user to determine
the appropriate resolution for the project [28, 29].

point density required to  point density required to
feature size example featurs give 646% probability that  give a 95% probability that
the feature will be visible  the feature will be visible

[0000mm  large earth work 3500rm S00mm
[000mm  small earth workf/ditch 350rmim 50rmm

[ 00 large stone masonry 35mm Srnm

[ Ornim flint galleting/large tool marks  3.5mm 0.5mm
[ Weatherad masonry 0.35mm 0.05mm

Figure 37: Appropriate point densities (sampling resolutions) for various sizes of cultural heritage features [28]
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This table is generated based on the following formula [29]:

'
m
Q=1- (—
\ A
Where Q is the quality of the data, m is the point density (resolution) on the object and A is the

minimum feature size, or the point density required. The value Q therefore indicates the level to
which the object has been scanned.

3.2.4.3. Primary Filtering

While scanning, the scan data can be filtered using primary filters, sometimes also called
hardware filters. Different options are given: filtering by range, filtering by reflectance value, or a
combination of both. Primary filtering can be used to make sure that the data collected is within
the range of the scanner’s range accuracy limits, or to remove points with low reflectance values
because they are probably not accurate enough.

Figure 38: Primary point filtering based on Range

3.3. Data acquisition

3.3.1. Scanning the object / building

Once the field-of-view is determined and the proper resolution is set, the scanning itself can be
started. The scanning process is almost fully automated. After pressing the control button in the
scan control software or directly on the scanner control, the scanner moves to the starting point
and starts collecting points. These points are stored by the laptop or in the internal memory of
the scanner itself. When a laptop is connected to the scanner, the points scanned are directly
visualized in three dimensions on the screen and provide an overview of the area that has
already been scanned. After scanning, it is a good practice to check the scan for unforeseen
obstructions that cause occluded areas in the scan data.

In most scan control software, the target and parameter settings can be scripted, so multiple
regions can subsequently be scanned with different resolutions. A script can be created to
enable specific areas to be scanned at higher resolution whilst the general scan is running, so
that better defined features can be used as registration features in the registration process.

Depending on the chosen resolution and the targeted area, the scanning process can take from
5 minutes up to 120 minutes or even more. During this time, the survey notes should be made or
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in case the sketch of the surroundings hasn’t been made during the survey planning, this might
be the time to do this. The sketch and survey notes should show/describe the object(s) being
scanned, the target positions and their labels and the scan positions. Specific external
conditions influencing the scanning and the scanner settings used should also be noted.

3.3.2. Scanning targets

When artificial and/or natural targets are used to register the scans in the registration phase (see
paragraph 3.5), these targets should be labelled and measured very precisely.

Because of the limited speed of a time-of-flight scanner, the scanning is done in two phases. At
first the subject is scanned using a resolution that is appropriate to reach the requested
deliverables. In a second phase, the targets are fine-scanned (Figure 39) to reach a higher
accuracy when determining their centre position. However, in public areas it would be beneficial
to first scan the targets and afterwards scan the subject to avoid any possible movement of
targets.

After finishing the global scan (phase 1), most scan control software provides tools to
automatically detect artificial targets in the scan. Since these artificial targets are made from
highly reflective material, their reflectance value is much higher than its surroundings. However,
since these automated detection tools often give erroneous results, so it is advised to always
check the results and make sure no target is missed.

Figure 39: Scanning artificial targets

Once the approximate positions of the artificial targets are known, they are scanned with very
high resolution (phase 2). The scan control software can then automatically fit a specific target
shape to the target and determine its exact centre point.

47



Figure 40: Target fine scanning

Sometimes points-of-detail are used instead of or along with artificial targets. A point-of-detail is
a geometrical point that is highly distinguishable and can be accurately located due to its shape.
These points are also scanned with very high resolution. It is good practice to manually insert
the vertex for this natural target and label it on site to reduce misinterpretation problems at the
processing stage.

It is important to note that the latest generation phase based scanners scan at high speed so
that a 360° scan at very high resolution may only takes 5 to 10 minutes to complete. The targets
are automatically scanned at high resolution, so they do not have to be scanned again
afterwards. This way of working is of course much faster since the user does not have to identify
and fine-scan these targets on site. However, the labelling of the targets now needs to be done
in the office and requires very good field notes and sketches of the site.

3.3.3. Measuring the targets

A part of the scanning process is the recording of the targets with a total station survey
instrument. If multiple total station setups are needed, a traverse or resection should be
performed to minimize errors in the recording process. Since it is assumed that students working
with this tutorial have a background in surveying, this process is not described in detail.

3.3.4. Completeness checking

As already mentioned, it is of great importance to double check the scan’s completeness when
the scanning is finished. Realizing a part is missing in the scan data when at the office may lead
to an expensive return visit to the site. The second visit might require more time than checking
the completeness on site during the first visit would have taken. When working with a laptop,
point splatting can help with this (see paragraph 3.6.1)

3.4. Data preparation

Back at the office, the data is analyzed and compared to the field sketches and notes. It is
advisable to start working on a copy of the original scans and keep the originals as backup.
Different types of scanners store the point cloud information in different formats. More
information about point cloud file types and their advantages or disadvantages can be found in
Chapter 4. For archiving purposes, it is important that the file format is easily accessible and
recognisable. If it can be accessed directly, without any decoding, it can later be easily
converted to any other format readable by an appropriate piece of software. The file format
should also contain the data in its most rudimentary format, instead of using the most preferred
format for reprocessing. The most common format at this time (circa 2008) is the *.xyzrgb
format.
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Always add a meta-data file to the backup files containing the field sketch, field notes and all the
data gathered already in the preparation stage of the scanning job.

Before processing the clouds, scans affected by extreme environmental conditions or erroneous
scans due to human mistakes are removed from the data set. The scans that are not removed
now need to be prioritized according to the ‘best views’. The prioritization is done using the field
notes and sketches.

In some cases, it is also required to clean some scans before the registration phase. When
targets are put very far from the scanner or due to certain environmental conditions, the target
fine scans can be cluttered with noise. This noise has to be removed before registering the
scans because it will affect the precision of the registration phase.

3.5. Registration & Geo-referencing

In most cases, the object to be scanned is too large to be scanned from one position only.
Therefore, multiple scanning positions are required. Each scan position is defined in a scanner
coordinate system. To be able to align different scan positions, it is necessary to know the exact
position and orientation of these scanner coordinate systems according to a local/global site
coordinate system.

Figure 41: Registration between two scan positions

Directly linked to the aligning, or registration, is the geo-referencing of the whole dataset. Geo-
referencing means, besides aligning the scans, also geo-referencing the dataset to a fixed
coordinate system. The next paragraphs will explain the possibilities for registration and geo-
referencing.

This tutorial categorizes the registration techniques into direct and indirect registration or geo-
referencing techniques.
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Figure 42: Registration Techniques

3.5.1. Indirect Registration & Geo-Referencing

Indirect registration implies making use of target features (artificial or natural) in the scene itself
to align datasets. If geo-referencing is required, the targets themselves should be recorded and
transformed into a known coordinate system using recognised surveying methods.

To perform an indirect registration at least three target correspondences between two scans are
needed. However, it is always better to have more than three, so that errors can be minimized
by performing a least-squares optimization.

3.5.1.1. Target-to-target registration

Places that are easily accessible do not pose a problem for placing targets. Atrtificial targets
come in a variety of forms. There are special targets from the laser scanner companies made
from highly reflective material, but printed paper targets can also be used. When no printer or
special targets are available, targets may be improvised by using objects to which an ideal
geometrical surface can be fitted. For instance, pieces of a cylindrical tube can be used as
targets. Using the scan processing software, an ideal cylinder can be fit to a fine scan of such an
object to determine the centre axis with very high precision. If the cylinders are then placed in
both a vertical as well as horizontal direction, they can be used to align different scans.

In areas that are not easily accessible, for instance that are too high to reach, natural targets can
be used. Natural targets are points of interest in the structure itself that can be identified with
high precision, for instance edges of windows or cornices. As English Heritage states in their
publication [28], the registration results obtained using these natural targets are poorer than
using the artificial targets. The reason for this is twofold:

» The common features in different point clouds are not composed of identical points, which
are, essentially, circles of several mm in diameter, because of the laser beam divergence;
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» |dentification of common features is rather subjective, especially on very inclined scans.

3.5.1.2. Cloud-to-cloud registration

Another way of registering two point clouds is by using point cloud overlap. If two point clouds
have enough overlap (generally 30 — 40%), a technique called Iterative Closed Point processing
or ICP can be used to align both datasets. This technique requires the user to manually pick at
least 3 corresponding points in the point clouds. Since these 3 points will never be exactly the
same points (see explanation in the previous paragraph), the ICP algorithm iteratively checks
the distances between all the points of the point clouds and estimates the transformation to align
both sets thus resulting in minimal error.

The rules on target configurations mentioned in the previous paragraph are also applicable to
the point configuration in cloud-to-cloud registration.

This registration technique should be used with caution. When scanning long linear structures
where multiple setups are required, small errors in each registration pair may propagate and
result in large global errors (see Figure 43).

Figure 43: Error propagation due to cloud-to-cloud registration of multiple facade scans

3.5.1.3. Surface-to-surface registration

In 2006, A. Gruen published a new technique to align datasets by matching the surface
geometry of two scans. His algorithm estimates the Euclidian distances between surface
patches by least squares and tries to minimize this distance iteratively as in the ICP algorithm.
This method offers high flexibility for any kind of 3D surface correspondence problem, as well as
statistical tools for the analysis of the quality of the final result.

Surface-to-surface registration is especially useful when some of the scans contain substantial
quantities of noise. In this case, it is better to first clean and mesh the separate scans so that
each scan can be processed using the appropriate settings. When all scans are transformed into
surfaces, the surface-to-surface registration can be used to align the different scans.

3.5.2. Direct Registration & Geo-Referencing

Direct registration means that the position and orientation of the scanner is directly computed.
This can be done in two ways. One example is the laser scanner with some capabilities of a total
station, where the scanner can positioned directly over a known point using a laser plummet.
The orientation can be determined by scanning only 1 target in the next laser scanner setup
position. These laser scanners also have a dual-axis compensator so that they level themselves
within certain limits. This levelling imposes a third restriction on the orientation of the scan.
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Sometimes, a special reflector is fixed on top of the scanner’s vertical rotation axis. The exact
position of this reflector to the laser beam centroid can be determined through a calibration
procedure. If this position is known the reflector can be measured using a total station as would
be done when setting up a closed (or open) polygon for traverse networking. Other ways of
determining the scanner’s position, is by mounting a GPS receiver to the scanner.

This technique reduces the number of targets to be placed and therefore avoids the quite
demanding requirements on the target configuration. The scans also do not need overlap.
Taking all these considerations into account, this technique is often faster than using indirect
registration.

When geo-referencing is required, the measured reflector position can be transformed into a
specific known coordinate system using general surveying techniques.

3.5.3. General aspect of Registration and Geo-Referencing

This paragraph describes some advice in care which should be taken when registering datasets
or even planning the registration phase. Most of these statements are adopted from a
publication by English Heritage [29].

= When performing a registration, make sure the residuals of the global registration process
are equal to or better than the geometric precision required by the end deliverable.

» When registration is done solely using resection calculation (indirect), each scan should
contain at least 4 appropriately distributed XYZ control points/targets. This over-determines
the geometric relationship between the two datasets and therefore a least-squares
optimization can be used to minimize errors in the target recordings.

» Always include the residuals of the registration process and the geometric precision of the
estimated parameters in the survey report.

» Add illustrative photography/screenshots of irregular features in the scan data caused by
cracks or features on the subject that could be misinterpreted as errors in the registration
process, and note them in the survey report.

= Do not put artificial targets at places where they obscure important details of the subject.
Don’t make the targets too large.

» When mounting targets on the surface of the subject, make sure the adhesive does not
damage the structure

= Try to avoid the use of natural target points, because they are less accurate than artificial
target points.

» The scan control software must be adapted to the type of targets used. Some flat retro-
reflective targets for instance show a Halo effect caused by multiple target returns of the
laser energy in the vincity of the target centre. Proper software can reduce the cluster of
returns to the target centre e.g. by using intensity-weighting of individual returns [11].

» When artificial targets are scanned under very sharp angles, the automatic target
identification tools should not be used, because they give bad results [15].
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3.6. 3D point cloud processing

Point cloud processing means the process of transforming the raw registered point cloud into a
final deliverable. These deliverables come in a wide variety of formats: cleaned point cloud data,
standard 2D drawings (e.g. plans, elevations, cross-sections), fully 3D textured models for
walkthrough animations.

Often, scanner companies show impressive videos of point clouds turning into fully textured
models in less than one second. However, in reality this process is still very time consuming and
is mainly a manual process. In the Figure below, an overview is given of the different steps in
the laser scanning process and their grade of automation.

degree of
automation
high —
low -
> workflow of
| | | TLS processing
acquisition registration modeling

Figure 44: Automation in the Terrestrial Laser Scanning Workflow (adopted from A.Gruen)

In general, the 3D point cloud processing can be divided into two categories. Deliverables can
be extracted straight from the point cloud without further processing, or by first creating a 3D
surface model from the point cloud and extracting the deliverables from this surface model.
Which method is chosen depends greatly on the required deliverables. For instance, when only
a limited number of cross-sections are required, it is better to extract them directly from the point
cloud. However, when more sections (+50) are needed, the second method is more efficient
because there are automated tools to generate multiple cross-sections from a meshed model.
Furthermore, the surface model adds more value and understanding than just a raw registered
point cloud.

3.6.1. Point Cloud representations

The result of a scan acquisition is a huge number of points in space, each having an x, y, z
coordinate and usually a laser reflectance value. Some scanners even provide colour
information in the form of RGB values.

The point cloud can be represented by drawing all these points on the screen, but this gives a
very chaotic impression and a user will have difficulties recognizing structures from the cloud.
When every point is given its reflectance value or a colour value, the overall structure becomes
understandable.
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Figure 45: Figure of an unorganized point cloud

Since most laser scanners scan a scene in columns and rows, one way to represent a point
cloud is in a very simple way is as a depth map. A depth map is a matrix-like structure (2D) in
which each pixel represents the distance of the 3D point to the scanner in the form of a grey
value. Because this type of representation incorporates neighbouring information, it is of great
use in point cloud processing algorithms and is known as an organized point cloud.

Figure 46: Depth map

By using complex meshing (triangulation) algorithms, neighbouring points can be connected to
form surfaces. This provides a closer representation to reality because surface structures or
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meshes are not transparent, therefore points lying behind others cannot be seen. By computing
the local normal directions of the surface, artificial shading can be used to highlight surface
details.

Because the generation of a mesh, especially from an unorganized point cloud, is complex and
can take considerable time, there have been attempts to find alternatives to quickly make a
coarse representation of the cloud just for viewing and analyzing. As a result, the idea of laser
point splatting was launched. Point splatting generates surfels (small surface elements) for each
point in the cloud from the raw laser scanner data. Each surfel is represented by a small
primitive surface shape (circle, ellipse ...) in 3D that inherits its normal computed from its
neighbouring points. This results in a very high speed surface representation.

Figure 47: Result of laser splatting (left), close up of laser splatting (right)

3.6.2. Dataimprovement

3.6.2.1. Noise Filtering

A first step in the meshing process is removing noisy data from the point cloud. If noise has
been introduced due to wind, bad surface reflection, etc. (see chapter 2.6), the mesh will contain
triangles connecting these noisy points to correct points. This results in a mesh full of spikes. It
is therefore important to remove these noisy points in the first step.

Often, an operator can easily identify parts that are scanned, but are not required in the final
deliverable. Therefore, it is advised that this operator performs a first analysis of the point cloud
and removes all the unnecessary points from the dataset by hand.

Automatic algorithms that remove noisy points are mainly based on two principles. The first
principle is the fact that points that have little or no other points in their direct surroundings, are
considers to be outliers. They probably originate from people or other obstacles moving in front
of the scanner while scanning is in progress and are not part of the object to be scanned. These
points can easily be identified using a limited number of parameter settings and then be
removed from the point cloud.

Another noise removal principle is to move points slightly so as to achieve an optimal
smoothness of the surface. These algorithms try to locally fit (freeform) planes to the points in
the point cloud. When the central point lies very far from the fitted plane, it is moved towards the
plane so as to provide more consistency to its neighbours.

Other noise filters exist, some specialized according to scanner type, others removing

systematic errors. Of course, care has to be taken when removing noisy points. Features can be
lost when over-smoothing the dataset or removing too many points.
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3.6.2.2. Resampling

As mentioned earlier, when creating a mesh, the triangle count is more than double the point
count. A meshed version of a phase based point cloud can easily measure up to 20 million
triangles. This number of triangles becomes difficult to work with using standard hardware. In
general, the number of points needs to be reduced before meshing and this point reduction can
be done in two ways.

The easiest way of reducing the number of points, is by deleting one point within every few other
points. When based on their 3D spatial position, points can be removed while keeping full
coverage of the area. However this technique possibly removes points in areas that contain
important features and therefore may remove valuable information.

Another way of removing points is by looking at the surface curvature to determine whether a
surface part is smooth or is highly curved. This point cloud resampling technique works
intelligently, keeping valuable points in areas of high curvature, while removing points in areas
that can easily be represented by fewer points. Using this technique, a proper reduction of the
original point cloud size can be achieved without loosing valuable features.

3.6.3. Direct 2D modelling from point clouds

Direct 2D modelling from point clouds is a matter of human interpretation. Most available
software packages in this domain are plug-ins for CAD packages like AutoCAD or
MicroStation. Special interfaces let the user load huge point clouds into these programs to
process them using the standard CAD tools. Typical software to perform these tasks are: Leica
CloudWorx, Kubit Pointcloud, LFM CAD Link, ...)

Cross-sections, plans and elevations can be generated by taking a thin slice of points from the
point cloud and projecting all the points onto a plane. Then the user has to manually trace or
connect the points creating lines, arcs, etc. The user makes an interpretation about corners and
details that are smaller than the scan resolution. This is a precise and difficult task and may take
considerable time to complete just one cross-section or plan. The person performing this task
must have a proper understanding of the building or structure or have photographic material at
their disposal to make the correct interpretations.

In some research centres, academics create algorithms that can automate these tasks. A
number of these algorithms have proved to be useful; however they need certain restrictions to
generate satisfying results. This means that they cannot be used in a generic way and thus are
not yet implemented in commercially available software.

Elevations can be created in two ways. When there is colour information available through
photographs, or the laser beam reflection intensity is available, the coloured points can be
orthogonally projected to a plane, generating a true ortho-photograph. By tracing this ortho-
photograph, an elevation can be made. An important note to make is that the accuracy of the
elevation depends highly on the resolution of the scan.

Another way of creating an elevation is by tracing important edges (e.g. window openings, door
openings, etc.) in the 3D point cloud and then projecting all these 3D entities into a plane. This
technique requires a good geometrical understanding and a capability for recognizing structures
in point clouds quickly.

Some software packages allow the user to register external images to the point cloud and use
these for mono-plotting. This means that the interpretation is done in the image and the depth
information is gathered from the point cloud. The problem with this type of software is that the
results should always be double checked, because tracing an edge in an image often is
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misinterpreted by the software due to missing data and therefore is not generated in its correct
position.

3.6.4. Direct 3D modelling from point clouds

When the shape of a 3D object is known beforehand and it can be described by geometric
primitives, it can be automatically detected from a point cloud. When fitting these geometric
shapes to the point cloud, the algorithm makes an assumption that it is an ideal shape. For
instance, a scan of a petrochemical plant can be easily converted into a 3D model, assuming the
fact that all pipes have a circular cross-section and the connecting pieces also have a specific
shape. Most of these applications are applied to the petrochemical industry.

3.6.5. 3D modelling of complex surfaces

In general, the final product of the 3D modelling process is a meshed surface model. By
connecting all the points in the point cloud with small triangles, a surface model or mesh is
generated. This mesh is an interpolation of the points in three dimensions creating a full surface
representation. To create a quality mesh, a number of steps have to be followed:

= Data cleaning (noise reduction, removing outliers...)
= Resampling (see 3.6.2.2)

» Meshing/triangulation

= Hole filling (bridging, merging...)

= Mesh optimizing (decimation...)

3.6.5.1. Meshing/Triangulation

Different algorithms exist to create meshes from point clouds. The connections between points
are usually made out of triangles or quadrilaterals. By far the most popular of the triangle and
tetrahedral meshing techniques are those utilizing the Delaunay criterion [30]. The Delaunay
criterion states that any point should not be contained within the circumsphere of any tetrahedral
within the mesh, which is illustrated in 2D in Figure 48.

(a) (b)
Figure 48: Example of Delaunay criterion. (a) maintains the criterion while (b) does not. (adopted from [30])
In recent years, more complex meshing algorithms like the ball pivoting algorithm or the

marching cubes algorithm have been developed which are able to triangulate huge datasets with
low memory consumption.
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3.6.5.2. Hole filling

Multiple scan positions are used to solve the occlusion problem. However, small gaps are
introduced into the point cloud when meshing due to insufficient data. A number of algorithms
that are able to fill these holes have been developed over recent years. These algorithms use
interpolation to make up the lack of information. The hole can be filled ‘flat’, only connecting the
surrounding points by simple triangles, or using curvature based filling in which the surrounding
points and surface triangles are used to both create new points and fill the hole creating a
smooth surface.

3.6.5.3. Mesh Optimization

Although the point cloud has been reduced during resampling to create lesser triangles in the
mesh, it might be necessary to reduce the number of triangles in the mesh in a second step to
overcome hardware capabilities. This is called mesh decimation.

Other ways of optimizing the surface description is by approximating it using mathematical
surfaces. One of the most commonly used surface types for this task is NURBS (Non Uniform
Rational Basis functions). These nurbs are mathematical precise representations of freeform
surfaces like those in car bodies, ship hulls or even the human face. They have control points,
which direct the surface; however these control points are not necessarily points of the point
cloud.

3.6.6. Indirect 2D modelling from point clouds

Indirect 2D modelling means generating 2D drawings from 3D modelled or meshed objects. This
technique is useful when multiple cross-sections have to be made, for instance one cross
section every 1 centimetre to be able to create a depth contour map.

Indirect modelling requires a 3D modelling phase as described in chapter 3.6.5. Once a surface
model has been created it can easily be intersected by planes to create cross-sections. The
interpolation of areas in-between the measured points, is automatically done in the meshing
phase and does not need to be performed by an operator.

3.6.7. Texture mapping

A texture map (i.e. colour information or other) is mapped to the surface of a shape, or polygon.
To correctly place the texture information UV maps are used (see Figure 49). In contrast to x, y
and z, which are the coordinates for the original 3D object in the modelling space, "U" and "V"
are the coordinates of the transformed object. UV mapping transforms the 3D object/mesh onto
a flat image which can then be used to attach textural information. This mesh transformation can
also be described as an unfolding or pelting of the 3D shape onto a 2D canvas.
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Figure 49: (a) Cube without texture information, (b) UV layout, (c) textured cube, (d) texture information

When a model is created as a polygon mesh using a 3D modeller, UV coordinates can be
generated for each vertex in the mesh. One way is for the 3D modeller to unfold the triangle
mesh at the seams, automatically laying out the triangles on a flat page. A UV map can either be
generated automatically by the software application, made manually by the artist, or a
combination of both. Commonly used maps are, height maps, normal maps, displacement
maps, light maps, specular and bump maps.

Once the UV map is created, the user can paint/colour this UV map and then project it back to
the 3D model, making it easier to correctly colourize a 3D model.

Instead of using UV maps, some 3D software packages also have an option to project and bake

the texture information onto the surface, usually using orthographic projections, which simplifies
the texturing process (Figure 50).
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Figure 50: Orthographic projection plane and surface

Unfolding is preferred over projections because of minimal texture stretching. Both techniques
can be used and mixed in a single 3D model.

In laser scanning, often high resolution photographic information is required for visualization of
3D models. For accurate mapping, the positions of the cameras and the internal camera settings
(focal length, lens distortions...) have to be known in relation to the model. Commercial software
packages provide algorithms that allow the user to manually select corresponding points
between the image and the 3D model to determine these unknown parameters. Given enough
correspondence, the position and parameters of the camera can be calculated.

Mainly two different algorithms exist to project photographs onto the 3D model, texture mapping
and texture draping. Texture draping can be described as putting the photograph onto a piece of
elastic canvas and then pulling it over the 3D model. This implies that areas that do not contain
a lot of information or no information at all in the photograph (for instance very oblique surfaces)
will be stretched and are therefore not textured correctly. Texture mapping overcomes this
problem by first analyzing the visible parts in the image and then only projecting these photo
pixels onto the 3D model.

The detail of the texture map is dependent on the resolution, this is mostly defined as power of
two (i.e. 512*256, 1024*1024) which is best for graphic memory. The new generation of graphic
cards is more capable of handling textures which do not have power of two.

3.7. Quality control & Delivery

The quality aspect of surveying using laser scanners needs careful consideration throughout the
measurement and processing process. Each time the scanner is set up to capture data (before,
during and after) certain elements of the data should be inspected and checked against
expected or predicted results. The most technical factors that might have an influence on the
quality of the data have been explained, in detail, in 2.6. In addition to these factors, scanner
operators should also be checking factors such as sufficient area coverage, even point
distribution with required resolution, reference photography with high resolution camera, correct
acquisition of reflective scanner targets and acquiring additional check dimensions which would
be very useful at further processing steps.

Quality starts with a full understanding of project specification. This understanding allows the
correct choice of scanner, correct scan resolution, appropriate registration method and so on.
For example, choosing a scanner which has insufficient range, not using enough scan targets
and positions, not allowing appropriate overlap (if decided to register your scans using
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overlapping scans), and most importantly, not using the correct scan resolution will have a direct
effect on the quality of the end product when produced from point cloud data.

Adequate on-site documentation ensures the achieving of optimum quality. Supporting sketches,
reference photography, check dimensions would be used in later processing steps.

In general, the aim should be to reach a registration accuracy ten times smaller than the
accuracy of the required deliverable. Keeping this in mind, there are many other elements that
might have an effect on accuracy; so it is always better to aim for the best registration results.

The flowchart below (Figure 51) gives an overview of quality assurance for laser scanning
surveying.
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4. Chapter IV: Data management

As referred to in chapter 3.1, data management needs to be considered when starting the
survey planning. A laser scanner captures thousands of points per second and therefore
datasets become very large in a short time. Thus, equipment able to store, process and archive
the laser scanner data is needed.

To understand data storage, it is necessary to know about commonly used file formats to store
laser scanner data. File formats govern the amount of precision and the amount of information
stored in the file. Some file formats save coordinates with single-precision floating point (32bit),
while others store with double-precision floating point (64bit). When storing the absolute or
relative Euclidian coordinates of points this might not be so important, but some scanners store
their data in polar coordinates. In polar coordinates, an angle difference of 0.01 degrees means
a change of 1cm at a distance of 50m. In this case, floating point precision becomes very
important. When converting between different file formats these differences need to be taken
into account.

Some file formats only contain point information (x,y,z coordinates), while others add more

information such as colour and reflectance information, point normals, scanner position, etc.
Commonly used formats to store point clouds are:

= DXF: AutoCad format

» PTX: Leica ordered text format containing xyz coordinates, reflectivity and colour
information, sometimes also contains the scanner position

» PTS: Leica unordered text format containing xyz coordinates, reflectivity and colour
information; XYZ : unordered text format containing xyz coordinates

= XYZ: unordered text format containing xyz coordinates

= XYZRGB: unordered text format containing xyz coordinates and colour (RGB) values for
each point

Because laser scanning captures huge amounts of data, much more than is actually required; it
can often be utilized at a later date in a project. Therefore, it is important to archive the data and
keep it accessible for an extended period of time. Archiving in itself has become an important
matter, not just in laser scanning.

When archiving, it is as important to add meta-data to know what has been scanned and how it
has been stored or processed. According to English Heritage [29], the metadata should be
subdivided into scan metadata and project metadata, registration metadata and control
information.

Scan metadata:

= File name of the raw data

» Date of capture

= Scanning system used (with manufacturers serial number) Company name
* Monument name

=  Monument number (if known)

= Survey number (if known)
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= Scan number (unique scan number for this survey)
= Total number of points

» Point density on the object (with reference range). Weather during scanning (external scans
only)

» The file name of an image, located at the point of collection, showing the data collected — the
filename should be the same as the filename of the raw data file.

Project metadata:
* Filename(s) of the raw data used in the registration

= Data of capture (month and year)

= Scanning system(s) used (with manufacturers serial number(s))
= Company name

= Monument name Monument number (if known)

= Survey number (if known)

= Number of individual scans

= Scan numbers of all scans

» Total number of points

= Filename of the control data

= Description of registration method (e.g. “All scans registered to local site grid using targeted
points.”)

= An index plan showing the data collected with individual scan points named
= Weather during survey (external scans only)

= Any scanner specific information.

Registration information (for each scan position):
» Translations in the X, Y and Z axes necessary to transform the scan origin to the scan
position.

= Rotations around the X, Y and Z axes. This should be carried out in the order X, Y and Z.

Control information:
= PointID, X, Y, Z, cDX, aDY, aDZ, comment (optional)

The media and the format in which the data is stored for later use, determines if the data can be
read in 10 years or even in 50 years time. Contemporary media such as external hard disks,
CD-ROMS, DVD’s or even BlueRay have the possibility to store large amounts of data, but their

64



lifespan is uncertain. Therefore, it is necessary to backup backups when their lifespan is almost
reached. The format should be as simple as possible (for instance text files) and contain as
much information as possible which would imply larger file sizes.
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5. Heritage case study (anti-disaster record): St. James
Church

5.1. Introduction and Technical Information

This case study will explain how to record complex buildings, linking the interior measurements
to the exterior measurements. The main focus areas are the registration phase and the 2D and
3D modelling using third party software tools.

5.2. Problem statement

The St. James Church is situated in Leuven, Belgium. It dates back to the year 1220 when the
construction of the western tower began. During several subsequent building phases, the
Romanesque Church has been replaced and extended by a Church in early Gothic style. The
wooden roofs in the central and side naves were replaced with masonry vaults, and flying
buttresses were added. The Church is approximately 62 meters long, 38 meters wide and 28
meters high from the ground up to the rooftop, not including the Church tower.

Because it is constructed on a former swamp, the load-bearing capacity of the subsoil is limited,
causing large differential settlements. In the past, restoration works took place at various times.
However, due to the excessive cracks observed, it was decided in 1963 to close the Church to
services, in fear of its structural collapse. During subsequent years structural supporting shoring
was put in place to stop the Church from degrading. In 1995 the city of Leuven decided to
restore the Church into its original state and to valorise it as a multi-cultural space.

To be able to start the restoration of the Church, a number of actions should be taken:

» Since the Church has changed many times over the years by adding, removing or
renovating pieces of the building, “as-is” plans and sections are required. Therefore the
Church should be surveyed, providing the geometrical layout as 2D drawings.

» To assess the structural conditions of the building, in particular the masonry vaults and
some wall pieces that may have deformed during the years, measurements need to be
made so that these building elements can be compared to their geometrically ideal
shape. A full 3D model of these elements is requested that can later be used in a finite
element analysis. Using this data, appropriate structural supporting and/or reinforcement
techniques can be chosen to keep the Church from deteriorating any further.

= The foundations of the Church should also be checked and reinforced to keep the Church
from moving and to assure its structural safety in the future. This task will be performed
by structural engineers using high-precision structural monitoring tools.

The history of this Church already reveals several interesting items related to its structural
problems:

= 1484-1485: Construction of bell-tower (masonry and wood) on crossing. Dismantled in
1735 because of the severe state of decay.

= 1485-1488: Reconstruction of masonry vaults in side nave — northern and southern side.
= 1534-1535:
= Construction of additional level with windows in main nave.
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» Construction of supports and abutments of flying buttresses.

= Removal of wooden barrel vault.

= Construction of masonry vault in main nave (arching: Gobertange stone).
= 1806: The pillars are strengthened with steel rings.

= 1905: Request for consolidation and strengthening after local inspection and in view of
severe cracking in the west wall of the northern transept (after painting in 1872).

= 1929 and 1936: The flying buttresses (those that remain) are in bad condition.
» 1950-1953: Repair of war damage (roofing, windows and stucco-ceiling).

= 1956: Main nave and two side naves are out of plumb by 30 cm. Two years later an
increase of 10 cm is measured.

= 1963: The Church is closed down.

= 1965-1971: Phase 1 of restoration 1961-1974 (dismantling of vaults in side nave; shoring
of main columns, shoring of side naves).

= 2000: Dismantling of flying buttresses.

= 2005: Consolidation measures: repair of roofing (leakage), renovation of sewer system.
5.3. Survey planning

5.3.1. Goals and objectives

The final goal of this case study is to provide accurate measurements before restoring the
Church into its original state and valorise it as a multi-cultural space. A number of engineering
studies will be performed, the results of which will be geospatially linked to the buildings
geometry. These engineering studies will be performed by different companies, all of them
working in a different domain but some of them using the same information to start from, namely
the geometry of the building. In stead of each team having to contact a surveyor to record the
part of the Church that he/she needs, the use of laser scanning will provide one central
geometrical database from which each third party can extract the information as needed.

5.3.2. Deliverables
The deliverables asked for from the surveying team are:

= 2D as-is plans, elevations and sections of the Church;

These should contain the inside and outside measurements of the building with an accuracy that
is used in architectural drawings, meaning +- 1 cm.

To make sure the whole structure of the Church can be clearly understood from these drawings,
we suggest creating at least 3 floor plans (1.20m, 8.70m, 13.00m and possibly 19.00m), 2

sections (1 longitudinal along the main axis, 1 through the transept) and 3 elevations (of the
facades that are not obstructed by trees), and

= A full 3D meshed model of the masonry vaults with very high accuracy (+-5mm).
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= A full 3D meshed model of the side wall of the south-east transept wing to be able to
check its inclination angle.

= Walk-through animation of the full point cloud for tourism purpose.

5.3.3. Site documentation

Since both the interior and the exterior of the Church have to be scanned, the site
documentation phase will be divided into two parts.

e Wooden panets ||

Figure 53: Floor plan showing obstruction
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5.3.3.1. Interior

The interior of the Church is empty and appears a little like a construction site. The floor
is in a very bad condition and engineers have placed structural supporting scaffolding
inside the Church. This scaffolding obstructs a clear view of the structures behind.

The lower part of the arches between the central crossing and the transept and between
the central crossing and the choir area are obstructed by wooden panels.

A number of smaller rooms exist on the perimeter of the Church (see floor plan). It is not
advisable to use a laser scanner to survey these small rooms.

A power supply is available near the rear entrance of the Church. The supply can be
used for powering a laptop as well as the laser scanner.

Figure 54: Panoramic photograph of the interior of the St. James Church

5.3.3.2. Exterior
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The Church lies in the city centre near a public car park.

Cars are parked in front of the entrances (the rear entrance and the front entrance); these
are to be considered as obstructions.

In front of the entrance lies a busy street.
The north-east area (choir) is visually obstructed by trees.

The south-west fagade is only accessible through a small courtyard. This courtyard is
closed to the public.

There is no direct access to a power supply



5.3.4. Choosing the right measurement technique

5.3.4.1. Fit for purpose

While choosing the right measuring technique, a number of conditions should be taken into
account.

First, looking at the geometry of the Church, some assumptions can be made regarding cost,
time and precision of different measurement techniques available. In this instance the building
should be surveyed inside as well as outside and these surveys should be aligned into the same
coordinate system. This means that there will need to be a reference system that connects the
inside and the outside measurements. For this purpose it is suggested that a total station be
used to set up a closed polygonal reference system that allows for the reduction of any errors by
use of a traverse network adjustment. From each of the total station setup points, we measure a
number of target points (natural or artificial) on the building itself, which will provide the
necessary means to connect all the measurements.

Secondly, included in the requested deliverables are 2D as-is plans and sections. The Church is
a large structure, so it is desirable to get as many measurements as possible from as few
positions as possible. Mainly, man-made structures contain many regular shapes, but since this
is a Church that was partially built in Gothic style, it also contains many irregular, organic shapes
which are more difficult to measure using traditional techniques (i.e. hand measuring or total
station). Another aspect to be coped with are the high ceilings. This implies that using distant
measuring techniques rather than close contact measuring techniques will negate the need for
scaffolding. Often, distant measuring techniques can prove to be more accurate for large
structures.

And last but not least, a full 3D model of certain parts of the Church is required for use in
structural computations using finite element analysis. This means that the measurement
technique chosen should be able to measure three-dimensional structures. Accuracy and
resolution play an important role in this part, since we need enough information to be able to
create a full 3D model of the building element as accurate as possible.

Taking these considerations into account laser scanning was seen to be the most appropriate
measuring technique available when considerable measurement data is needed. Laser scanning
is a distant measuring technique that has very high accuracy and resolution. It creates data that
contains enough information to create 2D as-built plans and sections and also to create accurate
full 3D models of irregular, organic shapes where necessary. Using artificially placed targets
inside as well as outside and by connecting these in the same reference system by surveying a
closed polygon with a total station, it is possible to correctly align the scans from the inside and
outside.

Later, the data can also be used for tourism in the form of virtual walk-throughs and as a way of
illustrating the measures that have been taken to renovate the Church. Other possibilities are
the monitoring of possible deformation of certain structures like the masonry vaults over a period
of time, so as to assure structural safety once the Church is put back in use.

5.3.4.2. Risk minimisation by using laser scanning

Using laser scanning to measure buildings of this type minimizes certain risks that might occur
when using different surveying techniques.

Risk for the structure itself:

» Because laser scanning is a distant measuring technique, there is no need to make
contact with the structure. This minimizes the risk of further deterioration.

70



» For the same reason there is no need for scaffolding to measure the ceilings. Scaffolding
might damage the structure.

= Laser scanning provides accurate, high resolution data that can be used for full 3D
modelling of certain structural elements. These considerations minimize errors in the
engineering phase.

Risk for the surveyor:

» As scaffolding will not be required the surveyor will not be exposed to the risk of working
at heights.

5.3.5. Laser scanner hardware

Since the scanning of a Church of this size is a complex process, it will be split into 2 sub-tasks:
scanning the interior of the Church and scanning the exterior of the Church. Both subtasks have
different requirements considering the scanning equipment. Because of scanner availability and
cost, a timeframe of 2 days was allocated to scan the whole Church.

5.3.5.1. Interior
To scan the inside of the Church, a scanner with the following specifications is required:

= Scanner should be able to scan a full panoramic view (360 degrees)
» the maximum range will be about 20-30 meters

= Because of the time limit, we need a fast scanner is required which is capable of
acquiring many points per second with an appropriate resolution to acquire important
detail of the structure.

» Accuracy should be very high (5mm), since the data will be used for structural safety
computation in a finite element analysis.

= There is no need to consider possible problems with temperature, rain or wind, since the
scanning will be indoors.

» There is a power supply, so batteries are not required.

Looking at the maximum range, the accuracy and the time-frame of 2 days, a phase scanner
(year 2007) would be the best scanner choice for this job. In this case the Leica HDS 4500
phase scanner was used (see specifications in box below). To be able to work even faster, a
support for the laptop was attached to the tripod that holds the scanner and the tripod itself was
mounted on a mobile platform so that moving the scanner between scan positions was very fast
and easy.
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TYPE Phase-shift SINGLE POINT ACCURACY ***
COLOR Red {visible) POSITION AT 10M AT 25M
LASER CLASS Class 3R {IEC ENG0825-1) 20% reflectivity {dark grey) < Bmm =13.5mm
RANGE (optimal effective]  1m to 25m 100% reflectivity (white) = Bmm =12.8mm
MINIMAL RANGE 0.1m {low output power mode) D'STME_ )
20% reflectivity {dark grey) =3mm +180ppm*
MAXIMUM RANGE S
i . 100% reflectivity (white) < 3mm +64ppm*
(25m MODEL) 25.2m (default output power mode)
g ANCLE
MAXIMUM RANGE Horizontal 350 micro-radians
(53m MODEL) 53.5m (default output power mode) Vertical 950 micro-radians
SCAN RATE Up to 500,000 points/second* MODELED SURFACE PRECISION" * aT10M AT 25M
SCAN DENSITY (RESOLUTION) 20% reflectivity {dark grey) < 1.6mm < d44mm
Spot size 5mm at 10 meters, 8.5mm at 25 meters 100% reflectivity (white) < 1.0mm =1.8mm
TARGET ACQUISITION ACCURACY¢ < 3y <35mm

* PPM value equals the range noise standard deviation

**0ata acquired in default moda, subject to modeling methodology
#** at 125 KHz data rate

& Algorithmic fit to biack and white HDS targats

Figure 55: Leica HDS 4500 phase based Laser scanner [27]

5.3.5.2. Exterior

The outside of the Church requires a different scanner:

No need for full panoramic view (scanning of the surroundings is not necessary).
However the scanner should be able to scan a wide view (about 100 degrees
horizontally, 60-70 degrees vertically) because of the scale of the building

The scanner will need to be able to measure points up to a distance of 100 meters.

Should be able to scan with high accuracy because the data will be used to compute the
inclination of certain wall parts.

Scanner resolution is of less importance since there are almost no fine detailed structures
in the exterior, however a suitable resolution will still be required for modelling
discontinuities in the surface with high accuracy.

Possible problems due to temperature, wind and rain might occur since the scanning will
be outdoors (temperature range 0 — 20 degrees Celsius)

A battery or generator will be needed to power the scanner since there is no direct
access to a power supply

At the moment of scanning (year 2007) the Leica HDS3000 time-of-flight based scanner was
chosen.

72



TYPE Pulsed; proprietary microchip SINGLE POINT ACCURACY*
COLOR Green Puosition Gmm
LASER CLASS Class 3R (IEC 60823-1) Distance 4mm
RANGE Angle (horizontal] 60 micro-radians
Dptimal effective Angle (verticall 60 micro-radians
range Tm-100m MODELED SURFACE
To 10% reflectivity PRECISION 2mm
targets Up to 100m (typicall TARGET Acauisi-
SCAN RATE Up to 1800 pointsisecond* TION ACCURACY! | Gy

*M: scan rate on sean resolution and sel;
figld-of-view

SCAN DENSITY (RESOLUTION)

DATA INTEGRITY  Perigdic accuracy self-checking during operation
MOHNITORING and at stanup

* Al specifications shawn @ Im - 50m range

** Subject to mogsding methodalogy
t Agorithmic it to planar HOS tagets

Spot size < Bmm from 0-50 meters

Selectability Independently selectable vertical and horizontal
point-to-point measurement spacing T

Point Spacing Select by total number of points per unit
area or minimum distance between points
(at specified range) t

Maximum Sample
Density 1.2mm t

Scan row (horizontall 20,000 points/row, maximum ©
Scan column {vertical) 5,000 points/column, maximum

Figure 56: Leica HDS3000 time-of-flight based laser scanner [27]

5.4. Data acquisition

Before starting the actual scanning, the scanner positions need to be planned carefully. As
explained in an earlier chapter, it is recommended to cover as much as possible using a
minimum number of laser scanner setups.

5.4.1.1.

The building is divided into areas considering the major obstructions like the wooden panels and
the pillars between the main nave and the side naves which are also obscured by scaffolding.
These areas result in 8 different zones in which each ceiling height remains approximately
constant and the view is not obstructed by large obstacles.

Interior

L ]
— Wooden panels

Figure 57: Zones separated by visible obstructions
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| To do: Copy the sketch and try to make a planning for the scanner positions.

An optimal configuration has at least 1 setup in each of these zones. It is important to look for
small scale obstructions that might obscure the view of the scanner from each position. If parts
of the view are obscured other scan positions can be added so that the scanner can also see
the obscured parts. This must be done with care. Additional scan positions should be located so
that they do not overlap more than 50% of other scans unless it is necessary to remove all
obscured parts.

Figure 58 shows the proposal as planned on site by a surveyor. These setups were scanned on
site. Ideally more setups would have been better for a full coverage, but because of the time-
limit this was not possible.

The Cyclone software (see chapter 5.6), uses the term ScanWorld for each scanner setup,
meaning a new physical position and orientation of the scanner.

—— Wooden panels

Figure 58: Overview of the scan positions used inside the Church

To give an overview of the scan positions in the proposail:

= ScanWorlds 3, 5, 6, 7, 8 and 9 were taken from the centre of each vault to get full
coverage with high overlap of the vaults. This high overlap also implies better accuracy
because more points of the same area are scanned.

» ScanWorlds 10 and 14 were taken in the middle of an opening in the wooden panels to
get as much coverage from the transept wings as possible while still having a part of the
main nave in the scan. This allows for registration which is done using the targets in the
main nave as well as cloud-to-cloud registration.
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*= Only one high resolution scan was taken in the choir (ScanWorld 11). This was enough
to cover the whole area. The scanner position was chosen so that the scanner could also
capture part of the vaults in the crossing between the transept and the main nave. This
overlap in data acquisition can later be used for registration (see paragraph 5.6.1.7).

= ScanWorlds 12, 15, 16, 17 and 18 were made to assure a full coverage of the side
naves. The exact positions of ScanWorlds 12, 15 and 16 were taken to cover the side
nave while also trying to cover as much as possible of the wing parts of the transept.

54.1.2. Exterior

Because a considerable part of the north and the north-east side of the Church was obscured by
bushes and trees and because of the limited time frame, it was decided not to scan this side of
the Church. Due to the direct public accessibility of the site, it was very difficult to use artificial
targets. People passing by are often curious and sometimes it has been known for them to move
or even steal targets. Therefore it was decided to make 2 or 3 scans from different sides on one
day using artificial targets and some additional scans the next day. These latter scans could
then be registered using cloud-to-cloud registration.

To do: Take the sketch and plan the scanner positions for the exterior of the Church.

Figure 59, shows the scanner configuration (ScanWorlds) used by the authors in the actual
acquisition phase. ScanWorlds 30, 32 and 31 are the scans to be acquired on the first day, so
they will contain targets. ScanWorlds 33, 34, 35, 36 and 37 will be made the second day and
will be registered to the other scan by means of cloud-to-cloud registration.

‘$§wa4

%31

Figure 59: Overview of the scan positions used outside the Church
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5.4.1.3. Targets

Not only is the scanner position important, the positioning of the targets carries equal
importance. As already mentioned earlier, it is important that:

» targets be widely separated,;
» targets have different heights;
= as few targets as possible on one single line;
» atleast 3 targets should be visible in each scan;
To connect the interior and exterior scans and to put them into the same coordinate system,

there is a need to measure all the targets with a total station, building a polygon (preferably
closed) with which to adjust the measurement errors.

To do: Try to complete your sketch by adding target positions using the above guidelines.

The final sketch made by the laser scanner operator containing all scanner positions and targets
is shown below.

%33
%32

!'I:;}
1

i
A
=
=0t
i

Figure 60: Overview of all the scan positions and the target configuration proposed by the authors

5.5. Data Preparation

During the data acquisition phase, things sometimes do not go as planned. In the acquisition
phase for the inside of the Church for instance, some people (students and professors) wanted
to have a demonstration of the laser scanner equipment. Therefore a number of scans were
made just for demonstration purposes. Before the processing of the data, it is advised to remove
scans that are possibly contaminated by noise (i.e. people in the line of sight of the scanner,
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people around the scanner causing vibrations ...). The ScanWorlds involved (ScanWorlds 1, 2
and 3) were removed from the dataset.

To start working with the scan data in the Leica Cyclone software, a connection between the
scan database containing the scan data and Cyclone is required.

= QOpen Cyclone
= Right-click on the (unshared) icon in the list of servers and select Databases

In the dialogue box, click the Add... button, then click the ... button next to Database
Filename and browse to the scan database called: St.James Church — Tutorial Inside — start --
Reduced.imp (reduced dataset) or St.James Church — Tutorial Inside — start.imp (full
dataset) . Select the *.imp file and press the Open button. Back in the previous dialogue, just
press the OK button and then press the Close button in the dialogue. This brings us back to the
Cyclone Navigator.

&) Configure Databases on ASRO-WRK-016... [X]|

ASROWHRE-0167 [unshared]

Databases | & Add...

&) Cyclone - Navigator EIE'E|

File Edit View Configure Create Tools Help

- SEH:E:;%UHK s There are no iterr[%o dizplay
ASROWRE-DNET [unshared -
G SHORTCUTS
28 SCAMMERS Servers. .
o Show Servers

Shortcuk in Windows  #
Open the Configue Databases dislog o manage i

Cloze

i

&) CreatefSelect a Cyclone DB

‘_E Lack in: | (£ Cyclone data - =k B~

[Cheventlog 3k James Ch
D atahase I*{;‘éne | |Choriginals St.James Chi
i [Crecovery
Database Filename | J 3k, James Church - Tukorial ALL.imp

3k, James Church - Tutorial Inside - Registration Finsihed.imp
0K Cancel ‘ St.James Church - Tutarial Inside - stark.imp

£ |

File: narne: |St.James Church - Tutorial Inside - start.imp
Files of type: | Cyclone DB [*.imp] -] Cancel

Figure 61: Loading a database file into Cyclone

|

Cyclone now imports the database and it is shown in the database listing in the Cyclone
Navigator. To check the data, open the database by clicking the + icon next to the required
database. This will expand the lower sub levels. Each individual scan observed in the field will
be shown as a ScanWorld; these are scans with no specified orientation or co-ordinates and
are not related to each other. Each ScanWorld has 4 parts: ControlSpace, ModelSpace,
Scans and Images. The Images folder contains the images made by the integrated camera of
the scanner that helps in setting the field of view of the scanner. The Scans folder contains
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each separate scan as RAW data. Here, even scans made from the same position but with
different settings are separated. The two most important folders are the ControlSpace and
ModelSpace folders. These folders contain the data to work with. The Controlspace is the
space that actually contains the RAW scan data. This Controlspace is used in all
computations, for instance in the registration. However, there is a security measure. A user
cannot directly alter the ControlSpace. He or she has to alter the ModelSpace and then copy
the changes to the ControlSpace. The Modelspace is in fact a snapshot of the Controlspace.
It provides a ‘View’ onto the controlspace at a certain moment in time. It is possible to have
multiple Modelspaces taken at different times from one Confrolspace.

5.6. Registration & Geo-Referencing

5.6.1. Registration: Interior

As a result of the data acquisition phase, a total of 23 ScanWorlds, 15 from the inside of the
Church and 8 from the outside of the Church have been collected.

Note: When using the reduced dataset, only 8 scanworlds are available for the inside, but they
allow you to follow the tutorial as it is. The tutorial uses screenshots from the full dataset so do
not rely on them when using the reduced dataset. Sometimes an reference as (reduced dataset:
...) will be given to indicate a value that is different in the reduced dataset.

Registration will be started with the inside scans. To register the inside of the Church a number
of different registration techniques will be used (see video “reqistration_interior_partl.avi”).

First, a technique called target-to-target registration is used. A number of artificial targets were
placed in the scene before scanning. Matching at least 3 of these targets between ScanWorlds
allows us to register these scans. An important remark here is that not all ScanWorlds can be
registered using these artificial targets alone.

| Question 1: which one? Look at Figure 60.

Question 2: Take a look at the scans that cannot be registered using artificial targets alone and check if they have
sufficient overlap to perform a proper cloud-to-cloud registration.

Even if point clouds do not have enough overlap and they do not have common targets, they
can still be registered by connecting the targets in one point cloud to the targets in the other
point cloud and by measuring these targets using a total station. Using this technique, all targets
can be placed in the same coordinate system and that coordinate system used as a basis to
register all the point clouds. This technique is called cloud-to-total station registration.

In the case of the St.James Church total station measurements will be used because they
automate a large part of the registration process. Later on these measurements may be used to
make a connection between the inside scans and the outside scans of the Church.

In the upcoming sections, all these different registration techniques will be used and explained in
more detail.

5.6.1.1. Creating a registration project

To create a registration in Cyclone, look at the Cyclone Navigator. In the Cyclone Navigator,
already imported, is the database called ‘St.James Church — Tutorial Inside - start’. This
database contains all the ScanWorlds of the inside of the Church. Right click the project folder
‘Project St.James Church — Inside’ and select Create — Registration. At the bottom of the list
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of ScanWorlds, a registration project is added. Rename it as ‘Registration St.James Church -

Inside’ (see video “registration_interior_part2.avi”).

&), Cyclone - Navigator,

File Edit ‘iew Configure Create Tools Help

=&} ASRDMWRKDTET
=l StJames Church - Inside
=] o 5 Churcd

g Searwiord 5
g Scarworld B

LY ETTEEE
=8 SERVERS

Shortcut in Windows

Undo

Project
Reqgistration
ModelSpace

+ Scariwiold 7 Scariorld
+ t Scanworld 8 Clear Undo/Reda Multilmage
+ ,‘Q Scarworld 3 Cuk

+ h Scariwiorld 10 Copy Shortout
My Searworld 11 Delete

My Scariworld 12
+ -y Searwond 13
-y Seariwiond 14
-y Searwond 15
Mg Scarworld 16 )
+- g Scanwald 17 Optimize
+ h Scanwaild 18 Merge Sub-Scans
g ASROMWRKDET (unshared) Import HDS4S00fHDSE000 Scans, ..
@8 SHORTCUTS Download HDSE000 Scans...
[38 SCANMERS Make Available Offline

Rename

Add/Edit Annotations. ..
Ohbject Info...

Impart. ..
Impoart Leica System 1200...

Figure 62: Cyclone Navigator — Creating a Registration Project

Once the registration is created, double click it to open the registration dialogue. In the
registration dialogue you can find 3 main tabs: ScanWorld’s Constraints, Constraint List and
the ModelSpaces tab, which are all empty at the time.

Toolbar
Main Tabs

¥ Bt ratins: Regivtratinn S1_Larme s Elvarch - Imide
Beguirsion [ jorwokd Cosby’ o Corrand eean en

Tab Content window

Fagohsior. o of e

Figure 63: Registration Project Dialogue Box
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5.6.1.2. Importing total station data

As mentioned earlier we measured all targets using a total station because this highly automates
the registration process. Before starting the registration, we need to import this measured
dataset. In the Cyclone Navigator right click the ‘Project St.James Church - Inside’ and
select Import. A new dialogue appears in which can be selected the file containing the total
station data. This file can come in different formats and its structure can be specified through the
Cyclone Import dialogue. In this case the file is called ‘TSSurvey-StJames.txt’. Select the file
and open it.

Now define the structure of the file. The values in the file are ‘space delimited’ and their units
are set to ‘Meters’. The first column holds the ‘Targetld’ while the second, third and fourth
column contain the X, Y and Z coordinates. Specify these column headers by clicking them and
selecting the correct column title (see video “registration_interior_part3.avi”).

&) Import: ASCII File Format

==
Farmat |Suwe_l,l Default j Save As..
" Fized Width # of columns - |B 3:
' Delimited ft Bows toskip [ 3:
Iab I Semicalon [ | Comment Marker |-
5 v :
(E=IES Other ’_ Megative Walue | it -
Comma [

. . Unit of Measure
[¥ Merge consecutive delimiters = Meters i

Create line zegments between

Text Qualifier | r pairs of vertices
v Auta Preview Presview

Calumn 1 Column 2 Column 3 Column 4
TargetID kS b z

Text Deecimal Deecimal Deecimal

1 974413593 115.950376  101.595445 -
z 130.,420025 116.096554 102139765
3 130.445905 112.141563 101.708313
4 102,360773 113300560  100,169087
5 101.935490  117.702574 100.153575
B 120243504  117.1832253 101274543
7 121778295 113.014750 100.314111
g 111,704133 113024631 100,189524
El 114,425067 104916816 100.477457
10 115749585 104.674599  101.750791
11 114164595 97.4358843  101.757931
12 112737868 97.475311 101.695651
15 112,2758475 105302855 101.636183
14 113.369580 125.947411 102133645
15 109254711 125.51041 101.659159
16 104.542732  105.331432 101.769175%
17 101,104652 125518525 101.557541
18 103.966754 125.695647 101.754406 3
el 176 137489 1NA NS2363 101 7510548

Import | Cancel

Figure 64: Importing the Total Station Data from an ASCII file

Once all parameters are set, import the file by clicking the Import button. When importing a new
dataset from an ASCll/text file, a new ScanWorld is created in the navigator. This ScanWorld
has the same structure as a normal ScanWorld. It contains both a control- and a
modelspace that now only contain the target points and their labels instead of a full point
cloud.
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Figure 65: Structure of the imported total station data in Cyclone

5.6.1.3. Adding ScanWorlds

To add ScanWorlds to the registration, open the registration project by double clicking it and
select the menu ScanWorld - Add ScanWorld.... In the following dialogue box select the
ScanWorlds wanting to be registered. Firstly, an attempt will be made to register all the inside
ScanWorlds at once to see what problems might occur. Select all ScanWorlds while holding the
shift key. Make sure to include the TSSurvey-StJames ScanWorld containing the total station
data. Now click the right arrow button to add these ScanWorlds to the registration project and
press the OK button (see video “registration_interior_part4.avi”).

&) Select ScanWorlds for Registration

=i Project StJames Church - [nzide Scarwforld 4

e c Scarworld 5
. h = Scarworld B
= Scariworld 7
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+ h 5 Scariworld 9
5] h = Scanwiorld 10
H h c J Scanwforld 11
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Figure 66: inserting all the ScanWorlds into the registration project

5.6.1.4. Adding target constraints

When all ScanWorlds are added to the registration project, one ScanWorld is selected to be
the Home ScanWorld. This means that all other ScanWorlds will be registered using the
coordinate system of that reference ScanWorld. To do this, go to the Modelspaces tab and
select the TSSurvey-StJames ScanWorld containing the total station data. Then right click it and
select Set Home ScanWorld. Using the TSSurvey-StJames ScanWorld as the home
ScanWorld, a combination of the target-to-target and target-to-total station registration
techniques is used automatically (see video “registration_interior_part5.avi”).
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Now constraints can be added. Manually adding constraints would take a long time, so an
automated technique can be used and its outcome scrutinised. First, auto-detect artificial target
correspondences between ScanWorlds to do target-to-target registration. To do this, open the
Constraint menu and click the Auto add constraints item. Cyclone will now automatically try
to find correspondences between artificial targets in the ScanWorlds, considering these were
positioned and labelled correctly.

g} Registration: Registration 5t.James Church - Inside
Registration Edit  Scanworld

K ;.L? -,.Lg N Auko-4dd Constraints

Update Constraints

W E NS Cloud Constraint  Viewers

)Jg( ScanWorlds® Constraints

Scanworlds/Constraint 10 tatL
7Y Scanworld 16

J,( Scarworld 7
My Scanword 18
M Searwaid 10
Ay Scarword 14
A Scanwoard 13

Figure 67: Auto-Add Constraints menu item

At the end of this process a warning box may appear stating that a number of constraints may
have been mislabelled or be erroneous, giving an idea of which targets might be wrong. On
examining the ‘bad’ target list, it can be seen that targets 6, 7, 13 and 17 are repeatedly
mentioned, so these should be checked.

For now press the close button and open the Constraint List tab. In the Constraint List tab can
be found all constraints that were automatically detected by Cyclone. The error measurement
column is still set to n/a. This means that the software has not computed the errors yet.

5.6.1.5. Finding errors

To compute the errors the scans need to be registered the scans. Open the Registration menu
and start the register command. When this command is finished, the error column is filled and
an error vector column has been added. These constraints can be sorted in descending order
based on the error value, by clicking the header of the error column. In this way the constraints
can be analysed. This shows the constraints that show high measurement errors to be
examined and, if necessary, corrected manually (see video “registration_interior_part6.avi”).

To Do: Sort the Error column and check the error values.

In the error column the first 4 (reduced dataset: 2) constraints have an error measure of more
that 2 meters, also Target 17 is involved in all these constraints. By double clicking on a
constraint, Cyclone opens both ScanWorlds involved in the 2 viewers below.

Question 3: Double click the second constraint matching ScanWorld 5 and ScanWorld 6 and zoom to target 17. What
is wrong with target 17?
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Figure 68: Target 17 in ScanWorlds 5 (good position - left) and 6 (bad position - right)

Care should be taken when checking targets directly through the viewer in the registration
project because not all fine scans may be visible. Therefore it is better to check the ScanWorlds
directly from the navigator to see if all individual scans are visible. This can be done by opening
the controlspace of the respective ScanWorld directly from the navigator and check the Tools -
Scanner — ScanWorld Explorer... If all scans are marked, they are visible.

5.6.1.6. Fixing errors

To fix the problem with target 17, all constraints containing targef 17 in ScanWorld 6 will be
disabled.

Question 4: Re-sort the constraint list according to the constraint ID’s and search for constraints containing target 17.
How many constraints contain target 177?

Check each constraint’'s ScanWorlds and disable the constraints containing ScanWorld 6 by
right clicking them and selecting Disable. After disabling some constraints, re-Register the
project. (The auto-update option may be set to automatically update the registration)

Ay Scanilonds Gonstraints =2 Gonstraint List l 8l ModelSpaces l

Congtraint 1D Scariaord Scari/ord | Type | Statusz | ‘w/eight Error | Error Yector |
Scarorld 18 Scartwiorld B Caincident: WVertax-Yertey 0ff 1.0000 277 m [-1.782, 2120, 0.200]) m
Scanword B TS5Survep-Stlames [Leveled) Coincident: Vertex-vertex Qff 1.0000 2776m [1.782,-2119,-0201) m
Scanworld 17 Scanworld B Coincident: Yertex-Vertex aff 1.0000 274 m [-1.783, 2115, 0.202) m
Scanword 5 Scanworld B Coincident: Yertex-Vertex aff 1.0000 2773m [-1.780, 2118, 0.199) m

Scanworld 16 T5Survey-Stlames [Leveled) Coincident: Yertex-Vertex On 1.0000 0151 m [0.083, 0.044, -0119) m

TargetlD: Scanworld 16 Scanworld 7 Coincident: Yertex-Vertex On 1.0000 0142m [-0.083, 0.043, -0107) m
TargetlD: 13 Scanworld 16 Scanwhorld12 Coincident: Yertex-Vertex On 1.0000 0126 m [-0.079, 0.040, -0.090) m
TargetlD: 7 Scanworld 7 TSSurvey-Stlames [Leveled) Coincident: Yertex-Vertex On 1.0000 0105 m [0.007, 0.013, 0104 m
TargetlD: 7 Scanworld 7 Scanwarld 3 Coincident: Yertex-Vertes On 1.0000 0105 m [0.008, 0.014, 0104 m
TargetlDd: ¥ Scanworld ¥ Scanworld 5 Coincident: Vertex-ertexs On 1.0000 0104 m [-0.006, 0.013, 0103) m
TargetlDd: ¥ Scanworld ¥ Scantwiorld 8 Coincident: Vertex-ertexs On 1.0000 0104 m [-0.006, 0.012, 0103) m

Figure 69: Constraint list after registering

Now the constraints can be checked again (sorted by error value). We see that the largest
‘enabled’ error value has come down to 15.2 cm (reduced dataset: 14 cm) which of course is still
too high. Also noted is that the 3 constraints (reduced dataset: 2) with a high error measure all
contain farget 13 (see video “reqistration_interior_part7.avi”).
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Note: Cyclone has two different spaces to the dataset, the Modelspace and the Controlspace.
The Controlspace is the space that actually contains the RAW scan data. This Controlspace is
used in all computations for instance in the registration. The Modelspace is a snapshot of the
Controlspace. It provides a ‘View' onto the controlspace at a certain moment in time. These can
be multiple Modelspaces taken at different times from one Controlspace. It is important to notice
that altering a Modelspace does not always alter the Controlspace, so always check the
Controlspace after making alterations to the Modelspace.

| Question 5: Check all constraints containing target 13. What is wrong with this target?

To Do: Check which target is the correct one in the modelspace (the one with the visible target shape in the fine scan)
and remove the bad labelled vertex. Do the same in the controlspace (when removing the target from controlspace,
cyclone declares that this target is still in use in a registration project. Before deleting the target from the controlspace,
remove the respective ScanWorld from the registration project. To do this, go to the Modelspaces Tab and select
ScanWorld 16. Then right click and select Delete. After fixing the problem, add the ScanWorld to the registration
project and re-Register the project. Then check if the problem is solved.

After fixing target 13 in ScanWorld 16 and re-registering the project, there is an error value of
about 10 cm. Notice that the high error values come from constraints containing targeft 7.

| Question 6: Check these constraints and find out what’'s wrong with target 7.

Figure 70: Target 7 in ScanWorld 7, bad position

To correct this target, what is needed is to remove the target from the controlspace as well as
from the modelspace.

To Do: First delete ScanWorld 7 from the registration project. Then remove the target from the controlspace. Then go
to the modelspace and delete the target there too.

Now the target label can be re-created. Notice that when creating new targets, they should be
created in modelspace and then copied to the controlspace. Only the targets in the controlspace
are used for registration.

To create a new target, pick a point near the centre of the target using the selection tool. The
fine scan of the target should highlight. Then select Create Object - Fit To Cloud -
Black/White Target... Cyclone will now automatically try to fit a target to the point cloud and
find its exact centre point. When this succeeds, a dialogue appears asking for the TargetID.
Enter the number 7 as the TargefID and press the OK button. When pressing the OK button,
cyclone shows a dialogue stating that this has multiple references to different controlspaces
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and asks which one has to be updated. Select both the controlspaces available and press the
OK button. Before continuing the registration, check the controlspace to make sure the target is
inserted correctly.

Note: When Cyclone fails to automatically detect the target, manual insertion can be used. Do
this by selecting the exact centre point of the target using the selection tool and then go to
Create Object - Insert — Vertex. Then select the vertex and label it using the Tools -
Registration — Add/Edit Registration Label..., and label the vertex with the name of the
corresponding TargetID. When this is finished, copy the vertex to the controlspace using Tools -
Registration — Copy To Controlspace.

Now return to the registration project and select the menu item Constraint — Auto Add
Constraints. Then Register the project again and sort the error values.

| Question 7: Check the first ‘enabled’ constraint containing the highest error value. What is the error value?

Always check the absolute mean error of the complete registration by selecting Registration —
Show Diagnostics... Listed here is the mean Absolute Error for the registration of 3 mm, which
is within limits for a building of this scale.

Status: VALID Registration

Mean Absoclute Error:
for Enabled Constraints = 0.003 m

for Disabled Constraints = 2.770 m
Date: 2007.05.18 11:53:30

Database name : St.James Church - Inside

ScanWorlds
ScanWorld 16
Scanlorld 7
ScanWorld 18
ScanWorld 10
ScanlWorld 14
4 |ScanWorld 13

Figure 71: Registration Diagnostics

5.6.1.7. Adding cloud constraints

To optimize the registration, cloud constraints can be added. Cloud constraints are constraints
between ScanWorlds that have sufficient overlap in their point clouds to be used as an
additional constraint. Since all ScanWorlds are already registered, cloud constraints just add
redundancy. Adding cloud constraints in this case is very easy. Select the Cloud Constraint —
Auto-Add Cloud Constraints menu item (see video “reqistration_interior_part8.avi”).
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Figure 72: Auto-Add Cloud Constraints menu item

Cyclone will automatically start to search and analyze all point clouds for sufficient overlap and
try to add cloud constraints for these point clouds. This process can take about 10-20 minutes,
depending on the computer’s processor. The computation histogram shown during the cloud
registration process already shows if cloud constraints are good or not.

The histogram shown should look like a steep descending function instead of a shallow
descending function having values across the whole X axis (see Figure 73). During the process
the graph is iteratively updated and it shows that after a few iterations a higher number of points
are found with fewer error values. If one of the cloud constraints does not evolve in this way, it
probably is erroneous.

The histogram shown should look like Figure 73B. This image shows that after a number of

iterations, Cyclone has been able to optimize the cloud constraint number 11 to have more
points with smaller errors.

Cloud Registration Progress Cloud Registration Progress

Cloud Congtraint 11 of 105 : Cloud Congtraint [Scanworld 16 Cloud Constraint 11 of 105 : Cloud Constraint [Scaniw/orld 16 :
Scanworld 11] Scanwiorld 11]
_ 33 % completed Stop | _ 33 % completed Stop |
<< Details << Details
# ptz # ptz
0.000 0100m  emor 0.000 m 0100m  ermor

A B

Figure 73: Cloud-2-Cloud registration process dialogue, (a) after 5 iterations, (b) after 50 iterations

When the Auto-Cloud-Constraint process is finished, Cyclone will show a report on all cloud-
constraints added and their error values.
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& Optimize Cloud Alignment Resulis

Conskraink | Scanwarld | Scanwarld | Function Yalue (5q m) | RIS () | Avg (m) | T4in () | Maz (m) | Paint Count | Status | A~
Cloud/Mesh 1 | Scanorld 16 | Scartworld 7 0.00012931 0.015 0.011 0.000 0.095 535833 Aligned
Cloud{Mesh 2 | Scanorld 16 | Scartworld 18 | 0.00015843 0.018 0.012 0.000 0.096 1661353 Aligned
Cloud/Mesh 3 | Scanworld 16 | Scantworld 14 | 0,00010785 0,015 0.010 0,000 0,093 635200 Aligned
Cloud/Mesh 4 | Scantorld 16 | Scantworld 13 | 0.00014483 0.017 0.011 0.000 0.094 145000 Aligned
Cloud/Mesh 5 | Scantorld 16 Scartworld 5 | 0.00014273 0,020 0.012 0.000 0.095 359700 Aligned
Cloud/Mesh & | Scanorld 16 | Scantworld 12 | 0.00011448 0.016 0.010 0.000 0.095 313266 Aligned
Cloud/Meash 7 | Scanworld 16 | Scan'world | 0,00014149 0,018 0.012 0,000 0,099 445366 Aligned
Cloud/Mesh 8 | ScanWorld 16 | Scan'world 17 | 0,00007160 0,014 0,003 0,000 0,099 867933 Aligned
Cloud/Mesh 9 | Scantorld 16 | Scantworld 15 | 0.00005855 0.014 0.009 0.000 0.095 1063000 Aligned
Cloud/Mesh 10 | Scanorld 16 | Scanworld 9 | 0.00012696 0.015 0.011 0.000 0.096 269933 Aligned
Cloud/Meash 11 | Scanworld 16 | Scanworld & | 0,00011739 0,017 0.011 0,000 0,097 431766 Aligned
Cloud/Mesh 12 | Scanorld 16 | Scan'world 4 | 0,00015393 0,019 0.012 0,000 0,097 305900 Aligned
Cloud/Mesh 13 | Scanorld 7 Scantworld 15 | 0.00015952 0,019 0.012 0.000 0.095 243600 Aligned w

Figure 74: Cloud Alignment Results

5.6.1.8. Checking accuracy

Once all possible constraints are added to the project, a final registration can be used to check
the overall accuracy. In the registration menu select Registration — Show Diagnostics.
Cyclone shows a report containing the Mean Absolute Error which should be about 4mm in this
case. This value is ok since the scanners’ accuracy is about 4mm too.

Looking at the individual constraint accuracies, it can be seen that the maximum error value is
now 19mm (reduced dataset: 17mm). It seems the highest error values originate from
constraints containing ScanWorld 11. This can be clarified because ScanWorld 11 does not
have a lot of overlap with other ScanWorlds and the connection has been made mainly based
on targets measured with the total station. Since this setup of the total station is not part of a
closed polygon, error division was not optimal.

Looking further into the constraint list, it can be seen that the first constraint not containing
ScanWorld 11 has an error value of 12mm which is acceptable for this kind of survey (see video
“reqistration_interior_part9.avi").

5.6.1.9. Freezing and creating a modelspace from the registered cloud

As a final step of the registration process, a new ScanWorld can be created containing the full
set of registered point clouds. To do this, select the Registration — Create ScanWorld/Freeze
Registration menu item. This command freezes the registration so nothing can be changed
again. In case there is a need to alter the registration or add another constraint, make sure that
all modelspaces generated from the registration are deleted and unfreeze the registration.

After freezing the registration, select Registration — Create and Open Modelspace to create
a new modelspace containing the full set of registered point clouds and show it in a new viewer
(see video “reqistration_interior_partl0.avi"”).

The registered dataset up to here is saved in the file “St.James Church - Tutorial Inside —
Regqistration Finished.imp” (link fo reduced dataset).

5.6.2. Registration: Exterior

As already mentioned in the previous registration step, there are a number of registration
techniques that are available. Already discussed are the target-to-target registration and target-
to-total station registration. We also used a cloud-to-cloud registration, but this was done fully
automatically to add redundancy in the constraints. In the registration of the outside scans cloud-
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to-cloud registration will be used, but, in this instance, it will be used as a single constraint to
connect point clouds.

Note that the scans of the outside of the Church were taken at different times and that the time
frame was very limited. A large part of the north-east side of the Church was mainly obscured by
bushes and trees. Because of the limited time frame, it was decided not to scan this side of the
Church. The other scans of the exterior were made over different days. This means that a
number of these ScanWorlds do not contain targets because the targets could not be left
outside overnight.

To do: Open all exterior ScanWorlds of the Church and check which ScanWorlds have targets and which do not.

To register the outside of the Church, scans that have targets will be registered first. Afterwards,
the other ScanWorlds will be added one by one using cloud-to-cloud registration. The dataset
for the exterior of the church can be found in “St.James Church — Tutorial OQutside — start.imp”

5.6.2.1. Repeat steps 5.6.1.1 - 5.6.1.6

In the same way as in the previous registration of the inside scans, create a new registration
project.

Question 8:

- Create a new registration project for the exterior registration and name it ‘Registration St.James Church — Outside’.
- Copy the total station data file from the interior project as a ‘full copy’ to this project. (right click — copy - paste)

- Open the registration project and import ScanWorlds 30, 31, 32 and the total station data file.

- Make sure the Total station data file is set as the Home ScanWorld

- Auto-add the target constraints

- Register the set, find and correct the errors.

What goes wrong and why? (tip check the constraints)

Two constraints are not enough for a proper registration (at least 3 are needed), so remove
ScanWorld 32 from the set and register the project once more. ScanWorld 32 will be imported
later on and additional constraints will be applied to register it to the rest of the scans. When
analyzing the error values of the registration, the maximum error value is 1.8 cm.

5.6.2.2. Adding other ScanWorlds using cloud-to-cloud registration

The other ScanWorlds that do not contain enough targets to be able to perform a target-to-
target registration can now be added. Looking at the sketch of the ScanWorlds’ positions, a
search to find a ScanWorld that has at least 30-40% overlap with one of the ScanWorlds
already in the registration project is attempted.

| Question 9: Which ScanWorld(s) have a proper overlap with ScanWorlds 30 or 31?

The starting point is ScanWorld 37 because it has a large overlap with ScanWorld 31.

| To do: Add ScanWorld 37 to the registration project.

To add a cloud constraint, click the modelspaces tab in the registration window. Then open the
modelspace view of ScanWorld 31 and the modelspace view of ScanWorld 37 by double
clicking them. Cyclone opens both ScanWorlds in the viewers at the bottom of the screen. Now
use the viewer tools (panning, rotating and zooming) to align both datasets approximately.
To add a cloud constraint, at least 3 corresponding points in both datasets need to be selected
so that cyclone has a proper initial guess of the cloud alignment. Use the picker tool '* or R
to select at least three corresponding points. When using the '* tool, hold the CTRL-key to add
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other point correspondence pairs after selecting the first corresponding point pair. This is not
necessary when using the " tool.

In the images below, the points selected by the author are shown. It is important that all point
pairs lie as far from each other as possible and that they do not lie on a straight line.

A

Figure 75: (A) Overview of the point correspondences; (B) Corner of the wall with the roof structure near the
entrance; (C) Top of the second arch from the right; (D) Corner of rectangle on the left wall

When all corresponding points are selected, select the Cloud Constraint — Add Cloud
Constraint menu option. If the 3 selected correspondences are not ‘tight’ enough for Cyclone
to find a proper initial estimate, it will show an error message stating that less than three
correspondences were found. In this case, re-check the selected correspondences and possibly
adapt them or add more correspondence pairs. Cyclone will automatically take the 3 best
correspondence pairs to make the initial alignment.

In the constraint list you can see the added cloud/mesh constraint. Now start the Registration
command. When the registration is finished, it can be seen that the cloud constraint has an error
vector of 1.1 cm, which is very good for a cloud-to-cloud alignment.

To do:

- Add ScanWorlds 35 and 36 and attach them to ScanWorld 30 using cloud constraints
- Add ScanWorld 34, attach it to ScanWorld 31

- Add ScanWorld 32, attach it to ScanWorld 34, and also use the target constraints

- Add ScanWorld 33, attach it to ScanWorld 32

- Add a cloud constraint between ScanWorld 31 and 32

- Finally try the Auto-add cloud constraints to find additional cloud-to-cloud constraints
- Check the RMS errors of the cloud constraints

The final registration has a mean absolute error of 9 mm which can be found by using the
Registration — Show Diagnhostics command. The maximum constraint error is 18 mm, which is
satisfactory for this survey.

Freeze the registration and create a new modelspace view. When looking at the registered

exterior point cloud a number of gaps will be seen. This is because of the limited time frame for
the scanning.
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The registered dataset up to here is saved in the file “St.James Church — Tutorial QOutside —
Registration Finished.imp”.

5.6.3. Registration: Combining Interior and Exterior datasets

5.6.3.1. Copy/Paste the registration project into new database

Finally, both registered datasets of the inside and the outside will be registered to get a fully
registered model of the Church. A new database needs to be created. In the cyclone navigator,
select Configure — Databases... Then select the correct server containing all the imported
databases. Select Add... and enter the following name for the new database ‘St.James Church
— ALL REGISTERED’. Now click the OK button and close the next dialogue. In the list should be
seen the new database.

—-i_dl SERWERS
- @) Harddisk
+ r:i StJames Church - Inside
+ r_j Stlames Church - Qutside
+- [ Stdames Church - ALL

Figure 76: Databases in the Cyclone navigator

Add a new project to the database by right clicking the database and selecting Create —
Project. Use the default name for the project.

Next, copy the registered ScanWorlds from the inside and the outside of the Church to this new
database project. Therefore open the St.James Church — Inside database and select the
Registration St.James Church - Inside project. Then right click it and select Copy. The
registration is now copied onto the windows clipboard so that it can be pasted elsewhere.

=g StJames Church - Inside
—|--'_ Project St.James Church - Inzide Cuk
+ Scartwiorld 4
+ J,‘, Scartwiorld B Delete
+ J,‘, Scanworld B Rename
+ J,‘, Scartwiorld 7
+ J!( S ariaford & Add/Edit Annotations. ..
+- My Scarta/orld 9 Object Info...
¥ Jy Searmaond 10 Scanner Diagnoskics. .
+ J,‘, Scartwiorld 11 Optimize
+ J,‘, Scartwiorld 12 .
. J!( S cariwiod 13 Restore Original Scans
. J!( Scartwiond 14 Merge Sub-5cans
+ J!( Seariwiord 15 Impart HDE4500/HDSA000 Scans., ..
+ J!( Seariwiord 16 Daowenload HDSE000 Scans. .
¥ J!( Scartvard 17 Make Awvailable Cffline
+ J,‘, canW-:urId1B L . . Import...
+ J,‘, Scartworld [Registration St.James Church - [z

Figure 77: Copy the Inside Registration project to the windows clipboard

Note: Make sure not to copy the whole project into the new registration project, but only the
Registration ScanWorlds!! This takes a lot less memory and will be a lot faster.
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Go to the St.James Church —ALL REGISTERED database and right click the newly created
project, then select Paste. Cyclone will ask if the project is to be copied as a whole or as a
reference. A full copy means that all data will be copied into the new project, which means that
it will also take space on your hard drive and that there will be no link between the copied
version and the original one. Copying as a reference will create a reference link from this
database to the St.James Church — Inside database telling this database to use the same data
as in the St.James Church - Inside database. In this instance the Reference copying mode will
be used.

&) Select Co py Type

\,E) f'ou are copying objects between databazes.

Do you wigh to perform a full copy or a reference copy?

Full | Reference Cancel

Figure 78: Create Full copy or Copy as Reference

When the copying is finished, the St.James Church - Inside registration project should be
seen in the new database. Do the same with the St.James Church — Outside registration
project. When copying the Outside project, Cyclone will show a dialogue stating that the total
station data file already exists in the project. Just press the OK button to confirm the default
choice.

StJames Church - Inzide
Stlames Church - Outside
=-Igl 5tdames Church - ALL
=] Project 1
cariwornd [Regiztration St.James Church - Inzide]

+
+

—

Figure 79: Paste the Inside Registration Project into the new ALL registration project

5.6.3.2. Joining the two registrations

Create a new registration project in this database as explained in the previous sections. Instead
of adding ScanWorlds, the previously made interior and exterior registration projects will be
imported. Therefore open the newly created registration and select the Registration — Import
Registration... command. Now select the two registration projects and add them to the new
registration, then press the OK button.
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Figure 80: Inserting the inside and outside registration projects into the global registration project

Note: In the ScanWorld’'s Constraints tab, the total station data file should only appear once! If it
appears twice, this means that the total station file from the inside project to the outside project
was not copied but instead the total station data file for the outside project was re-created (see
5.6.2.1).

When the two registration projects are inserted into the general registration project, check the
constraint list and see that all individual constraints are inserted. Use the Registration —
Register command to register all the scans of the Church into one coordinate system.

When the registration finishes, check the maximum individual errors of the enabled constraints,
this should be about 19mm. Also check the mean absolute error of the whole registration
(Register — Show Diagnostics); this should be about 4mm.

To be able to work with the registered point set, use the Registration - Create
ScanWorld/Freeze registration command. Then create a new modelspace view using the
Registration — Create and open Modelspace command.

The final result is a fully registered dataset that can be used for further processing (St.James
Church — Tutorial ALL.imp).
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5.7. Data processing
5.7.1. Direct 2D modelling from point clouds

57.1.1. Introduction

Different ways exist to extract useful data from point clouds. In this chapter, 2D plans, x-sections
and elevations will be extracted through direct 2D modelling. This means that the point cloud is
filtered so that it only contains relevant data enabling the tracing manually in a CAD environment
to create the 2D drawings.

CloudWorx is an external application (MDL — MicroStation Development Language) for
MicroStation which allows to display and manipulate point cloud data in order to produce 2D
drawings, 3D topographic plans or full 3D models (wireframe, surface or solid). A similar plug-in
exists for AutoCAD with approximately the same menu structure and commands as the plug-in
for MicroStation. This tutorial will explain how to use CloudWorx in MicroStation.

5.7.1.2. Loading the database file

When the point cloud is registered, it is ready to be used in MicroStation CloudWorx. Due to
the large file sizes of *.imp files, it is not practical to work with them across a network. Therefore
they are copied to a personal hard drive. To be able to open the database in MicroStation, it
needs to be attached to Cyclone first. If this is not yet done, please follow the steps in
paragraph 5.5.

The area of interest is the data which has been registered together as one complete point cloud
with each scan world in its true position.

The data which has been registered together will (nearly) always be at the bottom of the list of
ScanWorlds and is named ‘ScanWorld (Registration St.James Church — ALL’. Expand this
project so that it displays its sub levels. To open the data in a viewer, expand the Modelspaces
folder and double click on the ‘Modelspace View 1'.

5.7.1.3. Getting Started

The first step when starting work with MicroStation is to create a new file. Open MicroStation,
then open File>New and choose the path to the working folder, then type in the name of the
drawing.
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Figure 81: Creating a new drawing file to import the point cloud into MicroStation

Make sure the right seed file has been chosen (template file). It should be seed3D.dgn (at the
bottom of the New window). MicroStation supports 2D and 3D files and when working with

CloudWorx the 3D file is always used. File needs to be in metres.

Now load the CloudWorx plug-in into MicroStation. The plug-in can be found in Utilities>MDL.
In the bottom window find CloudWorx and click Load.
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Figure 82: Loading the CloudWorx plug-in into MicroStation

Alternatively, simply type in the Key-In field (available from Utilities>Key-in) command: mdl
load cloudworx. Now CloudWorx is loaded into the MicroStation environment.

5.7.1.4. CloudWorx Tools

CloudWorx main tool box has 8 sub-boxes. Open them by click-and-hold or open by click-
and-drop (as shown on the picture).

CloudWorx Clipping

AP 0F0 K

Cloud... @

Cloud¥orx Hide Regions

CloudWorx Standard

3
SR My

o+, ot =)
= w P

Cloud¥orx Fitting Tools

[x]
FHAIR| T T

Figure 83: CloudWorx toolboxes
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Figure 84: CloudWorx Toolboxes

5.7.1.5. Importing a Point Cloud

In order to bring the point cloud into MicroStation there is a need to use the Open
ModelSpace View tool in the main CloudWorx toolbar. This brings up the Open
ModelSpace View window which should be familiar with from preparing the database in
Cyclone previously. If the database and modelspace do not appear in the Server space in the
window then navigate to the modelspace from the Open ModelSpace View window.

Open ModelSpace View (%X ] &7 Select ModelSpace View
Iput File AutaCAD units SCA
Server | | o Sl Eﬁ PCAZZS [unshared)
e B i = 6 5tdames Church - ALL
| | Inches > =3 Project 1
: Feat =5 [+ h Scanwworld [Fegistration Stdames Church - Inside]
b5 4 :
L | | D IYE“SS Us o = h Scanworld [Registration St.ames Church - Outside]
e B.TS.[_ i urvg_','] bt -@- Registration St.James Church - Outside
Coordinate Systems Murmber of units per meter =3 ModelSpaces
v] | | i =i ModelSpace
: o CEEEE w1
[ h Scanworld [Registration St ames Church - ALL]
O [ SHORTCUTS

[ Open J ,_ Cancel J

Figure 85: Opening the point cloud ModelSpace View in CloudWorx
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After clicking the Open button, CloudWorx shows a dialogue containing some parameters of
the dataset. These parameters are automatically extracted and filled in from the database itself.

Open ModelSpace View

Units Used In Design

Urits Sulfix Mudltiphier
Distance Meters ""I [m |
Anale Degiees "| [deg |

MS View | ModelSpace View 1
Database | St James Church -ALL
Server | LOCAL

Ok ‘ Cancel

Figure 86: Parameters for opening the Modelspace View

Click OK and the point cloud will now appear in the current MicroStation drawing. If not, use the
Fit View command.

= E1E])

TR ’

Figure 87: Point Cloud loaded into MicroStation CloudWorx
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Note: By default, MicroStation switches on Can Select Point Cloud and Snap To Point Cloud
settings when importing the point cloud. These need to be switched off. These options are in
CloudWorx Preferences.

& CloudWorx Preferenc M= | x
| o u
Cloud Diisplay | PickAfisible | Fitting | Colar Mapping | Cloud Fegen | []+] =
& &

[ Hide &l Paoint Clouds (%( s

¥ Can Select Paint Cloud J" T

¥ Can Snap To Point Cloud [Tentative Picking) : S&t“; .k.l"'-"' "

et Pick visible. ..

Figure 88: CloudWorx Preference settings

5.7.1.6. Regenerating the point cloud

When viewing point cloud data in MicroStation there is a screen refresh issue, which means a
standard MicroStation Update View is not sufficient to regenerate the point cloud as it is
actually Cyclone which is controlling the point cloud. For this reason when initially viewing the
cloud it may appear sparse. Note that there are some points displayed but not at a resolution
which enables all points to be displayed.

To view all points use the Regenerate Point Clouds icon. A Reading Point Blocks progress bar
will then appear in the bottom left of the screen. Once it reaches 100% (this may take a long
time depending on the number of points in the point cloud) the cloud should have regenerated.

When zooming in and out, panning or changing or rotating views the resolution of the point cloud
will drop and the whole regenerating point cloud process will need to be constantly carried out.

5.7.1.7. Manipulating the point cloud

There are commands within CloudWorx which enable the user to view only certain parts of the
point cloud to assist us with plotting in MicroStation. For example, if part of a street has been
scanned for the purpose of drawing some building frontage elevations, then only a certain part of
the cloud would be viewed in such a way as to see only the points of the elevation pertinent to
that location.

There are a few different methods available for clipping point cloud data. Defining the points to
be displayed or hidden can be done via a limit box, slice, section view, or fence.

The Limit Boxes Manager, Cutplane Manager and Hide Regions Manager dialogue
(CloudWorx Clipping and CloudWorx Hide Regions menu) can be used to create, edit, make
current and delete all slices, boxes and section views in CloudWorx. The advantage of this is
that the user can save multiple “Slice” states and name them accordingly such as Elevation 1,
Elevation 2, etc.

In working practice there are very few commands which need to be used to manipulate the

cloud. These will mostly be the Hide/Show Regions using a fence and the Slice command. The
skill is knowing when and how to use these commands to produce the desired result.
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Note: Hidden points are not deleted from the ModelSpace View or database. The following
commands merely reduce the size and complexity of point clouds for viewing and processing.

Slice

A slice allows the definition of two parallel 3D planes, and then the hiding of the points outside
the zone between the two planes, resulting in a controlled cross-section view of the point cloud.
This method is good for clipping a cloud to show only an elevations point cloud data for
example. It is only possible to have one slice active at a time. The current slice can be moved
one step (equal to the width of the slice) forward/backward along its axis via the Slice Forward
and Slice Backward tools or within the Cutplane Manager (where the slice can also be given
a name).

Fence

The fence command allows for the hiding or showing of points within a user-defined fence.
Fence operations are independent of other functions that hide point clouds. This means that a
fence could be used to view a certain area of data, and then within this fenced data a slice could
be used. A fence can be in the shape of a circle, rectangle, or polygon and thus offers the user
the most precise control over which points are hidden or shown. The Hide Regions Manager
dialogue (CloudWorx Hide Regions menu) is used to manage all such regions defined by a
fence. Each region is tracked individually. Unfortunately it is not possible to name any of these
regions.

Limit Box

A limit box is a 3D rectangular box beyond which points are not displayed or processed.
Creating or modifying the limit box is done using tools from CloudWorx Clipping menu. In Limit
Box Manager these boxes can be named and saved.

Section View
Section view allows for the defining of a 3D plane, and the hiding of points on one side of that
plane, for an exposed cross-section view of the point cloud.

5.7.1.8. Working Example
» Choosing elevation
The image below shows the plan view of St. James Church which needs elevation drawings.

The first thing to do is to isolate just the elevation to be draw. The highlighted elevation will be
used.
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Figure 89: Choosing an elevation

To do this we first need to place a Fence (see image below). Use the Fence Type: Shape.
Once the fence is placed, click the Hide Outside command and all the points outside the fence
will be hidden.

Fence Type:  Shape ¥
Fence Mode:  Inzide ¥

LCloze Fence

Flace Fence

Xl GTFL N+ [
FlBn bl # » OO |-

Figure 90: Hiding all points outside a Fence

» Setting Views

By default, MicroStation opens 4 views. These are: Top, Isometric, Front and Right. These
views are associated with the global coordinate system. Usually it is not aligned with the
building, so there is a need to rotate the views before starting drawing.

At first, a line is drawn to define the elevation plane. Zoom in and try to fix a line that fits best to
the requested elevation plane.
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Figure 91: Create a line to define the elevation plane

Now we need to align the Top view with this line. In the Key-in field type rotate view element
and press Enter. Then identify the element for alignment which is the line that has been already
drawn and select view for rotation — Top view.

Now the Front and Right views need to be aligned with the elevation. At first, copy the view from
View 1 to View 3 and rotate it so that the Front view is aligned with the elevation. The Copy
View tool can be found in the 2D View Control toolbar.

i %]
AQQOLWE AR &

Figure 92: 2D View Control toolbox

Click the Copy View icon and select the source view (View 1 — Top), then select the destination
view (View 3 — Front). This copies views 1 into the view 3 window. To get the Front view in View
3, it needs rotating.

MicroStation views have independent coordinate systems, always aligned with the borders of
the window. The X axis goes horizontally, from left to the right, the Y axis goes vertically, from
bottom to top and the Z axis is vertical to the view. To rotate the view by a certain angle, type in
rotate view and the rotation amount around every axis, separated by commas. The rotation
direction is clockwise.

For example, to get the front view of the elevation in View 3, rotate the view around X view axis
by -90 degree. So type in: rotate view -90,0,0. Then press Enter and select the view. Now
obtain the Right view of the elevation. Copy View 3 to View 4 and then type in rotate view 0,-
90,0 (in order to rotate the front elevation view by -90 degrees vertically), press Enter and select
View 4.
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Figure 93: Views aligned with the elevation plane

Save views, so that they can be retrieved and displayed in any window. To do this, go to
Utilities>Saved Views. A window similar to the one below will appear.
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[~ ClipYalume [~ Reference Settings
Cloze | Apply |

Figure 94: Saving views

Click the top-left icon (Capture) in the window and add a name and description (In example:
View 3 captured, named Front, description Front) and click OK. Now capture and name the rest
of the views. To make a view current, just click on the name to highlight it and then select the
viewport in the top-right icon (View). MicroStation can display up to 8 views. Confirm the
selection by clicking Apply.
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If the requirement is a 2D elevation drawing, all the lines should be drawn on one plane. To be
sure this happens define the ACS (Active Coordinate System) and lock it so that all your lines
will snap to the XY ACS plane.

To define the ACS, use the line was used to define the elevation plane. Find the ACS tool box
and use Define ACS (Aligned with Element) tool. Then select the line and the view. Now lock
the ACS plane using the menu item Settings>Lock>ACS.

| ]t 12 eyt 12
A\

—= 3
Define ACS (aligned with Element)

[

Figure 95: Defining a new Active Coordinate System

Note: Before starting drawing, remember to save the settings (File> Save Settings or CTRL+F).
Otherwise, if the MicroStation drawing is closed, all the views and tool settings previously made
will be lost.

Note: If a tool box on your desktop cannot be found, it is probably not opened. Tool boxes can
be accessed from the pull-down menu: Settings>Toolboxes or by short-key: CTRL+T.

Once the ACS is created and aligned to the elevation, the drawing can be started. Follow the

points and try to fit lines as best as possible. Some results made by the authors are shown in
Figure 96, Figure 97 and Figure 98.
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Figure 96: Front Elevation

Figure 97: Cross Section
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Figure 98: Floor plan
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5.7.2. 3D Modelling of Complex Surfaces

5.7.2.1. Choice of software

One of the final requested deliverables is a 3D model of the masonry vaults with very high
accuracy, so that it can be used to perform a finite element analysis for structural
deformation measurements. Generally, complex structures like these are meshed; which
means that all the points are transformed into surfaces by connecting them through small
triangles.

Standard software packages provided by the laser scanner company (i.e. Cyclone,
Realworks Survey,...) do provide some meshing and modelling tools. However, these are
limited for use with very simple shapes (planes, cylinders...) or do not provide appropriate
control for noise reduction or hole filling. Therefore, it is suggested using third-party software.
Because of its emerging use in a wide variety of domains, laser scanning has generated
competition in the point cloud processing software market.

For this tutorial Geomagic Studio (v9) software is used. The main reasons for this are that
it has a very friendly user interface, it can handle huge datasets and it has preview
possibilities when performing certain tasks which make it a lot easier to find the proper
parameter settings. Some other software package that do the same are Rhino3d,
Innovmetric PolyWorks, Inus Rapidform, JRC Reconstructor, ....

5.7.2.2. Preparing and exporting the data for modelling

Because the modelling or meshing step is one of the most computational and time expensive
steps in the whole processing process, it is a good habit to only export the required data for
processing. Cutting up the fully registered point cloud can be done in the Cyclone software,
as well as in the Geomagic Studio (v9) software. Because Cyclone can handle huge
datasets better than Geomagic Studio (v9), Cyclone is used to cut the data.

To cut the data into pieces, a new modelspace is created of the registered dataset of the
St.James Church - Inside project. In the Cyclone Navigator, right click the Modelspace
folder and select the Create and open ModelSpace view command from the drop down
menu.
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Figure 99: Creating and Opening a Modelspace View of the ‘Inside’ registration project

Cyclone now opens a view of the fully registered point cloud dataset of the inside of
St.James Church. To be able to select the correct part of the point cloud representing only
the vaults, change the view to orthographic instead of perspective. This can be done using

the 2 icons in the top toolbar ‘2% . Then select the Viewpoint - Standard Viewpoints —
Top menu item to get a top view. In the same Viewpoint menu, remove the option Keep

Viewpoint Upright. Then manoeuvre the point cloud using the pan, rotate and zoom tools
to create a view as in the following image.

Figure 100: Top view of the “Inside’ registered project
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Use the Rectangle Fence Mode tool = to select only the masonry vault area of the main
nave, right click the fence and select the Fence — Delete Outside Command from the drop
down menu.
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Figure 101: Selecting a part of the point cloud using the Fence tool

Then rotate the point cloud to get a front view and remove the unwanted parts. The result of
this process is shown in Figure 102.

Figure 102: Selected area of point cloud

Unfortunately, there is no easy way to get the number of points contained in this final point
cloud set. The only way is to unify all the different point clouds into 1 single point cloud and
then gather the info from this point cloud. To do this use the Tools — Unify Clouds... menu
item and make sure the Reduce option is unchecked. Then Cyclone will show a warning
dialogue declaring it has found certain object that were fitted to the point cloud and that these
will be removed when unifying the clouds. Just select ‘Yes’ and wait a little while. Once the
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point clouds are unified, we can get some information of this point cloud through the Tools —
Info — ModelSpace Info menu item.

F IE! Help

annotations + — -
ModelSpace Info
Measure 4
. Scardworld Info
Piping g

&) ModelSpace Info

Objects: wizble =1 total = 156

Point Clouds: visible =1 tatal =1
# points: vizible = 27026023 total = 27026023
Wertices: vizible = 0 total = 155

[ Automatically Update

Mare Info...

Figure 103: Modelspace Info dialogue to see how many points are in the point cloud

We see that about 27 million points remain in the filtered point cloud. This amount of points is
normally still too large to load into third-party point processing software (except for 64-bit
versions that allow the use of full memory capacities). Therefore it needs to be split further to
have 3 point clouds: one of the vaults above the choir area, one of the vaults above the
crossing between the main nave and the transept, and another point cloud containing the
vaults above the main nave.

In the Cyclone viewer, create a new fence around the vaults in the choir area. Then click the
right mouse button and select the Copy Fenced to New ModelSpace menu item (see
Figure 104). This will create a new modelspace and copy the selected points into this
modelspace. Now do the same with the other 2 parts and make sure there is a small overlap
between the point clouds. When closing the newly created modelspace views, select the
Remove link from original ModelSpace to disconnect this point cloud from the original.
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Figure 104: Copy the selected area to a new Modelspace environment

Now export each of these point sets so that they can be used in other software. In the
Cyclone Navigator three new ModelSpaces can be seen. Each of them contains the
selection sets made earlier. To export these, right click the appropriate modelspace View and
select Export from the drop down menu. Most third-party software packages can read a
variety of point cloud files, but one that is commonly used by leading exponents is the *.xyz
format. Select the *.xyz format and name the files respectively ‘vaults_choir.xyz’,
‘vaults_crossing.xyz' and ‘vaults_mainNave.xyz' (see Figure 105). When the process of
exporting is finished, close the Cyclone Navigator.

l.-? Export to File

Save in: |ﬂ£‘ Deskiop j = =5 Ef-
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& My Nebwork Places
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Figure 105: Export the point cloud to a file

5.7.2.3. Introduction to Geomagic Studio (v9)

Using Geomagic Studio (v9), a final meshed model can be produced in a variety of ways. It
is important to use the correct workflow. In this tutorial a workflow is recommended which will
provide guidance through a general process that is accepted throughout the heritage
community. It will explain the basic steps and principles and will help the novice to get started
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with Geomagic Studio (v9) software. Although the case of St.James is very complicated
and will need most of Geomagic Studio (v9)’s tools to do the job, more detailed information
can be found through the Geomagic Studio (v9) help files or through the Geomagic
Studio (v9) helpdesk (www.geomagic.com).

As already mentioned, the point cloud processing will continue using Geomagic Studio (v9)
software. Open Geomagic Studio (v9) by double clicking the desktop icon.

General Toolbar Menu

- Geomagic Studia 9 -- E:\Case_S1Jacobs\meshing\vaulls_export, xyz

Toolbar 2

Mickde Butior: Fictats | i gom | Pap 252am | N

Manager Panel Status bar and command help Viewing Area

Figure 106: Geomagic Studio (v9) Graphical User Interface

Geomagic Studio (v9) has 6 main areas in its user interface, all labelled in Figure 106. To
load the data set, select the File — Import menu item and select the ‘vaults_choir.xyz’ file.
Geomagic Studio (v9) will show a dialogue asking for a sampling ratio (see Figure 107). A
100% sampling ratio will be used, loading all the points.

File Options

Sample

Fiatio

K.eep Full Data on Sampling

Figure 107: Loading Ratio
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When Geomagic Studio (v9) finishes importing the points, it will ask the unit type used for
this dataset. In this case all the point clouds were registered to the total station data, which
was measured in ‘meters’. Therefore ‘meters’ is used as the proper unit type.

[ Always uze thiz setting

——

Specify the unitz for the data

Figure 108: Specify the unit type for the loaded point cloud

Geomagic Studio (v9) opens the point cloud and shows it in the viewing area. It also
shows the number of points loaded into memory, in this case about 7.8 million points.

To rotate the point cloud in Geomagic Studio (v9), press the middle mouse button and
move the mouse. Zooming is handled by the scroll button and panning by holding the Alt key
and moving the mouse. Since it is computationally very demanding to display this amount of
points, Geomagic Studio (v9) reduces the number of points shown on screen while
keeping all the points in memory for processing. The percentage of points displayed in the
manager panel may be changed using the Display statistics (see Figure 109). The left value
is the percentage of points shown when not moving the point cloud and the right value is the
percentage of points shown when moving the point cloud. Geomagic Studio (v9)
automatically sets these values based on the available memory.
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Figure 109: Display Statistics dialogue settings

When the point cloud is loaded, it is displayed as a black mass of points. This makes it
difficult to get an idea of the structure. Therefore change the point shading using the View —
Shading - Shade points menu item (Figure 110).
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Figure 110: Shade the point cloud view for better understanding

The point cloud will be splatted (see Chapter 3.6.1), and it will look cleaner and easier to
understand (Figure 111).

*= Geomagic Studio 9 -- E:\Case_StJacobs\meshing\vaulis_choir.xyz
File Edit Wiew Tools Points Curves  Apalysis  izards  Help

e .| @@‘%@&ﬁ&@\@qyw& :
EX AR T B jeuE v
‘od» 12345 =

Manager Panel

% 9 @ (5 @

@/ o ©

[ Frort Plane
Clip Only
Desth
Owerlay
Model Info

[] Coordinate Systems
[] Macro Server

[ Memary

[] Bounding Box

Short

Dizplay % [Static / Dynamic)

Points |33 v| /[ v

Cells [100 v #[100 v

Palys [100 ~| /(100 v|

[ Fly Thru Mode

WURES Resolution | | Current Points: 7,821,751
o] ¥

Selected Points: 0

Left Button: Select region | Chrl+Left Button: Unselect region | @ Delete selected region | Middle Button: Rotate | Shift+Right Button: Zoom | Alk+Middle Button 8:41 am I

Figure 111: Fully loaded, splatted view of the point cloud in Geomagic Studio (v9)

The 32-bit version of Geomagic Studio (v9) (version 9) is able to handle about 20 to 25
million points, but the suggestion is to work with smaller chunks of data, approximately 5
million points. For this part of the vaults (8 million points), split the dataset into two parts. To
do this, manoeuvre the view so as to have a top view of the vaults. Then, make a selection
box selecting the first two vaults. Geomagic Studio (v9) will select the points in the
selection box and colour them red (Figure 112). To separate them from the original point
cloud data set, select the Edit — Selection To Object and name the new object ‘part 1’ and
leave the option ‘Cut and Paste’ checked.
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Figure 112: Split the point cloud into smaller chunks for easier handling

When Geomagic Studio (v9) finishes this operation, there are two parts (‘parfl’ &
‘vaults_choir’) in the Model Manager. The first to be fully processed is the ‘vaults_choir’,
therefore remove the first part from memory. To do this, right click ‘part 1’ and select
ignore, then right click again and select hide.
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Figure 113: Remove one of the parts from memory

5.7.2.4. Pre-processing of the point cloud: noise removal

When analyzing the point cloud, some areas are seen that are not connected to the whole
and there is also noise in the data (see the speckled points). Before this point cloud can be
transformed into a meshed model, it needs to be cleaned and resampled.

A first step in the cleaning process is to remove unconnected components manually.
Manually select the unconnected components using a selection box and press the delete
key (see Figure 114). There are different selection tools available in Geomagic. These can
@A EW

be found through the icons on the right i
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Figure 114: Manually removing disconnected parts

When all major isolated components are manually deleted from the set, we can use the
automatic noise removal tools from Geomagic Studio (v9) to optimize the point cloud for
the meshing phase.

Select the Edit — Select — Outliers menu item or press the “* icon. Geomagic Studio (v9)
now opens the parameter setting box on the left of the screen. Adjust the value so that no
large connected areas are selected as being noise. In this case use a value of 50 and as can
be seen in the lower left corner this selects 57000 points of the 4.5 million (Figure 115). This
is about 1.2 percent of the total amount of points. Also it can be observed that there is noise
in the vertical area connecting this vault to the crossing vault. An explanation for this problem
is the fact that the laser beam intersection angle to the surface is very small, providing a
widely spread beam footprint and a low laser reflectance (see chapter 3.1.3).

When pressing the OK button, Geomagic Studio (v9) selects the noisy points so they can
be deleted by pressing the Delete key.

el g X | [lzometric)
.=
Senzitivity g]

Figure 115: Outlier Removal using the automated outlier removal tool
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The next step in preparing the data for meshing is inherent noise removal. Geomagic
Studio (v9) provides a tool in the menu called Points — Reduce noise.... The noise
reduction tool in Geomagic Studio (v9) offers a number of possibilities and settings to
make sure that noise can be reduced without loosing detail or affecting accuracy. Three
different noise reduction algorithms are implemented, each aiming at different type of
objects: Free-form shapes, Prismatic shapes (conservative) and Prismatic shapes
(aggressive). In general, architectural buildings can be approximated by prismatic shapes.
However in heritage recording we need precise measurements and not approximations.
Therefore the ‘free-form shapes’ noise reduction option will be used (see Figure 116).

b anager Panel g X

T 2 ® =2 K

Farameters
(%) Free-form shapes
() Prismatic shapes [conservative)

() Prismatic shapes [aggressive]

Smoothness Level

MNane J Max
Iterations [ I%
Dreviation Limit [ 1,032 m =
Outliers
Thieshald [0.00546 m =]
) Select
() Delete

Include |zolated Points

[] Preview

[] Display Deviations

Statiztics

Moige Level:

b axirnum Distance:
Awerage Distance;
Standard Deviation:

Crease Info

l ] 4 ][ Cancel l[ Apply l

Figure 116: Noise Removal using the automated noise removal tool

To control the amount of noise reduction, Geomagic Studio (v9) provides 3 parameters.
The Smoothness Level, the Number of Iterations and the Deviation Limit. A first guess
for the Deviation limit is automatically computed by Geomagic Studio (v9). In most cases
this value is appropriate, so we will keep it. The smoothness level specifies the
aggressiveness of the filter. In general we try to use the lowest setting that gives acceptable
results. The number of iterations can also be set. This allows for the gradual removal of
more noise in subsequent steps. It is preferred to increase this setting above the increase of
the smoothness value because this keeps more surface detail.
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To have an idea of how well the chosen settings work, a preview can be made of a small
patch of the model. To do this, check the Preview option in the dialogue (Figure 117). In the
preview dialogue the amount of points to be used can be changed. For large datasets it is
suggested to use about 10000 points. Then select a point in the point cloud and Geomagic
Studio (v9) will isolate this area and mesh it using the noise reduction settings provided by
the user. While in this preview, you can change the settings to see their effect. It is
recommended to preview a relative smooth area first and try different settings of smoothness
levels and number of iterations. Then click the Select Area button again and select a more
complex area containing more relief. Check if the settings made for the smooth surface are
also satisfactory for this piece. If not, adapt them and check the smooth area again.

For the data set ‘vaults_choir.xyz’, use the Free-form shapes option with a smoothness
level set to half and 3 iterations. These settings remove most of the noise but keep enough
detail for a proper mesh.

To do: Test the different noise reduction types on different areas of your point cloud (i.e. flat areas, smooth areas,
areas with a complex relief, areas with sharp edges), and try to understand what they can be used for.
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Figure 117: Previewing the noise reduction parameters on a small patch

When satisfied with the settings uncheck the Preview option and press the Apply button.
When the noise reduction process is finished, the Crease info should be checked. The
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crease angle predicts the success of the meshing process. A value greater than 10 suggests
that additional noise reduction or sampling is necessary.

After noise reduction, the crease angle for the St.James dataset turns out to be 3.33759,
which is acceptable, so press the OK button (Figure 118).

\il) Crease angle: 3.337590

Figure 118: Crease Info
5.7.2.5. Pre-processing of the point cloud: resampling

As a final step before the meshing, the data needs to be resampled. This is needed because
for each point in the point cloud, Geomagic Studio (v9) will create about 2 triangles in the
meshed model. For 4.5 million points, this would mean 9 million triangles. This not only
requires considerable of memory, but it also requires extended computing time. Therefore it
is more effective to first intelligently reduce the point cloud to an acceptable number of points
(around 1 to 2 million).

Geomagic Studio (v9) provides 4 different kinds of resampling; however the most
commonly used by practitioners is the Uniform Sampling method. This tool is found in the
Points — Uniform Sample menu. When Geomagic Studio (v9) starts this command, a
dialogue box is shown on the left in which the parameters can be set (Figure 119).
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Figure 119: Uniform Resampling Settings Dialogue
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To resample the data, Geomagic Studio (v9) provides 3 options. Since the need is to keep
as much detail as possible, it is important to use the first option which requests specifying the
Absolute distance between points in the resampled point cloud. The requested value is
defined by the distance between points in areas of low curvature (smooth areas). These
areas generally do not need much detail. Set the Curvature Priority slider to Max, to scale
the distance value for low curvature areas respectively to areas of high curvature.

The Curvature priority slider has 11 scaling steps. For instance enter a spacing of 2 cm for
low curvature areas and set the Curvature priority slider to maximum (11), the spacing
between points in high curvature areas will become approximately 2cm / 11 = 0.18cm or 1.8
mm. So, in general think of the spacing that is required in high curvature areas, set the
Curvature Priority slider first to maximum and from these compute the distance between the
points in low curvature areas.

Since it is best to reconnect this final meshed model to the meshed model of the
‘vaults_crossing.xyz' dataset, it is suggested to activate the Keep Boundary Option. Start
the resampling tool with the parameters just explained. After resampling, only 446000 points
remain in the point cloud, this is only 10 % of the original cloud.

5.7.2.6. Meshing

Now the noise is removed from the point cloud, it has been resampled to get an acceptable
number of points, so meshing can start. The meshing step in Geomagic Studio (v9) is quite
straightforward. Use the Points — Wrap menu item to start the meshing tool. Again a dialogue
box is shown on the left (Figure 120). In most cases of architectural reconstruction a final
surface would be required, so use the Surface Wrap Type. In the advanced option there is
another noise reduction algorithm that is not used since its outcome cannot be controlled
visually and since a noise reduction has already been performed in an earlier step. Again, a
sampling rate can be chosen to reduce the complexity of the mesh.
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Figure 120: Wrap Meshing settings Dialogue
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Different tests have shown that the standard setting of 250000 triangles gives almost no
difference to using the full dataset. The maximum measured difference between these 2
possibilities in numerous tests was 2 mm. So, in this case use this as the standard setting
and proceed with the meshing process by pressing the OK button.

Figure 121: Meshed model

Geomagic Studio (v9) finds the normal of each surface and colours the triangles
accordingly. This is why the inside of the mesh is blue and the outside is yellow (Figure 121).
Normally the blue side is required as the outside, so flip the normals using the Polygons —
Flip normals menu item.

To do: Zoom in to the meshed model and analyze its accuracy, especially in high curvature areas. What do you
see?

To do: Try preparing and meshing the ‘part 1’ section that was split earlier in step c.

The authors of this manual used the following settings:

- Selecting outliers: 30.0

- Noise reduction: Free-form Shapes, smoothness Level %, iterations 3, outliers delete = Crease Angle 5.496
- Uniform Sampling: Absolute Spacing 0.02m, Curvature Priority maximum, keep boundary

- Wrapping: Surface, No noise reduction, Target Triangles 250000, maximum Quality

The result so far can be seen in the file ‘vaults choir meshed.wrp’
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5.7.3. Hole filling

5.7.3.1. Introduction

Because of lack of information or noisy data the meshing phase often leaves holes in the
final mesh. Areas that do not contain dense point information or no data at all cannot be
properly interpolated to create a surface and therefore need more information. Through a
hole-filling process, the user can provide this additional information and holes can be filled.
Small holes are often filled by interpolating the neighbouring surface mesh, but larger holes
need individual user interaction.

Depending on the final use of the 3D model, these holes can also be left open. In this case,
one of the final deliverables was a full 3D model of the vaults for finite element analysis, so it
is important that all holes are filled.

5.7.3.2. Connecting two meshes

Before filling up all the holes, join the two separate meshes. Select both meshes in the Model
Manager Panel and start the Polygons — Merge Polygon Objects menu item (Figure 122).
The name for the merged object can be ‘vaults_choir_merged’. The Stitching option is
available and should stitch both meshes together; however, it sometimes does not perform
as expected. Therefore it is we preferred to do the stitching manually.

b anager Panel = Xl [lzometric)
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Figure 122: Merging two meshes

Manoeuvre the view to get a top view of the vaults and make sure they are aligned

horizontally. Then use a selection box (icon ‘ﬁ“ on the right toolbar) to select the area around
the gap (Figure 123). Start the Polygons — rewrap... function. The best result is achieved by
choosing the Create New Vertices option. This option first removes the existing mesh, then
creates new vertices so that the triangles of the new mesh are approximately the same size
as the surrounding triangles and then re-meshes that part of the point cloud.
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Figure 123: Newly created mesh connecting the two meshed parts

5.7.3.3. Removing the altar vault

Since the vaults on the left side above the altar, were in a very bad condition and was
scanned from only one position, the final mesh of this area is below standard. It contains
numerous large holes because of missing data. Although it would be possible to fill all these
holes, it would take too long in this tutorial. Therefore this will be deleted from the dataset.
Make the following settings to make selecting items easier: in the Edit menu, the BackFace
Mode and Select Through should be active and Select Visible Only should be de-
activated. Then select the part above the altar using a selection box and press the Delete
key. (The dataset at this stage can be found in 'vaults_choir_meshed_without_altar.wrp’)

5.7.3.4. Filling small (simple) holes

The next step in creating a good 3D meshed model is to analyze and fill the holes left by the
meshing algorithm. Geomagic Studio (v9) provides automatic tools for filling holes, but
these only work properly for small holes. Larger, more complex holes should always be filled
manually, so that the user can interact with the model.

For using hole filling tools, the mesh should not contain any spikes or disconnected triangles.
Therefore first use the Polygons — Make Manifold — Open menu command to clean the
mesh.

Firstly all the small holes will be filled by using the automatic hole filling tools. Select the
whole mesh using a selection box and start the Polygons - Fill holes... menu command.

It can be seen that Geomagic Studio (v9) found 117 holes in the mesh (Figure 124). These
are shown in the model using red boundaries. Five different hole filling methods are
provided. To fill the small holes the first fill method is used. Then the Deselect Largest
button is used to remove the largest hole from the set. This is continued whilst visually
checking the holes that are removed from the filling set, and is stopped when all large holes
are removed.

In the dataset, 7 large holes were selected, leaving exactly 110 holes to be filled
automatically. The Fill All button will start filling these holes automatically. Keep all the other
settings as they have been set by default.
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Figure 124: Hole Filling Settings Dialogue

When Geomagic Studio (v9) finishes the hole filling process, it returns a message stating
that it is not recommended to use curvature based filling for 33 holes. These holes will be
checked manually to make the appropriate decision on how to fill them correctly. Therefore
press the Cancel button.

All small holes are filled and highlighted in red. Press the OK button at the bottom of the Hole
filling dialogue to confirm the correct filling of these small holes.

5.7.3.5. Removing parts with not enough information

Now each of the 33 unfilled holes can be analysed manually by visually inspecting them and
then choosing the appropriate way to fill them. Looking at the mesh, a number of holes at the
bottom next to the niches can be viewed. Since there is not enough information to be able to
fill these holes, the bottom structure will be removed. Use the selection tools to select the
bottom structures of these holes and Delete them (Figure 125).
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Figure 125: Removing parts that do not have enough information

5.7.3.6. Filling complex holes 1

Now select one of the circular decoration areas on top of the vaults and start the Automatic
hole filling tool. Most of these holes have very irregular boundaries and can therefore not be

filled correctly. Zoom in to one of the holes and start the Clean Up Tool with the

Triangles Selection activated. Then use the Brush Selection tool = to select the visually
bad triangles and delete them. While selecting these triangles, rotate the model to make
sure all poor triangles are selected (Figure 126). During this stage the automatic selection
tools like the Rim Distortion or Poor Boundary selection could be used, but most of the time
they throw away too much information.

Figure 126: Cleaning hole boundaries before filling

When the border is cleaned, re-activate Fill tool and select the border of the hole with
your mouse pointer. Geomagic Studio (v9) will automatically fill the hole.

| To do: Fill all other holes in the circular decoration areas using these tools.
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After filling these holes, it may be noticed that these areas still contain spikes (triangles
sticking out of the mesh). Select these areas again and start the Polygons — Remove
Spikes... menu item. Use the slider to adjust the parameter while checking the result. Move

the slider just enough to remove the spikes without affecting the rest of the structure (Figure
127).

Parameters

Smoothness Level

Low - J High

Figure 127: Remove Spikes in the filled areas

5.7.3.7. Filling complex holes 2

The next stage is to start filling the long and narrow hole separating a large part of one of the
vaults from the others.

Figure 128: Example of a narrow hole

Start the Automatic Hole Filling Tool and first use the automatic tools to clean the boundary
of the small hole in the top and then fill it as seen in paragraph 5.7.3.4.
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Now use the Create Bridges Tool to split the large narrow hole into multiple smaller
holes (Figure 129). Using the standard options, select a point on one side of the narrow edge
and another on the other side. Geomagic Studio (v9) will create a bridge connecting both
sides. This bridge is also interpolated using the surrounding surface.

Figure 129: Creating bridges to split a narrow hole into different smaller holes

Use the clean up tool to remove sharp triangles contaminating the smoothness of the
boundary and fill the hole as seen in the previous steps.

To do: The rest of the hole can now be filled using the same procedure as explained above. The narrow hole on
the other side of the vaults can also be filled.

The dataset so far can be found in the file ‘vaults choir meshed holeFilledPartl.wrp’.

5.7.3.8. Copy/paste to fill holes

Very complex holes can sometimes be filled using information from other regions, especially
true for repetitive structures. The niches at the bottom of the vaulted structure are repeated.
Some niches contain holes of parts that are clearly visible in other niches. The next exercise
is to copy a part of one of these niches to fill one of these holes.

Search for the following hole in one of the niches on the vault near the altar (see Figure 130).
First clean up the borders and possible contaminating triangles.
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Figure 130: Example of a hole that does not have enough information to be able to be reconstructed

Then select a corresponding area in the niche to the left of this niche using the selection
tools (Figure 131).

Figure 131: Finding a similar piece to copy/fill the hole

A new object can be created using this selection set. Select the Edit — Selection To Object,
naming the new part ‘niche_copy’ and using the Copy and Paste option. Make sure when
selecting objects to activate the Edit — Select Through option. Now this part will be
registered to the correct position in the niche containing the hole.

Select both datasets (‘niche_copy’ and ‘vaults_choir_meshed’) and start the registration
process using the Tools — Registration — Manual registration menu item. The user interface
changes and a dialogue box is shown on the left (Figure 132). In the dialogue box, select the
‘vaults_choir_merged’ as being the fixed dataset and the ‘niche_copy’ being the
floating dataset. Both datasets will be shown in the top boxes of the screen. The registered
set is shown at the bottom.
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Figure 132: Manual registration dialogue box

Firstly the 1-Point Registration algorithm of Geomagic Studio (v9) will be used. As the title
implies, it only needs 1 corresponding point between the two datasets to perform a
registration. The software relies on the surrounding surface geometry to get extra
information. In the left dataset, zoom into the area where the right dataset should be placed.
Then carefully select one highly distinctive point that can also be seen in the right dataset
and select the corresponding point in the right dataset (Figure 133). Geomagic Studio (v9)

will now automatically try to align both datasets.
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Figure 133: Manual registration to fill the hole with a similar looking piece of the mesh

When Geomagic Studio (v9) finishes the registration, check the alignment in the bottom
screen. If the alignment is not perfect, press the Modify button and manually adjust the
registration. The average distance and standard deviation may be checked at the bottom of
the Manual Registration dialogue. Sometimes, when pressing the Registration button once
more, the registration improves. When satisfied with the registration alignment, uncheck the
Add to group checkbox and press the OK button.

Both datasets are now aligned and can be joined using the Polygons — Merge menu item.
The difference between this merging algorithm and the Polygon — Merge Polygon Objects
is that the first algorithm automatically does a noise reduction and a global registration
procedure before merging while the latter only joins the two meshes into one object while
keeping possible overlaps.

This Merge tool is used whilst leaving the default settings but with both sampling options
unchecked (Figure 134). Then press the OK button to start the algorithm.
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Figure 134: Polygon - Merge command dialgue box

The holes on the side can now be filled using the tools explained in the previous steps.

To Do: Fill the rest of the holes using the principles explained in these steps. Make sure to analyze the hole first
and then decide on which hole filling method to be used

The meshed model can be found in the file ‘vaults choir fullyMeshed holesFilled.wrp’
(see Figure 135).

Current Triangles: 350,102
Selected Triangles: 0

Figure 135: Fully meshed model
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5.7.4. Boundary cleaning

The outer boundary is ragged and what is required is smooth boundary. Start the
Boundaries — Relax menu item and select the boundary of the mesh using the mouse
pointer. Leave the Entire Boundary setting but change the number of iterations to 50. This
value has to be found by trial and error. Then press the Execute button. Geomagic Studio
(v9) will smoothen the boundary.

Figure 136: Mesh before (left) and after (right) the boundary smoothing

5.7.5. Slicing the Mesh to get Cross Sections

5.7.5.1. Preparing Datums

An easy way to create cross sections is through intersecting the mesh with a plane.
Geomagic Studio (v9) provides a number of tools to do to this.

Before slicing, the plane needs to be defined with which to intersect the mesh. In this case
sections will be generated perpendicular to the longitudinal axis of the main nave of the
Church. The symmetry axis of the vaults needs to be found and a new plane generated that
is perpendicular to this symmetry axis and to the xy-plane (this idea is based on the fact that
the total station data used to register all scans was levelled so that the xy-plane can be
considered to be horizontal).

Start the Tools — Datums - Create Datums... menu item (Figure 137). A datum is a
geometric point of reference, such as a plane or an axis. In this case a plane is required so
select the Plane Datum Type E] Give the new plane a name: ‘Symmetric Plane’.
Geomagic Studio ﬁ) can automatically find the symmetric axis of a mesh. Select the Best

Fit Plane Method and the Symmetry Method Type Input . When selecting the
Symmetry Method Type Input, the dialogue changes asking for an approximate plane. See
settings as shown in the image below. Then press the Apply button and Geomagic Studio
(v9) will optimize the plane’s position according to the symmetry of the structure.
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Figure 137: Creating a symmetry plane

If the location is ok, press the Next button to add the plane to the datum list. The resulting
plane defines the symmetry axis of the structure. The actual plane that is needed to intersect
with the mesh needs to be perpendicular to the previously created plane and perpendicular

to the xy-plane. Therefore, create another datum using the Plane Datum Type and call it
‘Slicing plane’. Now use the Offset Plane Method and the Perpendicular through

Point Method Input . When using this option two planes to which this plane has to be
perpendicular and a point through which it should pass have to be defined. Firstly, choose
the previously created plane, the second plane is the xy-plane and pick the point on one of
the sides of the structure (see Figure 138).
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Figure 138: Defining a slicing plane using the Perpendicular through Point Method
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| To Do: Try creating slices every 5 cm using the xy plane as slicing plane.

The model so far can be found in ‘vaults choir fullyMeshed holesFilled sliced.wrp’.

These curves can finally be exported into an OBJ (Wavefront Technologies) or IGES (Initial
Graphics Exchange Specification) file format. The IGES format is a neutral format that allows
the digital exchange of information among different computer-aided design (CAD) systems.
Unfortunately AutoCAD does not have this function in later versions. In future versions of
Geomagic Studio (v9), it will also be possible to export these curves in the DXF format.

5.7.6. Creating animations

For this part of the tutorial Cyclone is used. Cyclone has a build-in animation tool that
allows for the easy creation of walkthroughs through the point cloud.

Open a Modelspace View on the fully registered dataset called St.James Church — ALL.
When Cyclone opens the dataset, please wait long enough so that all points can be loaded.

The first step in creating an animation is to place cameras that can later be used to create an
animation path. Change the view as to have a starting point for the animation; starting with a
general overview of the site, using a bird’'s eye perspective. When satisfied with the starting
point, use the Create Object - Insert — Camera menu option to insert a camera object at
this location. Now change the view to the next location using the view controls. Large steps
can be taken because Cyclone will automatically interpolate the position of the camera
between two manual inserted positions using splines. These allow for a very smooth
transition between viewpoints. Change the view to the second viewpoint; again use the
Create Object - Insert — Camera menu option to insert a camera object at this location.
Continue placing cameras at important positions until finishing the animation path.

Notice the distance between two camera positions (keyframes) should be kept approximately
constant because it is easier to set a constant number of interpolation positions (frames) in
between (see later). It is advised to start with a general overview, then zoom in to the
structure and possibly make a walkthrough and end again with a general overview.

Basic use can be demonstrated using only 5 fixed camera positions (keyframes). The
positions used by the author are shown in Figure 140.

Figure 140: Snapshots of the camera positions to create an animation

When all cameras are created, select all the cameras in the order they were created using
the View - Set Object Visibility menu item. This opens a new dialogue enabling the
arrangement of items to show what should be visible and/or selectable. In the list, highlight
the Camera item and then press the Select button. This selects all cameras in the order
they were created. Then press the OK button.
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Figure 141: Changing the view properties to show the camera positions

Now, go to Tools — Animation — Create Path (loop). Cyclone will add the camera path in
the form of a spline. Then again go to the Animation menu and select Set Path.

To start the creation of the animation, use the Tools — Animation — Animation Editor (Figure
142). In the new dialogue, specify the number of intermediate frames between all keyframes
(camera positions). In general it is advised to first select the whole range of keyframes by
setting the From and To keyframe fields to the left respectively to the first and the last
keyframe number, in this case 1 and 5. Then change the value Number of Frames
between Keyframes to 20 times the number of keyframes (20 x 5 = 100). This value is
derived by trial and error and mainly depends on how fast the animation is to go and the
distance between the camera positions. Then press the Set button. Check the step size by
pressing the right arrow underneath the Frame Number Options. When satisfied, press the
OK button.

&) Animation Editor

K.epframes Mumber of Frames
[# of Keyframes = 2] bebween Keyframes

Fram 1ﬂ << Go 100
Ta 2 «GBo 00 get

& Frame Mumber Parametric "'Time"

84 ¢4 Go 330 <4 Go
Delta 1 << Delta 0300 gq| a2

v &uto-Preview Frame'Time" Add Keyirame @ Time

[ Eeep Curent Focal Point

Reset | ] | Cancel

Figure 142: Animation Editor dialogue box
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Now start the Tools — Animation — Animate menu item and select the Output to Video
File. Call the file ‘Animation.avi’ and leave the rest of the settings to their default value.
Then press the Animate button.
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Figure 143: Animation Settings dialogue box

Cyclone will now automatically show a dialogue in which can be specified a certain codec
to compress the file size of the animation. If accustomed to these codecs, one can be
selected, otherwise, choose the Full Frames (Uncompressed) compressor type.

Notice that most codecs are based on the JPEG principle, which is a lossy compression type.
Results of these codecs are often not satisfactory for animating point clouds. It is advisable
to use a freeware codec called CamStudio that provides the option of lossless compression.

The animation created by the author can be found in the file ‘Animation.avi’.
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6. Industrial case study: FPSO vessel

6.1. Introduction

This case study covers an industrial environment and more specifically the scanning of a
petrochemical platform that has also to be considered as a hazardous environment.

In the following chapter more emphasis will be placed on the laser scanning process itself,
the data processing and particularly the registration of point clouds. Then specific attention
will be given to the use of the processed data during the engineering phase.

The main objectives of this case study are the following:

= Laser scanning in practice in industrial environments

= Use of point clouds in the engineering phase

6.2. Problem statement

The client wants to perform a comprehensive survey of certain areas in order to obtain
accurate information and eventually complement the partially existing as-built measurements
existing in a PDS" model. This has to be performed onboard a FPSO (Floating Production,
Storage and Offloading vessel, Figure 144) located at sea, 300 km off the coasts of Western
Africa.

Figure 144: Photo of a FPSO

An FPSO is basically a unit situated in the nearby surroundings of oil rigs and serves as a
first refinery and temporary storage. These vessels are, most of the time, old oil tankers that
have been transformed. The FPSO pumps up crude oil extracted at the bottom of the sea by

' PDS: 3D plant design software developed by Intergraph (www.intergraph.com)
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several drilling rigs. Every day 250.000 barrels go through the refinery mill, making the
vessel fully loaded in 8 days. Once a week, the refined oil is transferred into a tanker (Figure
145).

Tanker-Offloading

Drilling Platform

Injection fines —

Existing Well Centers @

Figure 145: FPSO within an oil field

The project takes place before the engineering phase and aims at upgrading the FPSO in
order to:

= Exploit new oilfields in the surrounding of the FPSO.
= Expand the production capacity.
= Design new units and piping coping with the new production volumes.
As there are no precise and accurate as-built drawings available, the most suitable

alternative is to produce an “as-is” situation on the basis of 33 point clouds generated by
laser scanning. This will enable the client to:

= Determine where new modules will fit.
= Plan new routings for pipes.
= Determine where new reinforcements of steel structures will be placed.

= Reduce the risks of possible mismatches during the construction.
6.3. Choosing the right measurement technique
6.3.1. Measurement techniques within industrial installations

6.3.1.1. Total station

Many years ago, the measurement of any object within industrial installations was exclusively
done with theodolites or total stations.

With the increasing usage of 3D CAD design tools the need for better, more accurate and
faster 3D measurement grew in parallel.
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At the same time the focus of engineering companies in the developed countries gradually
shifted from green field installations (where no site measurements are needed) to
rehabilitation or extension projects; also called revamp or de-bottlenecking projects.

This in its turn put an additional emphasis on the need for fast accurate measurements,
delivered in a useful 3D format; more so because of the lack of reliable as-built drawings.

The scope of those projects consists of:

Replacement of existing pipes, pumps, vessels,...
Enlargement and rerouting of pipes.

Replacement of (control) valves.

Increasing of pressures, temperatures in the process flows.

Etc.

A typical example can be seen below (see Figure 146) where a basic engineering study was
needed to check and guarantee the possibility of replacing an existing heat exchanger by
another type:

Figure 146: Left; actual situation — Right: extension project in CAD © BnS engineering N.V.

Using classical surveying methods with total-stations during the engineering phase process
is not the right solution any more because of the following disadvantages:
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All the to be measured points have to be exactly pre-defined by the engineering
contractor before the measurement campaign at site, with the risk of forgetting some
and having to return several times to the site.

All objects need to be reachable for the surveyor; hence the need for scaffolding.

Point measurements are slow and costly (man hours).

These cumbersome measurement campaigns last too long before meaningful data is
available for the engineering phase to start.



= |t is unrealistic to measure and report “free spaces” in existing units. Yet, this free
available space is the most valuable information in the case of de-bottlenecking
projects.

= Only 3D points can be imported into the 3D design.

There is thus a need for a faster, safer, more cost effective measurement technique capable
of quickly delivering a complete 3D result at the start of the basic engineering programme.

6.3.1.2. Photogrammetry

Up to 1995 photogrammetry was the only obvious solution for the effective capture of large
objects within integrated process units into 3D CAD models.

However, as with classical stereo photogrammetry the process and workflow were quite
complex and time consuming, the technology never became an appropriate tool for huge
industrial projects with problematic features such as lack of light, shining effects, shadows,
metallic textureless pipes, etc. On the other hand, it is possible to find available software in
the market to carry out industrial projects following convergent imagery with fully automatic
processing.

6.3.1.3. Laser scanning

For more that 25 years, laser scanning technology has been widely developed and used in
the capture of smaller objects, especially in the automotive industry and especially for
metrology purposes.

The breakthrough in laser scanning for surveying within large industrial installations dates
back to the mid-nineties, with the arrival of suitable hardware and software.

The availability of very powerful processors led to the more recent development of laser
scanners and software capable of handling billions of points; the so called “point clouds”.
However the key to success in using 3D laser scanning remains the setup and
implementation of the right methodology and workflow “fit for the job”, combined with the
selection of the most appropriate hardware and software.

6.3.2. Laser scanning: fit for purpose

The job needs to be performed offshore on a constantly moving vessel. This means that all
kind of deformations can occur. Since it is a very dense industrial environment with piping,
steel structures, machines... and since the client needs to have as much accurate
information as possible, the use of 3D laser scanning is the best technique to use.

Indeed, in many cases, laser scanning can offer significant field productivity advantages over
traditional surveying methods for a given topographic or as-built (as-is) survey project.
Offshore oil production facilities provide tremendous dimensional control challenges
throughout their entire lifecycle. During construction, tolerances must be closely managed
between topsides and hull structures even though they are often built in different facilities.
Laser scanning can be used to validate the entire jobsite geometry including locating tie-ins
and anchor bolt locations and verify footing dimensions and positions. In the case of
damage from a storm, the structure must be rapidly documented to aid repair or
decommissioning.

It is however very important to guarantee the highest possible precision. This is done thanks
to the use of targets? that have to be very accurately measured.

The equipment used in the field was:

2 Targets: see 6.5.4.3 Registration using targets
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= Laser scanning: Mensi GS100°
= Total station: Sokkia MONMOS*

The produced laser scan data® can eventually be used in existing CAD or specialized
environment such as PDS thanks to the use of add-ons programs like Cloudworx®. In other
third party programs, “point clouds” can be visualised, together with other CAD drawings (eg.
Navisworx”).

Free software has in the meantime become available and allows non-experts to view point
clouds (e.g. True View®). In addition to being able to view, measure and mark-up scans, this
software also enables the producer of scan data to create a site map with icons that show
where each scanner location was. Clicking on a scanner icon on the site map calls up the
scan image for that location.

6.3.3. Risk minimization by using laser scanning
The use of laser scanning generates the following benefits:
= Accurate, reliable and comprehensive digital information available for sharing from
design to fabrication and assembly

* Reduced survey time

The following risks are minimised:

= Engineering errors are extremely low thanks to the availability of a high number of
precise 3D points,

= Fabrication errors are reduced thanks to the precision of the engineering allowing
even the design of smaller parts,

» Field fitting activities can nearly be eliminated thanks to the obtained precision during
the preceding stages.

As a consequence the usual financial uncertainties for these kinds of rehabilitation or
extension projects are much more under control:

= Only one well defined measurement campaign, holding more information than
immediately needed. The 3D data file of the scan of the site allows the user to get
dimensions after the fact and without having to go back to get more information,

» |mproved overall project planning thanks to the improved reviews and the information
sharing,

= Quasi elimination of reworks and field fitting leading to controlled and limited
downtime.

® Mensi has been taken over by Trimble. Alternatives scanners for industrial installations are provided by several companies
among which: Leica, Z&F, Faro, Riegl, Optech ...

* Sokkia Monmos (see www.sokkia.com): Total Station designed to measure large structures such as ships, buildings, bridges,
etc.

® Laser scan data is commonly referred to “point clouds”

® Cloudworx is a specialised add-on software developed by Leica.

” Navisworx: see www.navisworks.com

8 TrueView: users can view, zoom in, or pan over point clouds naturally and intuitively. Using a simple “panoramic” or “bubble”
viewer approach, a High-Definition Survey™ point cloud can be seen on the computer screen just as if standing right where
the laser scanner captured the scan data
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Such rework savings have been regularly reported to represent up to 10 percent or
more of the entire capital cost of a project. In contrast, as-built (as-is) survey costs
are typically less than 1 percent of the project costs. In other words investing more in
high definition laser scanning will lead to a substantial reduction of the rework:
assuming a cost of 2 percent for the laser scanning and a rework of 4 percent,
reduces the total cost of the project by 5 percent!

Smoother retrofit construction will also result in reduced downtime

Moreover, the use of laser scanning has a major impact on the safety issues:

As the measurements are taken from a distance, the measurement teams can chose
the most suitable scanning locations,

Thanks to the rapidity of the laser scanning, the exposure to the risks is also much
shorter

In summary:

Topics Benefits

One measurement campaign only
Reduced reworks

Costs Reduced field fitting

Improved reviews

Information sharing

Fast data acquisition

Project planning | Improved design

Shorter downtime

Less rework

Quality Accurate shop fabrication of more parts
Improved routings (clash detections)
Measurements from a distance
Shorter exposure to hazards

Safety

6.3.4. Engineering processes for industrial installations

6.3.4.1. 3D CAD applications history and overview

For more then 25 years, engineering design of industrial installations within (petro)chemical
plants has been done though the use of computer aided design — computer aided
engineering (CAD/CAE) applications.

Some of the most well known plant design application software is:
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PDMS a stand alone software developed by Aveva (www.aveva.com)

PDS with Microstation (from Bentley www.bentley.com) as its main platform,
developed by Intergraph (www.intergraph.com)

Autoplant with Autocad as main platform, developed by Autodesk
(www.autodesk.com)




Al these CAD/CAE applications share the same principle:

= All graphical and underlying component data are entered and maintained on one
central system. This means that all data concerning piping, equipment, cable trays,
concrete, steel structures, HVAC and electricity are stored on a central server.

= This data is shared “on-line” between all project team members, see Figure 147:
CAD/CAES8F program architecture - 222H® Bentley Systems. So a design team can
be spread worldwide, without having to miss any design information.
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- = = = =
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Engineers

Layout
Designers
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Figure 147: CAD/CAE? program architecture - © Bentley Systems

Another big advantage of these systems is that the design is completely done in 3D, based
on normalised specifications databases with all relevant component dimensions, materials
descriptions, etc.

At completion all construction documents and drawings are simply generated out of these 3D
models. This means that all deliverables will be linked and will keep their consistency with
the 3D model during the complete timeframe of the engineering process.

6.3.4.2. Engineering with point cloud data

When starting basic engineering works in an existing process unit the following parameters
are extremely important:

= Time frame for engineering

=  Total investment cost of the modifications

° CAD / CAE : Computer Aided Design — Computer Aided Engineering
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= Engineering budget

=  Safety

= Ergonomics

= Expected shut down time of the unit during modifications

= Minimization of production disturbances before the shutdown

As already stated, older process units rarely have “as built” documentation which means that
neither accurate documents or nor drawings, either 2D or 3D, are available at the start of a
revamp project. The only available information is the physical unit itself!

In this kind of projects, the first priority is NOT to create “as built” 3D models, but rather to get
the rejuvenated unit started up ASAP with all implemented modifications, simply because
every production down time can prove to be very costly to the customer.

But why not use a more conventional approach, where a 3D model is created and imported
into a CAD design tools as can be seen in Figure 1487

Laserscanner

Figure 148: From laser scanning to 3D modelling - © Leica Geosystems

Experience shows that the 3D modelling effort starting from point clouds will take
approximately 8 to 10 times the time spent in laser scanning in the field. In other words,
each day of scanning will generate 8 to 10 days of modelling!

This means that the effort needed for creating a 3D model from point clouds is not realistic in
relation to the engineering duration and budget. Moreover, the conversion into a 3D model
will degrade the data quality and suppress important technical details such as: electrical
cables, valve handles etc.

It is therefore important to define the most appropriate workflow starting from point clouds as
it is illustrated in Figure 149:
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Figure 149: Preferred workflow starting from point clouds - © BnS engineering N.V.

The above selected approach requires the following steps:

Selection of a laser scanner'® having the following technical characteristics: fast, mid-
range, mobile, 360 degree scan angle.

Plant coordinate system to be captured with conventional surveying applications (total
stations and GPS).

Precise measurements of reference targets integrated in the plant coordinate system.
Consolidation of all scans'' through the “overlap” function tool.

Consolidated scans brought into the plant coordinates system.

Importing IMP-file into Autocad running the add-ons AutoPLANT and Cloudworx.
Modelling only the tie-in"® points with Cloudworx.

In the case of “hybrid” design reviews'® point clouds together with the new CAD

design are imported 3D review software such as “Navisworks” (see
www.navisworks.com).

Optionally, 3D CAD modelling of the existing unit can be done after the unit starts up.

This workflow provides all the benefits needed for this specific project: engineering based on
point clouds without the need to generate any 3D “as built”.

"% For example: Leica HDS 6000 phase based, maximum range of 79 meters, scanning rate 500.000 points/s, average
measurement tolerance: 6 mm.
" Scan: each measurement by a laser scanning at a specific static position is referred to as a scan station that generates a

scan

"2 IMP: Cyclone file extension
' Tie-in: junction point between two objects (e.g. a pipe and a heat exchanger)
" Hybrid design reviews: combination of existing 3D CAD design with point clouds and newly engineered 3D designs
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6.4. Laser scanning project plan

6.4.1. Problem statement

Due to the dimensional constraints of a ship, a FPSO is by definition a highly congested
industrial environment (see Figure 150):

Figure 150: FPSO at sea

In this specific situation, the following aspects were to be dealt with:

=  Environmental conditions:

= The laser scanner has operational temperature limitations, and cannot be used
effectively in rainy conditions, or steamy environments.

= Portability

= Deformations:

= Static: caused by loading and offloading of the FPSO
= Dynamic: caused by waves

= Vibrations:

= The FPSO was in operation: living plant

= Congested areas:

= Bad visibility

= Numerous scan stations needed:

= Some creativity was needed to position the scanner at the most appropriate positions
(see Figure 151)

= |tis not always possible to position all targets in the most suitable positions
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Figure 151: Creative positioning of the laser scanner - © GlobeZenit

6.4.2. Goals and objectives (purpose)

The client’'s expectations and plans for using the data will significantly impact the project
approach. Therefore it is essential to have a clear understanding of the client’s goals and
objectives prior to proceeding with the project. Some questions to consider are:

= What are the reasons that this project is being done?

= What are the objectives pursued by the customer? What is the client’s aim or goal?

Is the client looking for complete as-built documentation?
= Does the client need only critical tie-in points, and a shell model?

= Are 2D plans and elevations required?

What will be the use? Engineering? Virtual reality or visual simulation? (In the latter
case the accuracy requirements will be lower)

In this case study specifically, the customer wanted to determine the available space in order
to:

»= Analyse if and where new modules will fit the space.
= Plan new routings.
= Define where new reinforcements of steel structures can be placed.

The 3D laser scans will also be used to:
= Check if the existing PDS-model of the FPSO matches with the as-built
measurements.

= Adjust the model to the as-built situation when the divergence between both are
greater than 50 mm.

These objectives have to be realised for:

» Piping: diameter of 15 mm and above.

= Flange: thickness of 10 mm and above.
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= Steelwork.

6.4.3. Define the deliverables

The project must “begin with the end in mind” in order to identify the key information and data
that will need to be collected, modelled and ultimately transmitted to the client. It is therefore
important to first establish a clear definition of the final deliverables, and their formats (ASCII,
binary), file types, etc. Indeed the final output could include some of the following elements:

= Point clouds.

= Full 3D model.

* AutoCAD (2D or 3D).

= MicroStation (2D or 3D).

= PDMS.

= PDS.

= Printed 2D Engineering Drawings (plot plans and elevations).
= Printed Isometrics or Spool drawings.

In most cases, clients have their own standard design platforms, so they will specify either
AutoCAD or MicroStation or other CAD environments. However, in some cases, a customer
might not have a clear idea of what the best format for the deliverable could be. Then, it is
important to understand how the client plans to use the deliverables or what the purpose of
the project is, in order to define the most appropriate solution.

In this case study, since the client already had an existing PDS model of the area, the
required laser scan deliverables could be easily defined:

= Registered IMP file format, to be used by a project engineer, in AutoCAD and the add-
on Cloudworx.

6.4.4. Risk factors
The following risks had to be taken into account:
= (Petro)chemical environment induces risks due to products that are flammable, toxic

= Offshore environment (extra safety training needed).

» As the 3D laser scanner is not ex-proof'®, a constant gas monitoring with a LEL
(Lower Explosive Limit) detector was compulsory.

6.4.5. Site documentation

A key part of the planning consists in the gathering of essential documents needed to fully
assess the project. These documents include: photographs, site plans, description of

'S Ex-proof : Isolation level of an equipment guaranteeing a low level of ignition hence a low risk in an explosion prone
environment
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equipments to be scanned, local safety procedures, working regulations and other
appropriate drawings.

In this project, we used an extract of the clients PDS model was used to determine the
different areas that had to be scanned and the order of priority.

Figure 152 illustrates by means of a bloc diagram those elements and the priorities (colour
codes):

Figure 152: Bloc diagram of the FPSO - © GlobeZenit N.V.

6.4.6. Choice of scanner
The choice of the most appropriate scanner depends upon the following requirements:
= General dimensions of the object(s)

= Environment (Temperature, humidity...)
= Resolution

= Accuracy

* Rapidity

6.4.7. Training people

It is obvious, that every member of the on-site survey team is well trained. Besides having
good knowledge of traditional survey techniques, they must be expert in operating the laser
scanner.

In this project,

= All people, performing the on-site laser scanning survey, were trained in operating the
laser scanner. The actual training course was a well organized hands-on training, at
company office.

Remarks
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= Today, some software packages include a module to train people before they actual

go on-site. In Cyclone' for instance, there is a module called “simulated scanner”.
This tool allows a user to execute a virtual scan of a 3D CAD model.

= |t will be further assumed that the reader has some training thanks to this feature and
that he has reviewed the available tutorials.

6.4.8. Site preparation

Once on site a few elements need to be identified and clarified.

6.4.8.1. Hazards

Hazards include the probability for accidents related to chemical or other processes within
the specific manufacturing facility. This is why each facility has its own local requirements
and procedures to be applied while working at their location. Such requirements may include
safety training courses, special protective equipment, dedicated safety watches, etc.

Other hazards may include mobile pieces of equipment or “work in progress” which may be
moving through the facility.

In this project,

= Special safety courses organised by the clients were followed both on-shore and off-
shore
» [ndividual protection and safety:
o Safety clothing, safety shoes, safety glasses, ...

= Additional safety material:

o H2S metering, life jacket, ...

6.4.8.2. Power supply issues

As most laser scanner works on battery packs, there is a need to know the battery autonomy
and thus define the number of needed battery packs in order to keep scanning.

For long duration projects a ‘loading station’ to re-charge the battery packs should be
arranged. But, make sure not to charge the battery packs in an Ex-zone'. Keep also in mind
the available power (110, 230 VAC) and the country specific plug.

In this project,

= 230 VAC power supply, European connection, available throughout the facility, within
a distance of 50 m around all scanning positions.

6.4.8.3. Work schedule restrictions

Make sure that the allowable scanning times are clearly spelled out. Some facilities may only
allow scanning during night shifts or weekends. Other projects (e.g. highways) may only
allow scanning during the middle of the day, in order to minimize impact on traffic.

In this project,

1 Cyclone: Leica software allowing to convert point clouds into solid CAD models
' Ex-zone: clearly identified explosion prone zone where all electrical equipment are designed so that they never act as an
ignition source (electrical arcs are confined)
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= No restrictions on scanning time.

6.4.8.4. Field documentation notes

Field notes are a critical success factor and without them, project failure is imminent. Clear,
concise notes are essential to a rapid resolution of registration or modelling problems.

The following is a quick summary of items to consider in field notes:

= Sketch of scanner locations (record scan number/name as well).

= Sketch of target locations and names.

= Several measured dimensions to aid in accuracy verification.

= Temperature and general weather conditions (record this for each scan).
= Time, date and name of person doing the scanning and taking notes.

= When using traditional survey techniques in order to incorporate the data in a client
local coordinate system, it may be best to note the location of the total station also.

In this project,

= Several document templates were at the disposal of the survey team.

6.4.8.5. Site Training

In general, working access to petrochemical sites requires a specific training on safety
issues. This training lasts usually a couple of hours.

In this case, additional sea survival training was also required due to the specific
environment.

6.4.8.6. Static and dynamic deformations on a ship

Because the ship (FPSO) is a constant moving and deforming platform, we used a Sokkia
Monmos Total Station was used.

Furthermore, the maximum scan distance was limited to 40 meters.

Each scan zone was defined by a local coordinate system. The choice and use of the Total
Station (Monmos), will not be discussed in this case study. It was however a must in order to
obtain the required precision: the overall accuracy was less then 20 mm, which in the case of
this challenging project, was a real success.

6.4.9. Laser scanning operations

Once the above items are clearly defined, the actual on-site laser scan data acquisition
phase begins.
The overall productivity of the scanning job is influenced by several factors:

= The size of the scanning team (in this case 2 land surveyors and several local
helpers)

= The number of setups and the amount of equipment that needs to be carried from
one setup to another.

= The portability of each piece of equipment. Wheeled devices have also proven to be
convenient and help avoiding booting up the scanner at each setup.
151



The number and the type of targets.

There are many types of scan targets, including bipod twin-target poles; magnetic
mount; tripod-mounted planar; spherical or hemispherical; adhesive-backed, stick-on
and paper tape-on.

Those scan targets will be used for accurate registration of scans taken from multiple
scanner positions and for geo-referencing scans to appropriate coordinate systems.

In general, the farther away that a target can be placed from the scanner, such that a
user can still extract its centre with high accuracy, the better.

Targets are usually scanned at very high density (e.g. 1.2 mm to 2 mm point-to-point
spacing) in order to be able to very accurately extract the target’s centre coordinates
for accurate registration and geo-referencing.

The surveying time of the targets. Often, scan targets are surveyed conventionally
with a total station.

The programming of the scanner. Programming consists of instructing the scanner
via the controller as to the field of view and the density. By automatically re-using the
same parameters at each setup, programming time is minimised.

Scanning time. Scanning is an automatic process that can last from several minutes
to more than an hour. For long scans, it is advised that the team performs
simultaneously other productive tasks.

Quality assurance. It is important to determine if the scanners or targets were
inadvertently moved during the scan. Another high efficient tool is to import survey
points (collected via traditional survey means) into the scan data.

6.5. Simulated scanning

6.5.1. What is simulated scanning?

Simulated scanning is having the controls of an actual scanner but with the scanning process
taking place within a virtual environment. For this project we will use the simulated scanner
from cyclone software. Within this tutorial a cyclone database is provided with a 3D model of
an actual petrochemical installation.

6.5.2. Preparation of the scanning assignment

For this scanning assignment the following is given:

Scanner : Leica Geosystems HDS 2500

Field of view 40*40°
16 minutes for 1000*1000 points scan

Target : 25 Spherical targets

Model : 3D model of a petrochemical installation. Approximate dimensions Length
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Add the “SimulatedScanningScene.imp” database to Cyclone so you are able to view the
model [see paragraph 5.5 for details]. Familiarize yourself with the petrochemical installation.
You should be able to detect the spherical targets and recognize that the scanning
assignment will be inside as well as outside.

Figure 153 shows a sketch of the virtual scanning environment. In general it is important to
create such a sketch for the sake of planning (target and scanner locations) and
understandability during the registration process [see paragraph 5.3.3].

o

(¥

-
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Figure 153: Sketch of the Virtual Scanning Environment

In the database you will find a modelspace labelled "SimulatedScanning Scene" which
contains a small plant model and a multitude of spherical targets (Figure 154).
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Figure 154: Cyclone Navigator showing the Simulated Scan ModelSpace

To Do: Open the SimulatedScanning Scene View 1. Move around through the scene to get familiar with the model
and the positions of the targets. In a real scanning project, this would be the reconnaissance walk through the
scanning area and the identification of useful target locations.

Note: inside the building, there are some items of interest that need to be scanned too.
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Figure 155: View of the Simulated Scanner ModelSpace

6.5.2.1. Setting up a Simulated Scanner

Before setting up the scanner, we need to define an optimal scanner position. As already
mentioned in paragraph 3.1.3, it is important to find a position that has an optimal coverage
and as few obstructions causing shadows as possible.
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To Do: Turn, pan and zoom in the ModelSpace until you think you are in an optimal scanning position. Bear in
mind that in reality the scanner needs to be put on the ground or on a stable platform.

Tip: Make sure a lot of the targets are visible and a large part of the scene is covered.

Now we will start the scanning phase. Create a Simulated Scanner by choosing Tools >
Scanner > Create Simulated Scanner (Figure 156).
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Open a Scan Contral viewer to operate a simulated scanner within this ModelSpace

Figure 156: Creating a simulated scanner

In the upcoming dialog, select the “5.8 SimulatedScanningScene.imp” database and press
Create. In the database, a folder is created where the simulated scans will be saved. Name
the folder "Simulated Scans" and press OK (Figure 157).
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Figure 157: Simulated Scanner Dialog Box

The Simulated Scanner Screen appears. Connect your computer to the simulated scanner

by choosing Scanner > Connect. At the bottom of the window, the scanner status bar will
show when the connection is ready.
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Figure 158: Simulated Scanner Control Window

To know what the scanner will scan, we first create a picture using the build in camera.
Choose Scanner Control > Get Image.

The Simulated Scanner Window will display the area that may be covered in the scan, using
your current position and orientation. Check if all desired targets are visible.
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Figure 159: Simulated Scanner image acquirement

If the view does not correspond to the view you wanted or if not all desired targets are visible,
do not close the simulated scanner, but reposition in the original Modelspace and update
your position using Tools>Scanner>Update Simulated Scanner Position.

6.5.2.2. Setting up scanning parameters

Once satisfied, you'll need to define the scanning resolution. Since the resolution of scanner
determines the angle step change of the scanner and not a fixed distance, it is a function of
the distance to the scanner. Therefore the resolution is defined according to a certain
distance to the scanner. To define the resolution in Cyclone, we use the "probe" function. By
probing we measure the distance between an object and the scanner. Based on this distance
and the chosen sample spacing, the angle step is computed, defining the resolution of the
scan.

Note: In practice one should probe a distant object, defining the resolution at this distance.
All objects that are closer to the scanner will be scanned with a higher resolution. Sometimes
it may be preferable to focus on objects of interest, and thus reducing the required Number of
Points in your scan. This makes scanning less time-consuming.

To probe, left click the mouse pointer on an object of interest that lies far from the scanner. A
cross-hair appears where you clicked. Choose Scanner Control > Probe or use the Probe
button on the right to measure the distance to this point. The distance is shown in the
"Scene Range" field (Figure 160).
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Figure 160: Probing to determine the scanning resolution

Now change the Sample Spacing, displayed on the right hand side of the screen. When
changing the sample spacing, the number of points changes accordingly. Alternatively,
you may define the Scene Range and Sample Spacing yourself without probing or even
just fill in the Number of Points without bothering about the Scene Range or Sample
Spacing. However, these alternatives do not provide as much feeling with the scene scale
and resulting scanning detail. For this case we choose a Sampling Spacing of 20mmx20mm
at a distance of 27.093m, giving a total of 945 by 945 points.

Note: Evidently, defining a Scene Range doesn't mean that the scanner doesn't scan
anything beyond that distance.

Note: The simulated scanner is based on one of the first laser scanner models of Leica (the
HDS2500). This scanner only allowed scanning 1000 points horizontally and 1000 points
vertically.

6.5.2.3. Scanning

When all parameters have been set, select the area in the Simulated Scanner Screen that

i

you want to scan. You can do this using the Rectangle Fence tool , the Polygonal
52

Fence tool ";l, or by choosing Scanner Control > Target All *%l. The total scan time is
estimated and shown in the dialog at the bottom right.

Next click the Scan button. During the scanning, the scanning process can be monitored by
clicking Open Viewer. This will open a new modelspace in which the scanning acquisition
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can be seen in real time. While scanning, you can rotate, zoom or pan in the new
modelspace.
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Figure 161: Real time viewing of the scanning process
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Figure 162: The final scan

For now, close the newly created modelspace and go back to the Simulated Scanner Control
window.

6.5.2.4. Target scanning

For registration purposes, the spherical targets must be "fine scanned". Use the Rectangle
Fence Tool in the Simulated Scanner Screen to manually select one spherical target (Figure
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163). Change the scanner Sample Spacing to 1x1 mm or 2x2 mm, depending on its distance
(use probe) to the scanner and press Scan. Notice that within the current Scanworld a new
scan is added. A Scanworld may contain multiple scans, all made from the same scanner
position.
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Figure 163: Selecting a spherical target for fine scanning

Figure 164: Fine scanning a target (the red points are part of the coarse scan, green points come from the fine
scanning)

| To Do: Repeat this procedure for all remaining spherical targets in this scanner setup.

6.5.2.5. Moving to new scanning position

Close the new modelspace window. Switch to the SimulatedScanning Scene View 1
ModelSpace and change the viewpoint to the next desired scan position. Inform your
Simulated Scanner about your new position by choosing Tools > Scanner > Update
Simulated Scanner Position (Figure 165).

Switch back to the Simulated Scanner Screen and choose Scanner Control > Get Image.
Check if all needed spherical targets are visible. If so, press New Position. A new scanworld

160



is being created and the scan counter is reset. You may need to repeat the Get Image
command.
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Figure 165: Updating to a new scanner position

From this point on, the scanning procedure is no different from the previously described
procedure (Steps 6.5.2.2, 6.5.2.3 & 6.5.2.4). You may decide to use the same settings as in
scan 1, thus skipping the probing procedure.

6.5.2.6. Preparing scans for registration
In the Cyclone Navigator, you will know find your new Simulated Scans. For the registration,
based on the spherical targets, you need to label all scanned targets found in every scan.

First of all, make sure that all targets listed in your sketch have a unique name or number.
This helps identifying them in the separate scans.

In the Navigator window, open the "ScanConfrol: ModelSpace [ScanWorld 1] View 1"

from Scanworld 1. This Modelspace View shows all scans made at scan position 1, including
the target fine-scans (Figure 166).
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Figure 166: Checking out the simulated scans in the Cyclone Navigator

In this ModelSpace, locate a spherical target, zoom in and select its point cloud by left
clicking a point on the target. The selected point cloud gets highlighted while other point
clouds will be dimmed. Then choose Create Object > Fit to Cloud > Sphere Target (Figure
167).
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Figure 167: Fitting a spherical target to the point cloud

A new window pops up, letting you identify the target. Here your sketch is of great value.
Enter an ID for the target (i.e. targef#2) and click the OK button (Figure 168).
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Figure 168: Target Identification dialog

A sphere is fitted to the point cloud. Choose Tools > Annotations > Show Annotations to
display target labels (Figure 169).
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Figure 169: A labelled target

| To Do: Repeat these steps for all spherical targets that you can find in each scan.

The step required to perform the registration are explained in paragraph 5.6. A registered
point cloud of this scene should look approximately as shown in Figure 170.
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Figure 170: Registered point cloud

6.5.3. Simulated Scanner Assignment

To Do: Virtually scan this whole petrochemical installation and register the scans. The end result will have to look
like the screenshot above.

- Draw a sketch of the petrochemical installation. Specific details and target locations should be well defined.
- Plan the scan locations and optimal target use based on the sketch and view of the model.
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- Virtual scan the petrochemical installation.
- Do a target based registration of the petrochemical installation.

It is important to have special divided targets in every scan.

6.5.4. Data processing

6.5.4.1. Registration, choosing registration method

Registration is the process of aligning various individual scans (scan station locations) into a
single coordinate system. This registration or alignment is created by establishing a system
of constraints, whereby certain objects, geometric features, or clouds that appear in the
same position in two or more scan station locations are fitted together, in order to establish
an accurate relationship between each of the scan station locations.

GlobeZenit NV has the company policy to always use targets for the following reasons:

=  GlobeZenit NV being a land survey company considers the laser scanner as another
topographic device, but with specific advantages. Therefore their approach to
measurements remains the same whether they carry out the survey with total stations
or with laser scanner.

= The quality, accuracy of the final project is much more under control by using target ID
registration, because multiple error checking can be performed in order to verify the
accuracy. A typical registration, done by GlobeZenit, has a Mean Absolute Error of
less than 3 mm.

6.5.4.2. Registration using overlap

Some companies use the registration using overlap (also called cloud-to-cloud registration).
It basically aligns overlapping scans with each other. This technique can be demonstrated
by the use of captured data from the simulation scanner

For additional information: see § 3.5.1.2. Cloud-to cloud registration and § 3.5.1.3. Surface-to
surface registration

6.5.4.3. Registration using targets

In this case study, however, target registration was used to combine the multiple scan station
locations.

The imported point cloud data will be used to demonstrate the registration process using
targets.

For additional information: see § 3.5.1.1. Target-to-target registration.

6.5.5. Creating point cloud animations

As an additional output format, an animated flythrough was produced to provide a powerful
presentation tool, for project team members having not visited the FPSO vessel.
In this project, Cyclone was used to generate the animation.

6.5.6. Laser scan project — deliverables

The deliverables to the engineering department included an IMP Cyclone database, along
with an animation.
In Figure 171, one can see images of the registered and processed point cloud.
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Figure 171: Left: equipment — right: scan (point cloud) of the same equipment - © GlobeZenit N.V.

Further steps could be isometrics or even a solid CAD representation as shown in Figure
172.

Figure 172: Left: centreline isometric view — right: solid representation - © BnS engineering N.V.
6.6. Engineering project plan

6.6.1. Working with Cloudworx

Point clouds can be imported into AutoCAD or MicroStation in the same way as they can be
imported into Cyclone, trough the IMP'® format (See § 5.7.1. Direct 2D modelling from point
clouds) (see Figure 173):

'8 IMP: extension for files that have been generated by Cyclone
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Figure 173: Loading point clouds into CAD software - © BnS engineering N.V.

Once the database is loaded the imported scan can be seen. But why not just import all
points in AutoCAD through e.g. dxf?

The answer is that AutoCAD just can’'t handle millions of points without the Cloudworx
application that visualises the points in a more intelligent way than AutoCAD. Cloudworx
provides some additional (main) functionality:

= Snap to points.
= Measurements between pipes.
= Clippings and slices on point clouds.
= Recognition of pipes and other shapes, and model them.
In the following example (see Figure 174), the desire is to add a bypass between 2 existing

pipes. Cloudworx is used to recognise the piping centrelines and to exactly locate the
needed tie-in points.

167



[El6untier putobLan ISEIET

=]

DEE &R % yYXax RER BA| & iy FE@E T P =i F
s |vawmO =4 o = — TE

BASEFEE ¢ v bt | FE0cT4+OER - T07 7 &

r

s

o Ciuie Elycn e
| Fick Pariza

o | lamwcie e——

=i [F] Cariom Furnsm

ey [#] Fadraka

@ bezsavurn FedG Enci

3 RN e

L= g,

el -

il

&

H

Ly

A

% -
WAy WY L_:q,lcﬂ,(.e,.n:l.lE?
Ciok cloul Zountis sncole -
Coramsnd Lo
| < »
ST AME, BT S UL SR LHU| LS IHU| LUK [D5HAF | TTAAGS L] [aDEL -

Figure 174: 3D modeling based on point cloud - © BnS engineering N.V.

Now that we have the exact centreline of the existing pipes available, the pieces of pipe can
be traced over with the Plant design application, AutoPLANT. Once done, the new bypass
can be drawn in AutoPLANT (see Figure 175 and Figure 176) based on a specific Pipe
Specification that copes with the product, its internal pressure and temperature.
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Figure 175: 3D design of an extension within a point cloud - © BnS engineering N.V.
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Figure 176: Solid representation of the designed extension - © BnS engineering N.V.

Now that the design work of the bypass with a block valve is done, it is possible to
automatically generate shop-prefabrication documents, so called “Isometrics” (see Figure
177). This Isometric includes all dimensional information included, and the needed material
list (see Figure 178). This means that the complete new pipe will be constructed and pre-
assembled in a construction shop. On site, the only welding activities that will be done are on
the tie-in points from the existing pipes.

DB T2 g Lhaze

Figure 177: Construction drawing (isometrics19) of the designed extension - © BnS engineering N.V.

' Isometric: instruction drawing for piping manufacturing and assembly
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Figure 178: Bill of materials of the designed extension - © BnS engineering N.V.

Important remark: when working with tie-in points that are modelled with Cloudworx (or
Cyclone):

In the real world, within acceptable tolerances, pipes are not installed perfectly
parallel.

So when working with as built data generated out of Cloudworx or Cyclone, it can be
difficult to get understandable drawings that are reflecting small (irrelevant)
misalignments.

Therefore, tie-in points need to be redrawn in AutoPLANT in such a way that they are
following the theoretical main design axes.

Otherwise strange results can occur on the tie-in locations when new isometrics are
generated.

Attention should therefore be given to taking the right workflows in order to make sure
that the deliverables are matching the specified needs.

As an example the following shows the difference between two isometric drawings:
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Existing pipe drawn in exact “as is” inclination (se Figure 179):



Figure 179: Existing pipe in exact “as-is” inclination - © BnS engineering N.V.

”

= Existing pipe drawn in “cleaned up” “as built” inclination (see Figure 180):

- LEN

| | gl =P

Figure 180: Existing pipe drawn in “cleaned up” “as built” inclination - © BnS engineering N.V.
As second construction deliverable, a top view of the bypass is created.

This is a so called “Piping Layout” (see Figure 181), used as an installation instruction
drawing on site.
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Figure 181: Preparation of piping layout - © BnS engineering N.V.

6.6.2. Hybrid 3D Reviews (see Figure 182)

One of the biggest advantages of using laser scanning within piping design is the capability
to monitor constantly the new CAD model in combination with the existing environment.

So with e.g. NavisWorks there is the possibility to read and merge 3D CAD data from many
disciplines together with the raw point cloud data. Additionally clash “detection” can be
utilised on this “3D Master Model”.

e

ID-MASTER
MODEL
gl MATERIAL ORDERS
COSTCONTROL

gl SCHEDULING

¥
PLOT PLAN
L
CABLE TRAY LAYOUT

Figure 182: Hybrid 3D design workflow - © BnS engineering N.V.
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Figure 183 illustrates an hybrid visualisation using Navisworks:

Figure 183: Hybrid 3D review using Navisworks - © BnS engineering N.V.

6.6.3. Clash detection

Clash detection is a software module used within 3D engineering of process units.

This software mostly runs on top of 3D Review software such as Navisworks©, or Smartplant
Reviewer. It is used to automatically detect and report clashes between piping, steel
structures, concrete, cable trays, etc.

It must be realised that these “virtual’” clashes are unavoidable during design because
several designers from different departments are working simultaneously in the same virtual
3D area.

Thanks to the availability of the laser scanner and it 3D functions, it becomes possible to run
a check integrating the existing “as-is” situation and the new design.

However, this kind of quality controls needs to be done with a lot of care.

Why? A laser scan of a process unit will NEVER be complete! This means that the automatic
clash reporting cannot guarantee with 100% a clash free construction.

Therefore, always perform this quality control manually through a visual walkthrough in the
review software.

6.6.3.1. Simulations

More and more, simulations are done with the additional use of Point clouds.

Some examples:
» For a drilling platform, there is the need to have an as built 3D model, to be imported
in software in order to simulate the impact of a potential explosion.
= For training on personnel evacuations, point clouds are used to walk trough the actual
unit.
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6.6.4. As built

Sometimes, depending on the project schedule and budget it can be ideal to convert the

point cloud into a complete 3D model.

Some advantages:

Much easier to implement 3D CAD files in the Plant documentation system.

All components can be tagged and queried on several levels (e.g. valuable for
maintenance personnel).

All data can be structured and maintained in one CAD system.

Complete piping layouts and isometrics can be modified easily.

CAD models are still easier to distribute amongst all team members.

Figure 184 shows a piping layout, generated out of Cyclone 3D objects:
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Figure 184: Piping layout drawing including the new extension - © BnS engineering N.V.

6.6.5. Use of laser scanning when needed

A lot of plant owners are very interested in a complete documented “as built” archive.
This is mainly caused by the growing safety regulations and the desire to minimise

engineering schedules.

The problem is that only a minority of plant owners succeeds in this “wishful thought” due to
the huge effort and costs related to the maintenance of a 3D “as-built” over the years.
Laser scanning can help plant owners on de-phasing “as built” work by starting with laser

scanning, and putting things in 3D only when needed.
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6.6.6. Quality Control

The following illustrates the case of quality control of equipment after constructions. In this
case, the design of a new distillation column was made by the engineering contractor, while
its construction was executed by the construction contractor. As this equipment had to be
installed in a production unit in a very tight timeframe, it was extremely important to do a
detailed quality control in the production shop, before the equipment arrived on site. Laser
scanning was the most appropriate solution. The point cloud data was projected over the 3D
CAD model, and some construction errors were detected, e.g. the position of some bolt holes
are misaligned (see Figure 188). In this way, it was possible to anticipate problems, that
otherwise would only have been detected at the site. The result would have been a dramatic
delay during the installation of the unit.

The following workflow was used:

Stepl: Scan positions (Figure 185)
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Figure 185: Equipment to be surveyed - © BnS engineering N.V.

Step 2: Scanning from several positions (Figure 186)

hl\ "

Figure 186: Point cloud from one position - © BnS engineering N.V.
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Step 3: Consolidation of all scans (Figure 187)

Figure 187: Consolidation of 4 scans into one point cloud- © BnS engineering N.V.

Step 4: Importing point clouds within CAD & review tools (Figure 188)

Quality control

Figure 188: Quality control based on the point cloud - © BnS engineering N.V.
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7. Civil Infrastructure case study: deformation monitoring

of a hydroelectric dam

7.1. Introduction

Hydroelectric Power Plants are constructions which utilize the potential energy of dammed
water to drive a water turbine coupled to a generator to produce electricity. It is possible to
distinguish between “run-of-river power plant” and “storage power plant” (Figure 189 and

Figure 190).

Hydroelectric Dam

Long Distance
Power Lines

Figure 189: Run of river power plant (Schematic)
Source: http://www.tva.com/
power/Figures/hydro.gif

Income from

Rivers, Glaciers...

== Higher Reservoir
Arch Dam

: H=100-200m

Penstock

| (difference in the
\| height of several
| hundrets of

. Lower Reservoir

Power Building:
Turbine + Generator (+Pump)

Figure 190: Pumped storage plant (Schematic)
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The first type (Figure 189) works
continuously. It could be situated in big,
slow flowing rivers, usually with a small
difference in height (small potential energy)
and a high water flow.

The second type (Figure 190) will be
activated only in periods of peak
consumption of electric power. It consist of
a reservoir on a high level (e.g. situated in
the mountains) and of a power building with
a turbine and a generator on a much lower
level (e.g. in the valley). These are
connected using a pipe with a diameter of
several meters covering a height difference
of several hundred meters (penstock). The
water has a high potential energy. The
water volume is lower compared to the first
type. Most of them are situated in the
mountains, e.g. in the Alps.

A special kind of storage power plant is the
so-called pumped-storage plants. These
power plants possess a second reservoir at
lower level and a reversible turbine that is
able to pump the water back to the higher
reservoir on top of the mountain.

During the night the demand on electricity
is low and therefore the market price of
electricity is low. With this type of power
plant it is possible to store the
overproduction-energy  (electricity) from
other, not controllable, power plants like
nuclear-, coal-burning-, and river power
plants during the night by pumping back the
water to the upper reservoir.



Figure 194: Different load (orange) and deformation
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(red) resulting from the different filling level

Storage and pumping power plants need
reservoirs. These reservoirs are created by
one or several dams that are used as a barrier
across flowing water to obstruct the flow. They
can be made of stones, earth and clay, so
called embankment dams, or they are made of
masonry. Masonry dams are of either the
gravity or the arch type.

An arch dam is a thin, curved concrete or
masonry dam structure, which is curved
upstream so that the force of the water
compresses and therefore strengthens the
structure pushing it into the ground. An arch
dam is most likely used in a narrow site in a
mountainous area with steep walls of sound
rock [Wikipedia, 2007]. Arch dams can reach
heights to several hundred meters and they
partially have an elastic behaviour in case of
external variable loads.

The highest dam in Austria is the
Kdlnbreintalsperre with a height of 200m and a
length of 626m, the highest realized dam in the
world is the Nurek dam which measures 300m;
under construction since the 1960's is the
Rogun Dam with 335m (both Tajikistan).

The filling level (Figure 193) of a reservoir is
not constant but fluctuating, whereas the
fluctuation in the filling level can be divided in
short frequent and large frequent changes.
The short frequent fluctuation with a period of
one day is an example of a small amount,
whereas the large frequent one appears
seasonal and is of much higher amount due to
the higher demand on electricity in the colder
season as well as to missing water feeding
during the winter or dry periods.

Because of this variation of the filling level, the
pressure on the dam’s surface differs and
causes different loads on the dam body
(Figure 194).

This leads to an elastic deformation of the arch
dam structure with a change in shape. Plastic
deformation may occur only in the first years
after the completion of a dam because of
structural settlement and soil consolidation of
the ambient bedrock.



7.2. Objectives

7.2.1. Problem statement

The deformation of hydroelectric dams will be monitored periodically due to the enormous
risk for human life in the case of a dam failure. Typically the monitoring is done by surveying
the movement of single points on the dam’s surface (e.g. on the crest of the dam) or by
measuring traverses along surveying gangways that are located at different levels inside the
dam. Furthermore, the dams may be equipped with traditional sensors like strain gauges and
perpendicular measuring systems to permanently observe the relative horizontal dislocation
of the crest (inclinometers). Current measurements made by the dam operating company
identify movements of the crest within several centimetres over a time span of one year.

The purpose in applying terrestrial laser scanning (TLS) for monitoring the dam movements
is to measure the deformation on the surface of the dam not only in a few single points but in
a dense raster with point information every few centimetres. Out of this point cloud a dense
and accurate surface model can be generated which describes the actual surface. A
comparison of two or more of such surface models from different dates is able to show the
deformation of the entire surface. The results contain further relevant information, for
instance if the deformation is homogenous over the dam or if there is a local buckling.
Furthermore it can highlight zones with higher risk for deformations, which afterwards may be
surveyed more frequently with other equipment, like motorized total stations with automatic
target recognition (TPS).

The advantages of determining the deformation of dam structures by comparing surfaces
obtained from TLS point clouds are shown by various [31-33] It was shown by Rudig [34] that
the application of NURBS algorithms for the surface representation offers the possibility to
assess deformations of a dam surface of only 3mm. In this case study the distance between
scanner and object was about 60 m and the accuracy of the measured single points was +6
mm.

7.2.2. Goals

The arc dam of the Kops reservoir in the Austrian Alps was measured twice at different times
with the aim to deliver a complete dataset for the hands-on training of this European
Leonardo da Vinci Project.

Thus, these two real world data sets offer the possibility:

= To illustrate the entire laser scanning process of session planning, scanning and post
processing in a detailed and complete way.

= To carry out a risk assessment by comparing the deformed dam surfaces of two
different reservoir filling levels.

This case study should allow for a better understanding and the planning of terrestrial laser
scanning set ups for effective measurements. In particular, the surface of a dam is going to
be analysed for deformation assessment. The case study is focusing on:

= Best assembly: To define the best mounting of the scanner device: horizontal,
vertical or tilted.

= Definition of the optimal distance between object (dam) and scanner: To define
the optimal scanning distances from different scan station positions taking into
account both homogeneous accuracy and rough topography.
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= Determination of the minimum angle between surface and laser beam: To
calculate the minimum angle between laser beam and surface which allows for
maximum accuracy.

= Optimize the target type: To define optimal target objects for different scanning
distances.

Additionally, this case study will allow us to calculate the amount of deformation after two
periods. The purpose of the present investigation is to study whether the deformation is
homogenous or heterogeneous, containing local buckling zones of higher risks.

7.2.3. Deliverables
Outcomes of this case study should be:

= Two digital terrain models (DTMs) representing the dam’s surface at two different
reservoir filling levels.

= Differential model of these DTMs describing the deformation (displacement vectors
in a dense grid).

7.2.4. Risk factors
= Object related:

Dam failure due to an exceeding deformation may result in:

o Danger to life for the power plant staff and the inhabitants of the valley.
o Danger to fauna and flora in the neighbourhood areas.
0 Loss of production of electric power for several years.

= Project related:

o The rough terrain and bad weather conditions may contribute to bad working
conditions, including the risk of falling from a cliff.

o Deformation of the dam may
not be detected due to the
insufficient accuracy of the
surveying method (scanner
system, scan constellation,
data processing, etc.).

7.2.5. Site documentation

The dam of this case study is situated in
Western Austria, in the province Vorarlberg
(VBG). The name of the lake is “Kops-Lake”
(Figure 195). It is situated at an altitude of
1800 m above mean sea level (MSL) and the
dam has a length of 400 m and a height of
100 m.

180 Figure 195: Kops Lake with dam, view from SW



7.3. Methodology

7.3.1. Session planning

The measurement campaigns were carried out mid April 2007 (reservoir with low filling level)
and mid September 2007 (reservoir almost at maximum filling level). At the time of the first
measurement the reservoir was filled to one third. An earlier date with a lower filling level
would have been better to detect the total amount of deformation, but strong snowfall and
avalanche risk in spring 2007 impeded work at the site.

A detailed session planning is mandatory taking into account the maximum range and the
field of view angle of the scanner used. Furthermore, the characteristic of the scanned object
(400 m long x 100 m high) and its surrounding terrain (rough mountainous topography)
should be simulated in advance because of their influence on the surveying job.

To describe the deformation of the dam it is necessary to obtain at least two recordings: one
during the winter/spring season (in this case April) before the snowmelt starts and when the
storage lake is empty and a second one at the end of summer when the storage lake is filled
to its maximum.

During the spring session the terrain is already partially covered by ice and snow.
Furthermore, the terrain is rocky and the area to the left and right side of the dam is steep
(Figure 196 and Figure 197). Additionally, the tree population is mostly composed of conifers
(height up to 40 m), willow trees (height up to 3.0 m) and mountain pine (height up to 2 m).

Figure 196: Left part of the dam, February 2007
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Figure 197: Middle and right part of the wall, February 2007,

As a result; the scanning positions have to be determined prior to the start of the fieldwork as
accurately as possible. In this respect, it is essential to take into account the following:

= scanner and object characteristics
= the topography
= the security and safety of the field personnel (see also paragraph 1.1 and 3.1).

7.3.1.1. Choice of scanner and software

A lot of different specialized scanner types are on the market today. The list in Appendix 8.3
gives a short sample of popular laser scanners fulfilling the requirements for this application
related to range and accuracy.

The mountainous and rough topography hinders the positioning of the scanner. Scanning
distances of more than 200 m on the one hand and steep angles of incidence of the
scanning beam on the other, - require a long-range scanner with accurate range and angle
measurements to fulfil the requirements of hydroelectric dam monitoring. Therefore, the
Trimble GX 3D terrestrial laser scanner was chosen for this project.

Depending on the purpose, data acquisition or data processing, Trimble provides different
software as follows:

= PointScape (for notebook) or PocketScape (for Pocket PC) for data acquisition

= RealWorks Survey for data processing,

The main features of PointScape and PocketScape are:
» |nitialization and calibration of the system in the field.

= Control of the integrated camera.

» Display of camera scans to allocate reference points/geometrical targets, and to
define the scan area directly on pictures made by the camera.

= Acquisition, control and storage of the surveying data.

The main features of RealWorks Survey are:
= Display of the point clouds.

» Analysis of spherical and flat targets.
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Management of reference points.

Geometry fitting.

Register and georeferencing point clouds via reference points and targets.
Meshing of point clouds.

Slicing of point clouds and meshes.

Measurements of distances and angles.

Mesh editing.

Creation of orthoimages.

7.3.1.2. Determine the optimal scanning positions

The

1
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optimization of the scan station positions can be carried out in three steps:
Determination of the minimum distance to the wall

Errors such as standard deviation and positional accuracy are minimized.

In case of scanning an object with a height of 100 m under a field-of-view of £30°—
(Figure 198), the Trimble GX 3D scanner requires a horizontal distance from the object
of:

Solution 1: =100 m/tan (30°) =173.20m=175m

However, it is possible to decrease this distance tilting the laser scanner some degrees
(e.g. 20°, Figure 199), yielding a closer distance to the object:

Solution 2: =100 m/tan (50°) =83.91 m=85m

To reduce the distance between scanner and dam even more it is necessary to use a
totally different mounting on the scanner. An orthogonal mounting bracket can be used
to turn the scanner for 90°. In this case the vertical scan direction becomes the
horizontal one and vice versa. So the resulting field of view of the scanner is 360°
vertical by 60° horizontal (Figure 200).

With this adjustment, it is possible to come closer to the object. To avoid the
appearance of low intersection (sharp) angles, we keep an angle of 30° between the
object’s surface and the laser beam:

Solution 3: I=100 m/tan (60°) = 57,73 m=60 m



Figure 199: After tilting 20° the vertical axis

Figure 200: Acquisition layout with an orthogonal bracket

2 Minimization of low intersection (sharp) angles

If the angle between the scanner beam and the surface of the object decreases, the
intensity of beam reflection also decreases. The point measurement fails or delivers
wrong values. Additionally, the accuracy of the position measurement decreases as far
as the beam angle is not perpendicular to the surface and the laser footprint is enlarged
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(Figure 201). To avoid this phenomenon the angle between surface and laser beam
must be at least greater than 10° [34].

a) b) c) d)

|-

Figure 201: Laser scanner footprint (schematic): a) perpendicular, b)decline in Y-Z of 30°, c)decline in
X-Z and Y-Z and of 30°, d)decline in Y-Z of 45°, e)decline in X-Z and Y-Z and of 45°

3 Reduction of scan station positions

A lower number of scan station positions eventually yields less field and post
processing work. Increasing the distance to the object, the scanning area is increased
and the required number of scan station positions decreases. However, the accuracy
worsens.

To take into account these variations, it is recommended to simulate before-hand different
scanning set-ups.

It is necessary to have at least a contour line map of the dam’s surrounding and a sketch of
the wall dimension to consider all the above-mentioned conditions when planning the
fieldwork, as well as the scan station positions. The best way to simulate the scanning
fieldwork is by modelling the situation in a generalised manner using a GIS or CAD system.

It is irrelevant whether the session planning is done manually using paper, pencil and ruler or
digitally. The important thing is that it is carried out.

7.3.1.3. Simulation on CAD

In this case study a DTM and a digital orthoimage is available (Figure 202). There are other
georeferenced available sources that may provide useful information.

The processed orthoimage has been acquired during a LiDAR project from an airborne laser
scanning with an elevation grid of 1m x 1m. With the altitude information, a DTM in
Autodesk® CIVIL 3D 2007™ was modelled. Due to the reduced quality of the data in the
LiDAR scan of the dam, it was necessary to model the dam by extruding the outline of the
dam crest (Figure 203 and Figure 204) and joining it afterwards with the DTM.
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(@) (b) (©
Figure 202: Orthoimage (a) and DTM (b,c) with wrong wall crest plotting

In a second step, a 60° x 360° field-of-view of the scanner with a 20° tilted vertical axis was
produced. Different colours show the 50 m, 100 m, 150 m and 200 m ranges. See Figure
205.

Figure 203: Outline Figure 204: 3D model of the dam Figure 205: 60° x 360° field-of-view after
of the crest of the tilting 20° the vertical axis of the TLS
dam

In a third step, the field of view models were distributed at possible scan station positions and
intersected with the wall and DTM. Figure 206, Figure 207 and Figure 208 show the results
determined from three scan station positions near the arc dam.
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Figure 208: Final result for SP3
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7.3.1.4. Check List

As preparation for the field work a material/check list should be generated including all the
scanning and surveying equipment, and accessories that are required for the exercise. An
example is added in Appendix 8.2.

7.4. Data acquisition

7.4.1. Reference coordinate system

The hydroelectric company performs periodic deformation monitoring surveys of the dam.
For this purpose a local reference system materialized with a set of concrete pillars around
the dam exists. This local reference system was also used for the laser scanning campaign.

7.4.2. Scanner Mobile

A so-called Scanner Mobile was used because of the dense bush vegetation around the
scan station positions (see Figure 209). It is an arrangement of levers similar to those used
for theatre and lightings systems that allows positioning of the scanner 6 m over the terrain.
Therefore, the field of view of the scanner is less disturbed by vegetation and further
occlusions.

Figure 209: Scanner Mobile, h=6m

7.4.3. Targets

Trimble spheres with a diameter of 7.6 cm (Figure 211) were used at distances of less than
50 m. For longer distances (up to 200-300 m) bigger spheres and flat targets were used.
During the April measurements, planar targets (such as the green sticker in traffic signs, see
Figure 210) and painted bowling balls (Figure 213) were used. In September, painted
wooden spheres with self-made prism assemblies (see Figure 212) were used.
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It is imperative to use these remote targets at the outer limit of the sections, like the dam
crown. It ensures a stable georeferencing of the scanned point cloud and increases
significantly the accuracy.

The coordinates of the targets were determined out of TPS measurements using a Leica
TCRP 1202, which was mounted on survey pillars from a surrounding geodetic network.

Figure 210: Flat target in Traffic sign Figure 211: Trimble sphere, d=7.6cm and
interchangeable prism

Figure 212: Painted wooden sphere Figure 213: Bowling ball, d=21.9cm
with prism assembly, d=23.85cm

7.4.4. Scanning Positions

The scanner was situated at the positions defined in the session planning. Trimble Point
Scape 3.2 was the control unit software used for the scanner, running on a Colibri X6 tablet
PC. Up to eight targets were distributed around the scanner at each station.
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During the April fieldwork, point clouds were collected in three different sessions. After each
session, the scanner was restarted, thus point clouds were stored as being collected from
three different stations (one station per session). The first station contained test point clouds.
Each of the second and the third station contained point clouds with part of the dam,
reference targets with higher resolution and test-point clouds. The entire scanning phase
lasted about 8 hours.

During the September fieldwork point clouds were collected from seven different station
positions (A to G). In some of them, two or more sections of the dam (A1, A2, A3...) were
carried out because a special bracket to tilt the scanner was used (see Figure 200). Every
section includes at least three well-distributed reference-target-scans and one object-scan. In
total, 12 sections and 61 targets were stored. The nomenclature of the targets was the
following: Trimble sphere Targets (D=76mm) included an additional number << 100 (e.g. B2-
15); wooden spheres (D=240mm), >> 100 (e.g. C3-128).

In each section, the visible targets were scanned first followed by the dam, and finally one
single target was re-measured. The latter target was always named “control target” and it got
a “... (ctrl)” suffix. The “control target” was used to check the scanner stability during the
session. For the registration and georeferencing processes only the first scanned targets
were used.

In total, approximately 16.7 Million points were acquired in two days. The name of the output
file reflected the scan station positions.

7.4.5. Scanner Settings

A resolution of 50 x 50 mm @ 90 m was selected for scanning the object. The highest
possible resolution of 2 x 2 mm @ 160 m was used to scan the targets.

Table 2 shows some typical parameters used to scan the dam surface during the September
campaign:

Table 2: Typical scanner parameters

To get an idea of the time to scan either a target or the dam surface, check Figure 214. In

Target Scan Object Scan
Type Scan Sphere | Scan Object
Name C1-120 C1
Number of points 68593 2860089
Duration 00h 14m 47s | 00h 38m 01s
Points per second | 77 1253
Resolution 2x2mm @ |50 x50 mm@ 90
160 m m
Number of shoots | 20 2
Autofocus Enabled Disabled (fixed
50 m)
Grid type Best Quality Fast
Real time colouring | Disabled Enabled
Min. Distance Om Om
Max. Distance 300 m 300 m

total two days was taken for the September measurement campaign.
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Figure 214: Scan time of the different sessions of the September measurement campaign

7.4.6. Atmospheric conditions

The atmospheric conditions near the surface of the dam are extremely inhomogeneous due
to both the heating of the concrete surface by the sun and the turbulences of the ascending
air. This creates deflections of the laser beam of the scanner as well as of the total station,
and leads to errors of some millimetres.

Atmospheric data such as temperature, pressure and humidity were collected several times
by special measurement devices during the measurement campaign. This data was
parametrized in the scanner software, thus scan measurements were accordingly corrected.

7.4.7. Collecting control data

During the scan sessions, different control measurements for single points, lines and
surfaces onto the dam were made using a high precision TPS (see Figure 215). The control
data was used to compare the quality and reliability of the terrestrial laser scanner.
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Figure 215: Tachymetric measurement of the dam crest

7.5. Data processing

7.5.1. Starting RealWorks Survey

The purpose of this case study is to control the deformation of the dam. This deformation will
best be evaluated comparing two 3D models. This paragraph will outline the software
RealWorks Survey, chosen to process the data.

1 After double-clicking the RealWorks Survey icon, the following window opens (Figure
216)

T o g

KR IR RS [E- -

WorkSpace window

B IR

List window

Properties window

Status bar

Figure 216: RealWorks Survey window
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2 Open the data

2.1 From the File menu select Open or click the button = in the toolbar. A dialog
opens. Search and select the file ‘A+B+C+E+F+G SO.ppf’. Press Open.

2.2 While opening the file the user is asked to fit target spheres automatically. Click
Yes.

2.3 When all the data is loaded, points are displayed on the 3D View window. The
project takes the name from the “*.ppf’ file and a subproject called Sub-Project],
with all the data, is created. On the List window area an object called Project Cloud
appears.

3 Change the rendering mode

There are several modes to render point clouds (Figure 217). Choose one from the
Rendering submenu in the 3D View menu. The user can right-click anywhere in the 3D

View window (except on displayed objects) to display the pop-up menu and select
Rendering. A sub-menu drops down.

White Colour
Render all the points with
white colour.

Cloud Colour

Render points with the
colour of the cloud they
belong to.

Station Colour

Render points with the
colour of the station they
belong to.

193



Scan Colour

Render points with the
colour of the scan they
belong to. Usually there
are several scans in a
station.

Grey Scaled Intensity
Points are coloured in
grey according to their
intensity value.

Colour Coded Intensity
Points are red-to-blue
coloured according to
their intensity value.

True Colour
Points are displayed with
their RGB colour.

Figure 217: Point cloud rendering modes
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Question 10: If the user wants to display the data of each station in different colours, which rendering mode
should be chosen?

4 Save the project: From the File menu select Save or click the Save button el . Afile
with the extension “*.rwp’ will be created.

7.5.2. Registration

In a laser scanner project, it is usual to deal with several point clouds taken from different
stations. Each point cloud is referred to its station reference system. After the registration
process two or more stations have a common reference system. Usually one of them is set
as reference station and the others are transformed to have the same origin and orientation
(see also paragraph 3.5).

The aim of this paragraph is to learn how to register several stations in a laser scanner
project.

To register stations in a project in RealWorks Survey the Registration processing mode in
the Tool toolbar is chosen. All the stations appear under the project name in the Workspace
window.

RealWorks Survey presents two options to perform the registration:

- Cloud-Based registration: Users should pick three corresponding point pairs from two
point clouds to initialize the registration. Then the software can refine this registration by
using the common parts of the two point clouds.

- Target-Based registration: Users can register a set of stations by using targets. The
targets can be obtained during the scanning process, created manually during the
registration process, or obtained using traditional surveying instruments such as a total
station. The registration is based on a least-squares adjustment using the corresponding
target observations of each station.

In this case study, targets were used to both register and georeference the point clouds, so
the second registration option is used. In order to perform the Target-Based registration,
first examine automatically the fitted targets, modify them if necessary, and finally register the
point clouds.

For the registration stage, it is mandatory to change the module. RealWorks Survey offers
three different modules in the Toolbar: Registration, OfficeSurvey and Modelling. Click on
the pull-down arrow in the Tools toolbar and choose Registration (Figure 218).

OfficeSurvey o ’K

| officesurvey

Figure 218: Change of module

7.5.2.1. Analyze the targets

Targets can be detected automatically in the software (see point 2 of paragraph 7.5.1).
Unfortunately, some errors occur and they must be corrected manually. In order to check the
targets, follow the steps below and look at the video 01-RWS Fit a sphere Object.avi:

Open the project ‘A+B+C+E+F+D SO.rwp’

Select the project on the WorkSpace window.

7 In the Registration menu, select Target Analyzer Tool or click the button *. The
Target Analyzer dialog opens (Figure 219).

5
6
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L@:.ﬁ.l—S Spheric Targ
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< >
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Step 3 - Edit a Target
Modiy | Delete |
| Cloze ‘ Help |
“

Figure 219: Target Analyzer dialog window

When an object is scanned, the user can indicate whether it is a target or not. The point
cloud appears either in the Fifted or in the Not Fitted list. If the object is not scanned as a
target, the point cloud appears in the Scan list. You can select a fitted target, examine the
point cloud and the fitted geometry. If the automatically fitted sphere in the point cloud is
wrongly estimated, it can be either modified or deleted.

8 Modify a spherical target
8.1 Select the station kops-Al
8.2 Select the target AT-101(red): RealWorks Survey fits spheres with a known
diameter for Trimble spherical targets. In this case, a non-Trimble sphere was used
as a target. However, the software fitted a non-Trimble sphere (Figure 220). Thus,
it must be corrected.
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Figure 220: A1-101(red) target

8.3 Click the Modify button of the Target Analyzer Tool.
8.4 Draw a fence around sphere points (Figure 221) and click ¥ to delete the rest of
the point cloud (Figure 222).

Fitting Tool
WG Radius: aUTO

Fitting Tool
By | Radius: aUTO

Figure 221: Modifying A1-101(red) target Figure 222: Modifying A1-101(red) target
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8.5 Set the radius as AUTO or if the radius is known, enter the radius of the target
sphere. In this case study, a radius of 119.85 mm was set.
8.6 Click the button © to define the object as a Spherical Target.

Fitting Tool
< B |Radius: auTO

Figure 223: New A1-101(red) target

8.7 Click the Create Fitted Geometry & and the Close Tool *dbuttons.

To Do: Review all the fitted targets and make a list with those wrongly fitted.
Question 11: Why are these targets wrongly fitted? Is there any “Not fitted” target?

9 Modify all the wrongly fitted targets and save the project.

7.5.2.2. Registration of stations

In order to register two or more scans, they must have at least three common targets. In this
project, one target has two different names in two different scans.
Table 3 shows the names of the targets in different scans:

Table 3: Common targets

A1-1/A2-4
A1-101/A2-102
A2-5/A3-7
A2-6 / A3-8
A2-103 / A3-105 / B1-111
A2-104 / A3-106 / B1-112
A3-107 /B1-113/B2-115
B1-12/B2-13
C1-120/B1-114 / B2-116
C1-123 / C2-125
C2-126 / C3-129

All the names on a row correspond to the same target. It is easy to guess from which scan
the target takes the name (see paragraph 7.4.4). Thus, there are only three pairs of scans
that share at least three targets (Table 4):
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Table 4: Pairs of scans with common targets

Pair of scans | Common targets
A2-5/ A3-7
A2-6 / A3-8

A2-103 / A3-105

A2-104 / A3-106

A3-105/B1-111

A3-B1 A3-106 / B1-112

A3-107 / B1-113

B1-113/B2-115

B1-B2 B1-12/B2-13

B1-114 / B2-116

A2-A3

Scans A2, A3, B1, and B2 will be registered and referenced on the same reference system.
The other scans cannot be referenced in this way because they do not have enough
common targets. The rest of the scans can be registered by means of the Cloud-Based
registration tool. This requires identifying corresponding point pairs from both point clouds,
which is very difficult due to the shape of the object. (For additional info, please check the
video 02-RWS Registration.avi):

1 Open the file ‘A+B+C+E+F+G S1.rwp’All the targets in this project are corrected.
Select kops-A2 and kops-A3 in the List window.

3 Inthe Registration menu, select Target-Based Registration Tool or click the Target-
Based Registration Tool button 2. The Target-Based Registration dialog opens.

4  Click on the pull down arrow of the Reference Station list and select kops-A2 from the
drop-down list. Note that the name of kops-A2 will be in bold in the box below.

5 Select and toggle kops-A2 and kops-A3 stations to ON in the Station List window. Its
representation is shown in the 3D View (Figure 224)
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Figure 224: kops-A2 and kops-A3 scans before registering

6 Click the Automatic button on the Matching Targets step.

Note that before matching the targets, the Number of Targets for kops-A2 and kops-A3
was set to 0/7. When the automatic matching step was finished, this changed to 5/7. This

means that there are five common targets in both stations. The common targets can be seen
in the 3D View window (Figure 225).
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Figure 225: Matched targets in kops-A2 and kops-A3

Each matched target is included in a new and independent folder named mTarget and

rooted under the Project node in the Target tree. Unmatched targets remain in the
Unmatched folder.

7 Register stations: Click the Register button to carry out a least-squares adjustment.
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Figure 226: kops-A2 and kops-A3 after registration

8 Check the registration result: Click the Check button. This opens the Control Tool
window (Figure 227). The user can check the residual errors for each target group
(inside which can be found all matched observations for this target from different
stations) and also the residual errors for each station (with all the scanned targets from
each station, Figure 228). If the residual error of a target was out of tolerance, use can
be made of the Unmatch button to unselect it for the next registration. Afterwards,
registration should be performed again. The registration errors are displayed with the
current setting unit (mm) — it is possible to change this setting in the Edit > Preferences
menu. In the Control Tool dialog it is possible to sort the data of a column in ascending
order by clicking its title. This can help to take into account the targets with largest
errors.
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Figure 227: Registering report window for each station (note: ctrl targets are matched too)
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Figure 228: Registering report window for each target (note: ctrl targets are matched too)

Note on Figure 227 and Figure 228: Target sphere A2-5 was scanned twice. The first one,
named AZ2-5, was scanned following the normal scanning process and was used for
registration and georeferencing. The second one, named A2-5 (ctrl), was scanned after the
object scan (scan A2) was finished and was used in the post processing to check for any
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movement of the scanner during the job. Therefore, targets named ctrl should not be
included in the registration and georeferencing process, but only in the control process.

| Question 12: Why should targets be unchecked with a suffix “ctrl"?

9 To uncheck the “ctrl” targets: Mark them in the Control Tool dialog by clicking them;
then click the Unmatch Button to uncheck them.

10 Close the Control Tool and re-perform the registration by clicking on the Register
button. The results are shown in Figure 229 and Figure 230

Control Tool -]
|21 Station view |

Matched Station l Unmatched Station ]

Narne | SCA... | Carre... | 5ca... | Residual Error Delta ¥ Delka ¥ Delta 2 Fitking Error | Distance ko Scanner

- (2] 7 kops-A2 7 1.44 mm
B G aze - - - - - - 1,45 mm 11715,38 mm
B F Az-102 red) - - - - - - 1,12 mm 29487.65 mm
L@: § AZ-103 (green) M. 2 1.77 mm 1.01 mm -0.87 mm 117 mm 0,95 mm 25155.96 mm
L@: F Az-104 (blus) m... 2 1.51 mm -0.30mm -0.89 mm 1.19 mm 1.15 mm 31432.58 mm
L@:@ AZ-5 T 2 1,30 mim -1L1lmm 066 mm -0.19mm 1,62 mm 10679.53 mm
L@:@ AZ-f m... z 1,18 mm 0.40 mm 1.10 mm 0.17 mm 0,94 mm 1493946 mm
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L@:@ £3-105 (blue) MM 2 1,77 mm -1.0tmm 087 mm 1,17 mm 1,04 mm 2B146.16 mm
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Figure 229: Target View of registering report window (note: ctrl targets are unmatched)
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Figure 230: Station View of registering report window (note: ctrl targets are unmatched)
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11 To save the registration result:
11.1 Click Apply to validate the registration.
11.2 Click Group to validate and group the registered station into a new group. A
group of stations called New Group is created.
11.3 Rename the New Group to Group A2-A3. Right-click on the New Group
and select the Properties option. Change the name on the Properties box.
114 Quit the tool clicking the Close button.
12 Register BI and B2 scans. Name the group as Group B1-B2.
13 Register Group A2-A3 and Group B1-B2. Name the group as Group A2-A3-B1-B2.

Question 13: How many common targets have Group A2-A3 and Group B1-B2?
Question: Would it be possible to register both groups with a smaller number of common targets?

7.5.2.3. Reporting results of registration

A report of the registration process can be created using the following steps:

1 Select the project on the Work Space window.
In the Registration menu, select Entity-Based Registration Report. The Entity-Based
Registration Report dialog opens.

3 Navigate to the drive/folder where the report file is to be stored.

4 Enter a name in the File Name field. The extension ‘*.rtf’ is added automatically.

5 Click Save.

| Question 14: Which is the mean distance between targets in the registration performed on point 7.5.2.2?

Question 15: Is there any other strategy to register the four scans A2, A3, B1 and B2?

Does RealWorks Survey find the same solution for any case?

Which are the mean and maximum distances between all the targets and all the stations in these strategies?
Which is the best strategy? Why?

7.5.3. Georeferencing

Georeferencing is the process of transforming an object described in a local coordinate
system into a global coordinate system, i.e. national grids. To do this, at least three targets
have to be defined in both coordinates systems. If more than three correspondences are
given, a least squares fitting method will be used to calculate the best transformation. It is
also possible to import a control network surveyed by traditional surveying instruments, and
use these control points to assign coordinates (see also paragraph 3.5).

In this case study, georeferencing point clouds is an essential step to compare models of two
different periods. For this purpose, reference targets were measured by a high accuracy
surveying instrument (total station) and their coordinates are known in the global dam
coordinate system. This coordinate system is also used to control the dam.

Usually, when scan data is processed, scans are first registered (therefore all of them are on
the same reference system) and then georeferenced (the local reference system is
transformed into a global referenced system). In this case study, not all the scans can be
registered together, because there are not enough common targets. The solution in this case
is to georeference each scan individually without performing a common registration. Finally,
all the individually georeferenced scans have the same global reference system.

It should be stressed, that this way of georeferencing should be applied only if a common
registration of the point clouds is not possible, because the overall accuracy of these
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individually georeferenced point clouds may be less than that of point clouds registered and
georeferenced in one step.

This paragraph will explain how to georeference a set of stations. For this purpose follow the
next steps and look at the video 03-RWS Georeferencing.avi:

1 Open the project ‘A+B+C+E+F+G_S1.rwp’. In this project all the targets have been
corrected and the scans remain in their original reference system.
2 Import the target coordinates:
2.1 Open the Surveying Network ASCII file ‘Coordinates Spheres September.txt’.
2.2 When the Open dialog opens, check Add to project and select the current
project.
2.3 On the Surveying Network Import wizard (Figure 231) select the following options:
- Import: as a Topo Station
- Lines to skip: 1
- File Format: Point#, X, Y, Z, Description
- Separator: Tabulation
- Units: Meter

Surveying Network Import gl

|mport

' a: a TopaStation [fill with TapoPaints)

" in a Station [fill with GeomPointz] |kops-A1 ﬂ
Header File Format
Lines to skip: 1 = ; L
{+ Point#t, . v, 2, Description
Column Char o zkip: DQ

i " Paintt, Marthing, Easting, Elevation, Description
Comment Line Char:

q

Separator nits
™ Semicalan " Millimeter
" Comma

' Tabulation " 1.5, Survey Foat

" Dther: " International Foot Q

Cancel

Prewiew

Foint # walue T value £ walue Degcription Discarded
[Carnrment] [ meanlv' r
G1-60 E7.0230 304.8100 17731910

G1-62 04700 84400 1771.0980

G1-61 TE.A110 3097930 17724250

G1-63 80,5070 3237140 1770.2080

F1-50 143.8440 8086920 17245750

A1-3 149.8550 B48.6370  1804.3340

Aa1-2 153.6880 B39.5560 17375010

E1-140 154.0380 3374380 18154050

F1-151 154.0500 3374370 18154050

G1-161 154.0510 3374350 1815.3580 “
< >

Figure 231: Surveying Network ASCII file import wizard

Note that the new folder named Coordinates Spheres September is created and holds a
set of TopoPoints (Figure 232).
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Figure 232: Point clouds and target TopoPoints

3 Select all the scans on the List window
4 In the Registration menu, select Georeferencing Tool or click the Georeferencing
Tool button <. The Georeferencing dialog opens.
Select the station kops_A1
6 Select fitted targets and the corresponding TopoPoints.
6.1 Select the target A1-1 in the Target List window. The By Target button becomes
active (If not, click on the View window and key Enter)
6.2 Click on the By Target button. The Coordinates Assigning dialog opens.
6.3 Select the TopoPoint Al-1/A2-4
6.4 Click OK
6.5 Repeat the last 4 commands with all the targets of station Al-1.

(@]

Transformations to georeference objects require 7 parameters. Therefore, at least three
points must be available. Once three or more known coordinates have been assigned to
targets, a least-squares fitting method will be automatically applied to calculate the best
transformation. The user can select and delete an already assigned target. By unchecking
targets the fitting method will be recomputed automatically.

| Question 16: As the minimum number of targets required is three, should target A1-101 be unchecked? Why?

| Question 17: Should any other targets be unchecked? Why?

7 Choose the best combination of targets: The best combination is the one which has the
targets distributed regularly over the objects. It usually yields the lowest average error
(see also paragraph 3.1.4).

8 Click Apply.
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9 Repeat steps from 5 to 8 with the rest of the scans.
Note: Ctrl Targets should never be used for georeferencing!

What happens in the scan kops-F17?

After assigning all the targets to their corresponding TopoPoints, the Average Error is 109.04
mm. As this value is too large, it points to something being wrong. In fact, this error is due to
a slight movement of the scanner during the scan. Therefore, this scan will be neither
referenced nor used in the next steps.

10 Click on Close. Point clouds will be in the new coordinate system (Figure 233).

| &% File Edit Tools Registration Display 30 View Window Help =181
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.Ready . & =
Figure 233: Point clouds georeferenced

11 Save a georeferencing report
11.1 Select A+B+C+E+F+G S1 project on the workspace window.
11.2 In the Registration menu, select Entity-Based Registration Report or click

the Entity-Based Registration Report button a” .
12 Save the project with a different name.
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7.5.4. Performing a control on scan station positions

To perform a check on any possible movement of the scanner during the measurement, use
is made of the data displays on the Properties Report. The method is shown for the scans
Al and FI.

1 Export object properties report
1.1 Select the scan A1 and F1 on the List window.
1.2 Click on File > Export Object Properties... and create a *.rff file
A file with all the properties of the targets of the stations A1 and F1 is created.
2 Collect the coordinates of the cfrl targets and the associated hormal targets and copy
them into an MS Excel file (see Figure 234).

Al1-3 Al1-3 (ctrl)

Type: Spheric Target Type: Spheric Target

Number of Points: 12121 Number of Points: 23568

Number of Points Loaded: 12121 Number of Points Loaded: 23568

Standard Deviation: 1.22 mm Standard Deviation: 1.18 mm

Center: 149855.34 mm; 648637.76 mm; 1804338.69 mm Center: 149856.26 mm; 648635.94 mm; 1804336.57 mm
Diameter: 76.20 mm Diameter: 76.20 mm

Direction of Axis: -0.82; 0.57; -0.03 ... Direction of Axis: -0.82; 0.57; -0.03 ...

F1-50 F1-50 (ctrl)

Type: Spheric Target Type: Spheric Target

Number of Points: 12603 Number of Points: 17855

Number of Points Loaded: 12603 Number of Points Loaded: 17855

Standard Deviation: 1.07 mm Standard Deviation: 1.11 mm

Center: 143831.62 mm; 509686.92 mm; 1724627.35 mm Center: 143846.66 mm; 509669.43 mm; 1724650.75 mm
Diameter: 76.20 mm Diameter: 76.20 mm

Direction of Axis: -0.17; 0.02; 0.99 ... Direction of Axis: -0.17; 0.02; 0.99 ...

Figure 234: Properties Report of the Targets A1-3 and F1-50 with the centre coordinates
of the targets (bold)

3 By comparing the coordinates of the normal targets with the cfrl targets, an eventual
movement of the scanner can be easily shown (Figure 235).

diff = \/(X(normal) - X(cm))2 + (y(normal) - Y(cm))2 + (Z(normal) - Z(cm))2
X Y 4
Al-3 149855.34 | 648637.76 | 1804338.69
A1-3 (ctrl) 149856.26 | 648635.94 | 1804336.57
-0.92 1.82 2.12 | diff: 2.94 mm

F1-50 143831.62 | 509686.92 | 1724627.35

F1-50 (ctrl) 143846.66 | 509669.43 | 1724650.75

-15.04 17.49 -23.4 | diff: 32.86 mm

Figure 235: Calculating the dislocations in MS Excel

Note: Scan F1 cannot be used in the next steps (i.e. modelling) due to the large detected
error in X, Y and Z coordinates!
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7.5.5. Deleting points

During data acquisition, obstructions such as trees, adjoining buildings or street furniture will
also be scanned. These points should be deleted before modelling. In addition, this scan,
kops-F1, was not georeferenced and deleted. For this purpose, follow the next steps and
look at the video 04-RWS Deleting points.avi:

1 Open the project ‘A+B+C+E+F+G S2.rwp’. A project with all the scans georeferenced

(except kops-F1) is opened.

Select scan kops-F1 in the List window.

3 In the menu Edit, select Delete. A warning is given that the operation cannot be
undone. Click Yes.

N

In order to delete points from the whole point cloud the Segmentation tool is used:

Go to the OfficeSurvey module.

Change the rendering mode to True Colour

Select the point cloud on the List window (Project Cloud)

Select Tools > Segmentation Tool or click the button #. The Segmentation toolbar
opens.

~No o b

Segmentation Tool

s i =

Figure 236: Segmentation Tool bar

8 Draw a fence around the points that need to be deleted. Buttons In and Out become
enabled.

210



- RealWorks Survey

&% Fle Edt Tools OfficeSurvey Display 3D View MWindow Help
e & | e o0 Ty || Officesurvey

L@@ |E D | &2

g Mnde I [ Images ]

& WorkSpace (1 project)
= ¥ AHB+CHEHF+G_52 *
* [ UNTERPROIEKT1

E UNTERPROIEKTL - B

MName | Type I Mumber of point — =
G BPraject C... Project Cloud 13936200 Segmeil

Ready

Figure 237: Deleting points

9 Click the Out button ¥ to delete points inside the fence.
10 Repeat steps 8 and 9 until all undesired point are removed.
11 Click the Create button &

12 Click the Close button

Now, on the List window appears (additional to the Project Cloud object) a new point cloud
called OBJECTI. This point cloud does not contain any of the deleted points (Figure 238).

13 Select the Project Cloud on the object list.

14 In the menu Edit > Advanced, select Erase Points. A warning that this operation
cannot be undone appears.

15 Click Yes. Now, Project Cloud does not have any point.
16 Right-click on Project Cloud and select Get all Points.

Note that Project Cloud now has the same points as OBJECT].

17 Select OBJECTI. Right-click and select Delete. A ‘sure’ warning is asked Click Yes.
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Figure 238: Point cloud filtered

18 Save the project.

7.5.6. Slicing

In order to study the deformation of the dam between April and September use can be made
of cross sections. These can be obtained from the point cloud (making slices from the cloud
and converting slices to lines) or directly from the 3D model. This paragraph explains how to
obtain cross sections from slices from the point cloud. Another possibility to obtain the same
result from the 3D model is also mentioned. To obtain the slices from the point cloud follow
the next steps and look at the video 05-RWS Slicing.avi:

1 Open the project ‘A+B+C+E+G_S3.rwp’. This project has only one point cloud with the
georeferenced scans (the scan kops-F1 does not exist!).

Select the Project Cloud in the List Window

Select from the menu bar OfficeSurvey > Cutting Plane Tool or click the Cutting Plane
Tool button =.

W N

In order to obtain slices from a point cloud you must first define a cutting plane. The Cutting
Plane dialog opens, also a planar view with a 2D grid open below the 3D View window. A
cutting plane perpendicular to the screen and a slider appear in the 3D View window (Figure
239).
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Figure 239: Cutting Plane Tool windows

4 Define a cutting plane: First set its orientation and then define its position.

There are several options to define the cutting plane orientation:
- Selecting an axis.

- Picking a local frame object.

- Picking two points.

- Picking three points.

- Entering coordinates.

- Fitting geometry.

- Editing parameters.

4.1 Define the cutting plane orientation by selecting an axis:
4.1.1 Press the arrow on the Set From Frame button #~. The following list opens
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Figure 240: List of axis

4 1.2 Select an axis.

Note that the components of the normal vector have changed and a semi-transparent yellow
plane crosses the point cloud.

4.2 Define the cutting plane orientation by fitting the geometry.
4.2.1 Click on the Fit pull-down arrow ¢~. The following list opens

<™ Fit Plane

- Find Best Cross Plane

Figure 241: List of geometries

4.2.2 Select Fit Plane. The Fitting Tool toolbar appears.

4.2.3 Fence a set of points for which you want to fit a plane.
4.2.4 Click Plane button <7 . The best fitting plane is calculated.
4.2.5 Click Close.

The fitted plane defines the orientation of the cutting plane. Points can also be chosen to
define the best crossing plane. For this, follow these steps:

4.2.6 Select Find Best Cross Plan. The Fitting Tool toolbar appears.

4.2.7 Select points to fit a crossing plane.

4.2.8 Click the Crossing Plane button . The best crossing plane is calculated.
4.2.9 Click Close.

4.3 Define the cutting plane orientation by picking an object local frame.
4.3.1 Click Pick Axis From Object button .
4.3.2 Click on the Models tab.
4.3.3 Right-click on the selection and select Display Geometry.

In this project there is no geometry. If there was one, a selected cutting plane orientation
would be parallel to the axis of the object.

4.4 Define the cutting plane orientation by picking two points.
4.4.1 Click Plane Perpendicular to Screen button .
4.4.2 Pick two points on the screen. The cutting plane is perpendicular to the screen
and passes through the picked points.

4.5 Define the cutting plane orientation by picking three points.
4.5.1 Click Pick 3 Points on Plane button # .
4.5.2 Pick three points on the object. Point coordinates can be keyed. The cutting
plane passes through the picked points.

4.6 Define the cutting plane orientation by editing parameters.
4.6.1 Click Edit Parameters button = . The 3D Plane Editing dialog opens.
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4.6.2 Chose the set of parameters to edit and key the values.

| Question 18: Which is the best way to create slices parallel to the ground?

In order to define the position of the cutting plane the slider on the left side of the 3D View
window can be used to define one point that will be on the plane (By Offset option), or two
points generating a plane in the middle of both points (By Interpolation option). Point
coordinates can be keyed in or picked on the object.

5 Define the slices.
For each slice the thickness has to be defined. Single or multiple slices may be created. For

multiple slices, the distance between two slices can be defined. All slices will have equal
height.

Question 19: A dam was scanned with a point spatial resolution of 1 point per 10 x 10 mm. What would be an
appropriate value for the thickness of the slice in order to obtain a horizontal profile of the dam?

In the following steps, horizontal slices with an interval of 2 m will be created. The
appropriate thickness needs to be guessed:

5.1 Define the orientation by means of the Z axis.

5.2 Select the Multiple Slice option.

5.3 Set the interval as 2000 mm and a value for thickness.

5.4 Click the Preview button.

5.5 Zoom in to inspect the dam.
a) If it is noticed that slices are discontinued, increase the thickness and click
Preview. Repeat these steps until the slices look adequate.
b) When the slices are nice and smooth, try to reduce the thickness and click
Preview. Repeat this step in order to guess the minimum thickness to obtain
continuous slices.

Slices are computed and displayed in the 3D View window. The Control part of the dialog

box allows for selecting a slice. The selected slice appears in pink on the 3D View window
and its points are displayed on the 2D window view below (Figure 242).
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Figure 242: Previewing slices

6 Create the Slices Object
6.1 Click the Create button on the bottom of the dialog box. A folder containing all the
point cloud slices appears in the WorkSpace and List windows.
6.2 Click the Close button.

Slices can also be created after meshing point clouds (paragraph 7.5.7). The procedure is
the same but there is a need to select a mesh instead of a point cloud. In this case, slices are
polylines.

7.5.6.1. Converting slices to 2D lines

As mentioned earlier, creating slices from a point cloud is an important step because they
can be converted to lines and exported to a CAD file. The resulting 2D polylines can contain
only segments or a combination of segments and circular arcs. To learn how to convert
slices to 2D polylines and generate CAD files, follow the next steps and look at the video
06-RWS Converting slices to 2D Lines.avi:

1 Select a point cloud slice from the slices folder on the List window.

2 In the OfficeSurvey menu, select 2D-EasyLine Tool or click the 2D-EasyLine Tool &
icon. The 2D-EasyLine dialog opens. A planar view with a 2D grid opens and the cloud
of the slice is displayed.
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3 Click the Preview button. Check the Display Polyline box and uncheck the Display
Cloud box. Zoom in to explore parts of the polyline.

4 If discontinuities are found in the polyline, select the Fill Line Breaks option on the list
and enter a value for gaps to be filled. Click Fill.

5 Click Apply and Close.

Note: The slice symbol on the List window has changed to ‘#¥1. The Type has also changed
from Cloud to Polyline-Fitted.

Steps 1 to 3 can be repeated selecting all other point cloud slices. All the polylines are
created at once, but they can not be analyzed individually.

6 Create the 2D polylines from all the point cloud slices. Choose to do it with all the slices
together or one by one.

Slice polylines can be exported in order to work in CAD software. To do this:

7 Select the folder containing all the sliced polylines.

8 Inthe menu File, select Export Selection. The Export Dialog opens.

9 Select the “*.dxf’ format and write the file name. Click Save. The Export as *.dxf File
dialog opens.

10 Select to export only Selected Geometries, otherwise points will also be exported. If
you want to edit the polylines as 3D polylines in the future, check the corresponding
box.

11 Click Export.

7.5.7. Sampling and Meshing

The aim of this paragraph is to learn how to create a mesh from a point cloud in order to
have a 3D model of the scanned object.
To create a mesh follow these steps and look at the video 07-RWS Sampling and

Meshing.avi:

1 Open the project ‘A+B+C+E+G_S3.rwp’
Select the Project Cloud

3 From the OfficeSurvey menu select Mesh Creation Tool or click the Mesh Creation
Tool button ®. The Mesh Creation dialog opens.

Creating a mesh with the whole point cloud requires a considerable computing power. On the
other hand, the high density of the point cloud is not needed to create a good mesh.
Therefore, the number of points can be reduced. For this purpose, RealWorks Survey
presents a sampling tool.

4  Click the Sampling button ™\. The Sampling dialog opens.
5 Six different methods can be chosen to sample the point cloud:

5.1 Random sampling: The point cloud is sampled using a percentage ratio, which
will determine the amount of points that will be kept from the initial point cloud.
These points will be randomly selected from the original point cloud.

5.2 Spatial sampling: Point clouds obtained from different positions at different
distances presents a non-uniform point density. This method allows the user to
obtain a point cloud with a homogeneous density that you can define.

5.3 Scan-based sampling: This method creates a point cloud from a group of scans.
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5.4 Intensity-based sampling: Final point cloud contains points within an intensity
range.
5.5 Discontinuity-based sampling: RealWorks Survey deals with three different
discontinuities:
5.5.1 Edge: some points have opposite or different normal direction than the rest.
5.5.2 Gap: all the points have the same normal direction but some of them are
separated by irregular distance.
5.5.3 Other.
The first time all the data is loaded, edges and gaps are automatically detected. If
they are incorrectly generated, insufficient or missing, the Edge Detection tool can
be used. By un-checking boxes on the sampling tool, we will omit the unchecked
discontinuity type.
5.6 Topographical-based sampling: This method separates valid points from invalid
points. The tool is needed to process point clouds containing vegetation (invalid
points) and ground (valid points).

Question 20: In this case study the mean point resolution in each scan is 70mm, but overlapping zones present a
higher point density. Which sampling method should be used to obtain a homogeneous point density?

6 Choose the Spatial Sampling option and define the distance between points as
100 mm.

7 Click Preview. Note that there are about 3.2 m points remaining.

8 Click Apply. The sampling dialog is closed automatically.

To perform discontinuity elimination, RealWorks Survey use different projections:

» Plane-Based Projection: The user can define the projection plane. The options to
define the plane are the same as defining a slicing plane (see paragraph 7.5.6).

» Cylinder-Based Projection: The grid surface is a cylinder defined by the user.

= Screen View-Based Projection: The current view direction defines the projection
plane.

» Station-Based Projection: The scanning direction defines the projection plane.
» No projection: This method performs meshing on geometries that are more complex.
9 Select the Station-Based Projection mode.

10 Check the RemoveDiscontinuities Box and click PreviewMeshes.
11 Click Create.

This process may take some minutes.
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Figure 243: Mesh

Note that the new symbol of OBJECT2 is R (Figure 243). It means that the object contains
a point cloud and a mesh. Point cloud and geometry (mesh) can be either displayed or
hidden by means of the right button menu.

This mesh can be exported in order to work with it in 3D modelling software. For this:

12 Select OBJECTZ in the list window.

13 In the menu File, select Export Selection. The Export dialog opens.

14 Select the ‘*.asc’ format and name the file. Click Save. The Export as *.asc File dialog
opens.

15 Check the boxes to export RGB Colour and Normals.

16 Click Export.

Finally, a 3D model of the dam from the September data has been obtained. By performing
the same process on the April data, another 3D model of the dam will be generated. Both
models can then be compared to evaluate the deformations.

7.6. Deformation analysis

The input data for the deformation analysis is the outcome of two measurement campaigns:
one with an empty storage lake (April) and one with a filled storage lake (September of the
same year). In the deformation analysis, a comparison is made of registered and
georeferenced point clouds from these two measurement campaigns.

The September data has been processed within this tutorial and is now available for
analysis; the April data was processed by the authors and can be downloaded from the
3DRiskmapping website.

A simple way to perform a surface comparison is by generating slices of the surfaces
(described in paragraph 7.6.1.1), export them as .dxf in CAD software and measure the
normal-distances (paragraph 7.6.1.2).
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A more labour-intensive, but also more detailed solution can be done in the software
Geomagic® Studio. In this software, it is possible both to create polygon surfaces and to
compare them with a 3D Compare tool which allows the calculation of direct distances
between two polygon surfaces (paragraph 7.6.2.2). Other software packages, which are also
able to make surface comparisons, are Rhinoceros® and PolyWorks® among others.

Question 21: What is the big advantage of a comparing tool (“professional software”) related to a slicing CAD
analysis?

7.6.1. Using CAD software

For this process, use the file ‘A+B+C+E+G_S3.rwp’ created in paragraph 7.5.7. As already
described in paragraph 7.5.6, RealWorks Survey allows us to generate slices with a defined
orientation (axis) on a defined interval. These slices can be generated in a horizontal
direction (Z axis) as well as in a vertical direction (X and Y axis). In this case, the object is
orientated more or less along the Y and the Z axis, so this plane can be used as the cutting
plane.

7.6.1.1. Creating the dataset in RealWorks Survey

To ensure a correct comparison of the two models, it is necessary that the slices be located
in the same positions. For this we need the same coordinate system origin.
1 Performing the slices:
1.1 We choose the Z axis as Normal by clicking on -,
1.2 Click on Pick first point ¢ and select a point in the centre of the dam surface to
get an idea of the coordinate dimensions.
1.3 As origin Point choose 227000.00 mm; 475000.00 mm; 1750000.00 mm (XY2).
1.4 The Offset of the first slice from origin is 0
1.5 We define Multiple Slices, with a Thickness of 50mm.
1.6 As Interval we choose 10000 mm.
1.7 After clicking on Preview the slices appears. Their orientation is horizontal (Figure
244).
2 After clicking on Create, change the Normal direction to the Y axis and repeat the
slicing step described above. The newly created slices are vertically orientated (Figure
245).

| Question 22: Why is it important to define an origin?

| Question 23: Is it possible to set (0/0/0) as origin or is it important that the origin is placed on the surface?

Note: Slices were created every 10 m in horizontal and vertical directions (raster with 10 x
10 m). However, it is also possible to use other raster intervals!
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Figure 244: Cutting Plane Tool (horizontal slices) Figure 245: Cutting Plane Tool (vertical slices)

3 After closing the Cutting plane tool, two new folders are created in the List window,
one with the horizontal and one with the vertical slices. Now, generate polylines from
these points.

3.1 open the first folder with the horizontal slices and select all of them.

3.2 By clicking on the 2D-Easy-Line icon ¥ create lines (described in paragraph
7.5.6.1).

3.3 As settings use the standard settings (shown in Figure 250).

3.4 click on Fill.

3.5 After clicking on Apply the polylines are created.

3.6 To view them select Hide Cloud and Display Geometries. (ﬁ and %8).
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Figure 246: Creation of polylines (2D-Easy-Line Tool)

4 repeat step 3 selecting the vertical slices.
5 Before exporting the data combine them in a unique folder, so creating only one data
file.
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5.1 select the single slices in one folder and shift them by pressing the left mouse to
the other folder (drag & drop).

5.2 Some slices are renamed with a (2).
6 To export the data:

6.1 select them all and click on File > Export selection.

6.2 choose AutoCAD Files (*.dxf), name the file with ‘September slices’ and click on
Save.

6.3 Check/uncheck to export only the Selected geometries.

7.6.1.2. Visualization and measurement in AutoCAD

1 Open AutoCAD and with Insert-Block import the file ‘September slices.dxf’ (with

Browse and by selecting the “*.dxf’ format switch to the file path). The settings are
shown in Figure 247.

Note: be careful to insert the block on Insert point X: 0, Y: 0, Z: 0 and uncheck Scale and
Rotation!

% Insert
MHame: September slices R
Fath:  C:\Dokumente und Einstellungentdgnes
Inzertion paint Scale Fiotation
[ Specify On-screen [ Specifty On-screen [ Specify On-screen
z |0 ®o1 Angle: [
oo At
Z n z
[ Uniform Scale
[ Explode [ 0K ] [ Cancel ] [ Help

Figure 247: Block insert panel

2 Repeat the block insert by choosing the file ‘April slices.dxf’. This file has already been

prepared by the authors using the same processing steps as the September file. The
results are shown in Figure 248.
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Figure 248: Comparison of polylines (slices) Figure 249: Grid node with horizontal deformation

3 The distances in the nodes of the grid between September and April are the
deformation values (Figure 249). They can be measured using the distance tool (Tools

> Inquiry-Distance or type _dist or use == icon).

7.6.2. Using Geomagic® Studio

Geomagic Studio is software to post process point clouds. In this case 3D Compare Tool
will be used to analyze distances between the two measurement campaigns. For this, we will
use the point cloud already sampled to a raster of 100 x 100 mm in RealWorks Survey (see
paragraph 7.5.7).

For an overview of Geomagic and the Deformation analysis follow paragraph 7.6.2.1.
for further understanding of Geomagic follow the filtering process described in Heritage
case study (paragraph 4.7.2.3 and the following) using the non-filtered dataset without
outliers (paragraph 7.5.4, file ‘A+B+C+E+G_S3.rwp’). This Heritage case study also
contains an introduction to the general surface modelling using Geomagic software. The
parameter settings suggested are given in Table 5.

Table 5: The essential parameters in Geomagic to filter the dataset

Step Settings

1. Export of the data from RealWorks (paragraph | file ‘A+B+C+E+G_S3.rwp’ as

7.5.7) *.acs’ file

2. Import of the data in Geomagic (paragraph | Ratio: 100%

4.7.2.3) Keep Full Data on Sampling:
enabled
Units: millimetre

3. Selecting Outliers (paragraph 5.7.2.4) Sensitivity 66.667

4. Noise removal (paragraph 5.7.2.4) Free-form shapes: selected
Smoothness slider: Max
Iteration: 1
Deviation limit: default
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after noise removal ensure that
crease angle is lower 3,
otherwise repeat the application
5. Uniform Resampling (paragraph 5.7.2.5) Absolute Spacing: 100mm
Curvature priority: slider to Min
Keep Boundary: enabled

6. Meshing (paragraph 5.7.2.6) Wrap type: Surface

Noise Reduction: none

Target Triangles: 500.000

6. Hole filling (paragraph 0) Primary use Standard Settings
Deselect Largest
Fill All
7.6.2.1. Creation of surfaces

To create surfaces, follow the next steps and look at the videos 08-GM Import, Hide, Zoom,
Pan, Rotate.avi, 09-GM Reduction of the Pointcloud.avi and 10-GM WRAP, Flip
Normals, Fill Holes.avi:

1 Import of the filtered point clouds into Geomagic:
1.1 To load the data select File > Import and select the ‘Sept - 100.asc’ file
(September dataset, sampled in RealWorks Survey on 100 x 100 mm) from the file
folder (or use a dataset exported from RealWorks Survey in paragraph 7.5.7).
1.2 A window appears, select 100% sampling ratio to load the full dataset. As units
select millimetres.

1.3 Repeat the same procedure with the ‘April - 100.asc’ file (April dataset). The
loaded data can be seen in Figure 250.

bl anager Panel &5 o=
=R

e bpil 100

- 5 Sept-100

g Whorld

Figure 250: Loaded point cloud

| Question 24: How many points are loaded in the single point clouds?

2 The dam surface is shown in the viewing area.

2.1 To hide or ignore the different point clouds select them in the Model Manager
and with a right-click choose Hide/Show or Ignore/Consider.

2.2 zoom (using the mouse scroll), rotate (by pressing the scroll) and pan (by
pressing Alt + mouse scroll) on the dataset in the viewing area.

3 Ascan be seen in Figure 251 the point cloud from the September data and the point
cloud from the April data are not the same size. Additionally, the biggest deformation
appears in the middle of the dam and not at the sides. To avoid futile computation time
reduce the point cloud to the required area:
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Figure 251: Common central point cloud area

3.1 Mark both point clouds in the Model Manager panel: Press CTRL + select with
left mouse button.

3.2 In the Manager Panel change to the second register tab Primitives & and select
Object Colour.

3.3 To select the needed area use the Custom Region Selection icon ¥ from the
toolbar and fence the central point cloud.

3.4 Its colour changes to red, meaning that the points are selected.

3.5 By right click and select Reverse Selection we can flip to the opposite selection
(Figure 252).

Figure 252: Reversed selection

3.6 With * delete the selection.

Note: This reduces the point cloud to nearly 1.47 million points for the April and nearly
1.43 million points for the September measurement.

4 In the next step calculate a polygon surface, a so-called WRAP.

4.1 For this select both point clouds by clicking on them and then select the ® WRAP
icon from the toolbar.

4.2 In the Dialog panel a Compute Wrap editor appears. The settings can be seen in
Figure 253: Wrap Type is a Surface, in the Advanced Options select Noise
Reduction: Auto, Point Spacing is disabled and Target Triangles are 500,000
(for every point cloud) and select Keep Original Data. The surface computation
takes some minutes and created two new datasets (Figure 254).
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Figure 253: Setting for wrap computation Figure 254: Resulting polygon surfaces

5 In the Primitives tab uncheck the Object Colour and the Vertex Colour.

6 Now check the normal direction of the surface: blue means positive normal direction,
yellow means negative normal direction. For the 3D Compare Tool it is important, that
the normal direction of the surfaces is nearly the same. For that select the dataset by
clicking on Polygons > Flip Normals... and flip the direction (The front surface should
be blue).

| Question 25: Why it is necessary that the normals have nearly the same direction?

7  If there are numerous holes in the dataset (as in Figure 254: only in September
polygon) they must be filled. Paragraph 0 exactly how the process works and how it
compares with other hole filling methods.

7.1 Select the September polygon in the Model Manager tab.
7.2 Select Fill Holes “%. The panel shown in Figure 255 appears.
7.3 Click on Deselect Largest and on Fill All.

7.4 Click on OK. The holes filling process needs some minutes.
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Figure 255: Hole filling

7.6.2.2. 3D Compare Tool

As the name suggests, the 3D Compare tool is a method to analyze three dimensional
differences between two surfaces or a surface and a point cloud (Test and Reference
surface/point cloud). The differences can be mapped through colour coding. The coloured
difference vector can be visualised in larger scale. Generally in Tools > Options >
Operations > Comparison the user canchoose between two different comparing
algorithms: a shortest distance (Figure 256) and a distance along a given direction
(Figure 257). Additionally, it is possible to define the Critical Normal Angle.
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Test

Reference

Figure 256: 3D Compare: Shortest Distance Figure 257: 3D Compare: Orthogonal Distance
(Source: Geomagic Help file) (Source: Geomagic Help file)

To use the 3D Compare Tool follow the next steps and look at the video
11-GM 3D Compare.avi:

1 Select the April and September point clouds in the Model Manager and Ignore and
Hide the data in the right click - popup menu.
2 Select the April polygon surface.
3 Open the 3D Compare tool in the Menu (Analysis > 3D Compare):
3.1 The Reference object is automatically set to the April-100 Data (selected before
the 3D Compare tool).
3.2 As Test object is chosen the September-100 surface.
3.3 As Maximal Deviation enter 150 mm.
3.4 All the other setting are shown in Figure 258.

=98 =2 H

o) o

Objects
Reference: April - 100

Test: Sept - 100
Sept- 100 w
Max. Deviation [ 150.0 rmm :g

Dizplay Resolution

Coarse J Fine
Color Averaging
Low J High
Spectum
Fesult v
Color Segments |14 :5
Max. Pogitive | 0.0 rmm Ig
Min. Positive | 0.0 mm :g
Min. Megative | 0.0 rmm :5 ~

Figure 258: 3D Compare: settings
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3.5 Click on Apply; Computation takes some minutes.
3.6 As settings for the Spectrum use: 25 Segments, Max. Positive 120 mm, Min.
Positive 10 mm, Min. Negative -10 mm, Max. Negative -120 mm (Figure 259).

Manager Panel F X
e |9 @ 2
Obijects
Reterence: Aprl - 100
Test: Sept - 100 1200.
Diizplay l
1100
[] Test Dbject l
100.0
() Color Reference l
) Calor Test Paints 90.0 l
) Color Deviations 80.0
[] Highest Deviation Paint 700
Spectrum
Result b4 60.0
Color Segments | 25 :3 500
Max. Positive | 120.0 mm :: 400
Min. Positive | 10.0 mm = 300
Min. Negative [10.0mm  [=] 200
Max. Negative |-10.0 mm = 10.0
Decimal Places 1 1=}
taximum Distance: -10.0
positive: 143622835 mm .
negative:  -137.034111 mm
Average Distance: 33912833 mm
positive: 33.954556 mm
negative: -2 121683 mm
Standard Devistion:  16.217842 mm a1 Mlis
30 Deviation

Max +/= 149622805/ -137.034111 mm
33954356/ -2.121683 mm
16.217842 rm

Awerage +¢-
Standard Deviation:

Figure 259: 3D Compare: results

Figure 259 shows the dislocation of the dam surface between two measurement campaigns.
This deformation is a result of different water levels. The bottom part of the dam did not
move, because it is well fixed in the ground (green colour). The crest of the dam gets
maximum deformation, mostly in the center of the wall (orange — red colour).

The resulting deformations are consistent with the results of the tachymetric control
measurement (see paragraph 7.4.7) and also with the perpendicular measurements of the
operating company in this zone of the dam.
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8. Appendix

8.1. Conversion of Cyclone datasets (*.imp) to other formats

Open the Cyclone Navigator

Unfold the Database

= Unfold the Project

= Unfold one of the Scanworlds

= Right click one of the ModelSpaces and select Export...

= At the bottom of the ‘Export to File’ dialog select the extension (data type: dxf, ptz, ptx,
pts, ....)

= Enter a new Filename to save the dataset
= Press the Save button

= Repeat this process for each scan that needs exporting

8.2. Checklist for the environmental case study
= Laser Scanner:

0 Laser scanner TRIMBLE, Type GX3D with integrated Camera, incl. hard- and
software and power supply

Colibri X6 tablet PC

Scanner Mobil to position the scanner at an altitude of 6 m

Tripod for scanner

0 Bracket to tilt the scanner 90°

= Total Station:

O OO

Total Station LEICA Type 1202

Smart Card for total station

Card reader

Charger for Accumulators for total station
Tripod for total station

Umbrella for Total Station

Mini Prism

Leica Prism

OO0OO0OO0O0OO0OOo

o

= Targets:

0 Trimble spheres (d=7,6cm) incl. centerrack and tripod

0 Wooden spheres (d=24cm) incl. prism assembly, centerrack and tripod
o0 Bowling Balls (d=22cm) incl. mounting material

o Traffic signs, d=60cm, incl. adhesive Trimble folio incl. mounting material

= Accessories:

o0 Photo camera NIKON, Type D2X
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O O0OO0OO0OO0OO0O0

Reserve Accumulators

Cable drum

Radio unit

Tape measure

All terrain vehicle

Power supply

Measurement device to collect data about atmospheric conditions
(temperature, pressure and humidity)

= Additional plan basics and software

O O0OO0OO0O0OO0O0

(olNe]

Orthoimage of Kops - Lake

DTM of the surrounding of the lake

Coordinates of reference points

Ground plan of the dam

Prior visit to the site with documentation (photos etc.)

Software to simulate the fieldwork: AUTODESK Civil3D 2006

Software to analyse the TPS measurement: GeoSi 6.0 and LEICA Geo Office
Combined

Software to analyse the Trimble data: Real Works Survey 6.0

Software to analyse the deformation: Geomagic Studio 9



8.3. List of scanners

The following list is a short sample of popular laser scanners fulfilling the requirements for this application related to range and accuracy

TRIMBLE GX 3D
source: www.trimble.com

RIEGL LMS Z420i
source: www.riegl.com

LEICA ScanStation 2
source: www.leica-

OPTECH lIris 3D
source: www.optech.ca

ZOLLER+FROHLICH
Imager 5006
source: www.zf-laser.com

FARO Photon™ 80/20
source: www.faro.com

geosystems.com

Range measurement
principle

Pulse — time of flight

Pulse — time of flight

Pulse — time of flight

Pulse — time of flight

Phase comparison

Pulse — time of flight

Laser Colour

Green

Green

Visible

Visible

Class 2 (21 CFR §1041.10)

Class 1 (IEC 60825-1 and

Class 1 (IEC 60825-1 and

Laser Class ??d Class 3R (IEC 60825- | 541°GFR §1041.10) Class 3R (IEC 60825-1) 21 CFR §1041.10) 3R (ISO EN 60825-1) 3R

: 350-1.000 : : 76m (Photon™ 80
Range 200m @ 90% Reflection (accordingnso reflection) 300m @ 90% Reflection 1200m @ 90% Reflection | 79m 20m %Phgtgﬂm 20;
Field of view 60° vertical 80° vertical 270° vertical (overhead) 40° vertical 310° vertical 320° vertical

360° horizontal

360° horizontal

360° horizontal

40° horizontal

360° horizontal

360° horizontal

Reference target

Geometrical (sphere or flat)

Intensity of reflection

Geometrical (sphere or

definition flat)
1.4mm @ <50m
- 2.5mm @ 100m
Standard deviation 3.6mm @ 150m 10mm @ 50m - -- - -
6.5mm @ 200m

Accuracy of single point

Position=12mm @100m

Accuracy: 10mm@50m
Repeatability 8mm@50m

Position=6mm @50m

Position=8mm @100m

Mirror accuracy= 0.007°

Systematical distance
error : £2mm@25m

@ﬁzsélg&nae)m Range= 7mm @100m (single shot) 4mm@50m Range= 4mm @50m Range= 7mm @100m rms Eﬁg%t.]aobrwt% god;?/gngmm
(averaged) rms @25m
Minimum point spacing / | 3mm @ 100m 7mm@100m (70prad; o o o
resolution (32urad: 0.0018°) 0.004°) <1mm 0.00115 0.0018 0.009
4mm@50m (FWHH-
Diameter of Laser point | 3mm @ 50m based) o .
/ Beam divergence Auto focus: 0.3mm@5m 12.5mm@50m 6m@50m (GauRian - 0.009474 0.22 mrad 3.3 mm at exit
based)
11.000 Pt/s (oscillating
Maximum Scan rate 5.000 Pt/s 8000 )Pt/s (rotating 50.000 Pt/s 2.500 Pt/s 500.000 Pt/s 120.000 Pt/s
mirror)
LCD Camera Integrated E)étftriﬂgl’ Mounting Integrated Integrated, CMOS Integrated Eﬁ%ggl’ Mounting
Vertical axis declinable X\Qg‘iﬁ:&g?&ggfket Every desired position no ssagr;@gsgggyt?%%%gfse No No
PointScape 2.1 (Field) Output: variety of -
Scanner Software RealWorks Survey 6.0 (post | RiScan PRO 1.2.1b19 Cyclone 5.5 metafiles and XYZ Z+F Lasercontroll (Field) -

Processing)

coordinates

LFM (Postprocessing)
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9. Answers to Questions

Answer to Question 1:

SW11 only has 1 target in common with the other ScanWorlds, namely target 21 which is
visible from the other ScanWorld positions through a small door in the wooden panel. One
target is not enough to perform a target-to-target registration.

To register ScanWorld 11 to the other ScanWorlds, cloud-to-cloud registration is used. To
be able to do cloud-to-cloud registration a sufficient overlap between point clouds is required.
It is recommended to use at least 30% for a proper registration.

Answer to Question 2:
SW9 and SW11 do have sufficient overlap in the ceiling area, so cloud-to-cloud registration
can be used to register these ScanWorlds.

Answer to Question 3:
We can see that Target 17 in ScanWorld 6 (the right viewer) is not well defined.

Answer to Question 4:
The result shows 10 constraints containing this target. (Reduced dataset: 3)

Answer to Question 5:
Target 13 exists two times in ScanWorld 16.

Answer to Question 6:

Target 7 in ScanWorld 7 is in a bad position. However, the fine scan shows the target
correctly. This means something went wrong during the labelling of the target. Most of these
errors are due to manual or semi-automatic procedures during the acquisition phase and are
almost inevitable. Lack of concentration or improper use of a semi automated technique to
detect targets in the point cloud will result in an erroneous dataset.

When checking the constraints containing target 7, it is seen that the label for target 7 in
ScanWorld 7 is not in its correct position.

Answer to Question 7:
The highest error value should now be about 1.2 cm, which is an acceptable error measure
for a building of this size.

Answer to Question 8:

ScanWorlds 33, 34, 35, 36 and 37 do not contain proper targets.

Cyclone will respond to the registration command with an error message explaining that the
current constraints are insufficient for the registration process to form an initial registration
guess. When analyzing the target constraints we see that ScanWorld 32 only has 2
constraints.

Answer to Question 9:
ScanWorld 37 has a proper overlap with ScanWorld 31, and both ScanWorlds 35 and 36
have proper overlap with ScanWorld 30.

Answer to Question 10
The station colour mode.

Answer to Question 11
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List of wrongly fitted targets:

Station Target Station Target
kops-A1 | A1-101 (red) ) C1-122 (yellow)
A2-102 (red) kops-Cf C1-123 (blue)
kops-A2 | A2-103 (green) i C2-125 (blue)
A2-104 (blue) | "OPS-C2 C2-126 (green)
A3-105 (blue) C3-127 (yellow)
kops-A3 | A3-106 (yellow) | kops-C3 C3-129 (green)
A3-107 (white) C3-128 (blue)
B1-111 (green) i E1-42
ope.pl | B1112 (blue) kops-E1 E1-140 (red)
P B1-113 (yellow) F1-153 (green)
B1-114 (white) ) F1-152 (yellow)
cons.B2 | B2-115 (vellow) kops-F1 F1-154 (blue)
P B2-116 (white) F1-151 (red)
i C1-120 (white) i G1-161 (red)
kops-C1 C1-121 (red) kops-G1

These targets are wrongly fitted because RealWorks Survey fits spheres with a known
diameter for Trimble spherical targets. Targets on the list correspond to non-Trimble spheres.
In this project there is no “Not fitted” target. See “Not fitted” tab on the Target Analyzer form
for each station.

Answer to Question 12
Uncheck all “ctrl” targets, because they are used afterwards for quality control relating to the
“normal” targets (at the end of the document).

Answer to Question 13

They have three common targets. It would be impossible to register both groups with less
than three targets.

Answer to Question 14
Mean distance between targets is 1.31 mm.

Answer to Question 15

Other strategies to register the four scans are:

= Register all of them at once.

= Register A2 and A3. Then, register A3 and B1 being A3 the reference station. Finally,
register B1 and B2 being B1 the reference station.

Solution given automatically in the first case is not the real position of scans. However, the
second strategy provides the real position.

For the first case:

Mean distance (mm) | Max. distance (mm)
4 Stations 22.99 39.00
8 Targets 21.74 64.09
For the second case:
Mean distance (mm) | Max. distance (mm)
4 Stations 1.31 1.44
7 Targets 1.33 1.77
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In this case, the best strategy for registration is the one explained on point 7.5.2.2 because
the mean and maximum distances between stations and targets are the lowest.

Answer to Question 16

No, because to georeference an object reference points should be placed along the object
covering the major part of the object in 3D as possible. If target A1-101 is unchecked, the
upper part of the dam is not taken into account to georeference the point cloud and the
displacement of this part to the real position can be greater although the average error was
lower.

Answer to Question 17

Yes, you may uncheck target A1-2 for two reasons. First, because there are already more
targets on the lower part of the point cloud. Second because targets A1-1, A1-2 and A1-3 are
almost in a line and, therefore, target A1-2, which is on the centre of the line, can be
redundant.

Answer to Question 18
Define the orientation by means of the Z axis. Other option is to key the Normal 0O; O; 1.

Answer to Question 19
The minimum value would be 10 mm. The maximum thickness would depend on the required
precision of the profile.

Answer to Question 20
The sampling method should be the Spatial Sampling.

Answer to Question 21

A comparing algorithm handles with generated surfaces, a slicing process (as presented in
paragraph 7.6.1) is working with slices in a certain offset. Therefore, the first gives more
detailed information (for nearly every desired point). Furthermore, the software package
includes a better visualization possibility. The information content of slices increases with the
offset between the slices, but also the (manual) visualization work increases!

Answer to Question 22
To afford a relation with a second data set from other measure campaign(s) with the same
origin.

Answer to Question 23
The origin can be located wherever wanted, but for the visualization it is necessary to choose
a point near the surface.

Answer to Question 24
The data is shown in the viewing area on the bottom left corner: the April data consists of
2,297.429 points and the September data consists of 3,068.443 points.

Answer to Question 25

Because the comparing algorithm is calculating the distances beyond the normal vectors of
the surface and if they look in an opposite direction the computation cannot be done.
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